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ВВЕДЕНИЕ 
 

Данное методическое пособие разработано для технологического сопро-
вождения дисциплины специализации «Основы проектной графики и 
дизайна», направленной на формирование фундамента подготовки будущих 
специалистов в области информационных систем и технологий, способных к 
использованию технологий разработки объектов профессиональной деятель-
ности в области дизайна. Целью освоения дисциплины является изучение 
специфики и особенностей дизайна, как вида творческой деятельности, т.е. 
предметной области на которою ориентирован профиль «Информационные 
технологии в дизайне», формирование базовых навыков проектной деятель-
ности в области графического дизайна с использованием средств проектной 
графики, информационных технологий и методов дизайн-проектирования. 

Целью лабораторных работ является приобретение практических знаний 
и навыков в области проектирования объектов визуально-графической среды 
в результате освоения различных методов создания и обработки графических 
изображений средствами векторной графики, а также развитие творческих 
способностей и образно-художественного мышления у студентов, необходи-
мых для реализации конкурентоспособных решений и проектов. 

В результате выполнения лабораторных работ у студентов должны 
сформироваться знания, умения и навыки, позволяющие владеть особенно-
стями технологического процесса проектирования объектов 
профессиональной деятельности в области дизайна, связанные с представле-
нием визуальной информации, включая интерфейсы, визуальные 
коммуникации, веб-дизайн. 

Методическое пособие состоит из десяти взаимосвязанных разделов, в 
которых последовательно рассмотрены различные методы создания и обра-
ботки графических изображений средствами программы Adobe Illustrator, 
представлены контрольные вопросы по рассмотренной теме и задания, вы-
полнение которых требует развития образного мышления и творческих 
способностей у студентов. 

В первом разделе рассмотрены основные операции с документом и объ-
ектами, необходимые для организации эффективной работы для выполнения 
последующих заданий. Контрольное задание: логотип компании «Русский 
алюминий». 

Во втором разделе рассмотрены методы создания стандартных фигур и 
линий с помощью простейших инструментов рисования. Контрольное зада-
ние: «Объект на основе примитивов». 

В третьем разделе приводятся сведения об особенностях работы с цве-
том, типы и способы создания сплошных, градиентных и декоративных 
заливок. Контрольное задание: «Цветной объект на основе примитивов» 

В четвертом разделе рассмотрены основные элементы кривых Безье, ме-
тоды создания и редактирования контуров произвольной формы. 
Контрольное задание: «Объект на основе кривых Безье». 
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В пятом разделе рассматривается технология преобразования растровых 
изображений в векторные объекты и возможность их быстрой заливки. Кон-
трольное задание: «Трассировка цветной фотографии». 

В шестом разделе изучается специфика работы с текстом, способы его 
создания и редактирования. Контрольное задание: «Календарь». 

В седьмом разделе рассматриваются различные методы и средства 
трансформации, искажения, комбинирования объектов и создание обтравоч-
ных масок. Контрольное задание: «Букет». 

В восьмом разделе рассматриваются способы создания и редактирова-
ния декоративных элементов оформления графических векторных объектов. 
Контрольное задание: «Открытка». 

В девятом разделе рассматриваются способы управления информацией с 
помощью слоевой структуры документа. Контрольное задание: «Схема». 

В десятом разделе рассматриваются различные способы создания иллю-
зии глубины и объема векторных объектов. Контрольное задание: 
«Шахматы». 

Представленные в пособии материалы используются при проведении 
лабораторных работ со студентами факультета информационных систем и 
технологий СПбГУТ с 2008 года.  

Примеры контрольных заданий выполнены студентами того же факуль-
тета в процессе выполнения лабораторных работ. 
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1. ЛАБОРАТОРНАЯ РАБОТА №1 
«Основы работы с объектами векторной графики» 

 
1.1. Цель работы 

 
Познакомиться с интерфейсом программы и основными характеристи-

ками векторного объекта. Изучить базовые средства и инструменты, 
предназначенные для работы с векторными объектами, а также основные 
операции с документом, необходимые для организации эффективной работы 
для выполнения последующих заданий. 

 
1.2. Задание к лабораторной работе 

 
Постройте логотип компании «Русский алюминий» (рис.1.1.). В процес-

се работы используйте блок управления цветом, операции выравнивания, 
распределения и группировки элементов. Расстояние между объектами по 
вертикали и горизонтали должно быть установлено математически точно с 
помощью возможностей палитры выравнивания.  

Полученный результат сохраните в файле «logo.ai», сдайте преподава-
телю на проверку и защитите его.  

 

 
Рис.1.1. Логотип компании «Русский алюминий» 

 
 

1.3. Основы работы с векторными объектами  
 

1.3.1. Объект и его характеристики 
 
1. Типы объектов 
 
Объекты документа бывают следующих типов: 
– векторные объекты - описываются математически и состоят из трех 

связанных частей: векторного контура, области заливки и области обводки; 
– текстовые объекты - содержат текстовую информацию; 
– символьные объекты - потомки (копии) символов; 
– групповые объекты - механически объединяют в себе несколько объ-

ектов произвольного типа с целью их совместного использования; 
– комбинированные объекты - отличаются от групповых тем, что между 

их составными частями существуют более глубокие связи; 
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– объекты быстрой заливки - объекты, создаваемые из нескольких век-
торных объектов и допускающие различное оформление участков, 
образуемых их векторными контурами; 

– объекты быстрой трассировки - объекты, которые образуются из 
растровых изображений после применения к ним операции трассировки. 

 
2. Векторный объект и его характеристики 
 
Векторным объектом называется любой элемент изображения: прямая, 

кривая, прямоугольник, эллипс, текстовый элемент и т. д. Важным объектом 
векторной графики являются кривые. В основу работы с произвольными 
кривыми положен алгоритм математика Пьера Безье (Pierre Bezier), позволя-
ющий описывать и преобразовывать кривую с помощью указания двух 
векторов, находящихся в ее начальной и конечной точках. Кривую характе-
ризуют следующие параметры: 

– кривизна, которая изменяется двумя управляющими линиями, выхо-
дящими из опорной точки; 

– степень кривизны, которая определяется длиной управляющих линий и 
расположением опорных точек; 

– наклон. 
Любой векторный объект независимо от внешнего вида имеет ряд об-

щих характеристик (рис.1.2.): 
– узлы или опорные точки (anchor points) и соединяющие их сегменты; 

которые определяют внешний вид объекта; 
– контур (path), который формируется из сегментов; 
– обводка (stroke), параметры которой устанавливаются в процессе со-

здания объекта (толщина, стиль, заливка); 
– заливка (fill) или область внутри контура объекта, которая может быть 

сплошной, градиентной или узорной. 
 

 
Рис.1.2. Основные характеристики объекта 

 
Контур (path) - это линия, которая представляет собой проволочную 

оболочку объекта. Контуру могут быть присвоены параметры обводки 
(stroke) и заливки (fill). Обычно контур состоит из нескольких сегментов 
прямолинейных или криволинейных, представляющих собой кривые Безье и 
соединенных в узлах или опорных точках (anchor points). При перемещении 
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одной опорной точки сегменты, связанные с нею, меняют свою форму. Из-
менить форму сегмента можно также перемещением управляющей точки 
(control point), связанной с опорной точкой посредством управляющей линии 
(control line).  

 
Рис.1.3. Основные характеристики кривой Безье 

 
Обводка объекта характеризуется тремя параметрами: толщиной, типом 

и заливкой линии обводки контура, которая может быть как однородной, так 
и любого типа сложности. 

Заливка объекта, под которой понимается область, находящаяся внутри 
контура, характеризуется единственным параметром, который может быть 
определен либо как однородный цвет, либо как градиент, либо как узор (pat-
tern) произвольной сложности. 

Контуры бывают закрытыми (замкнутыми) и открытыми (рис.1.4). 
Контур считается открытым, если начальная и конечная токи не замкнуты, и 
закрытым, когда начальная и конечные точки сливаются в одну точку.  

При заливке открытого контура программа проводит воображаемую 
прямую линию, соединяющую начальную и конечную точки, и заполняет его 
как закрытый контур. 

а) б) 
Рис.1.4. Примеры закрытого (а) и открытого (б) контуров. 

 
Заливка и обводка объекта могут быть определены либо как отображае-

мые с определенными характеристиками, либо как неотображаемые или 
отсутствующие в документе. 

Создавать контуры можно с помощью нескольких инструментов, распо-
ложенных в палитре инструментов (процесс создания и редактирования 
кривых будет рассмотрен выше). Достоинством векторных контуров является 
возможность в любой момент изменить как количество опорных точек и, со-
ответственно количество, и форму сегментов, так и размер, форму, 
расположение и заливку всего объекта. 
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1.3.2. Управление цветовыми характеристиками объекта 
 
В нижней части панели основных инструментов находится блок управ-

ления цветом, предназначенный для отображения и редактирования 
основных цветовых характеристик объекта - наличия или отсутствия  цвета 
заливки и обводки контура (рис.1.5.).  

 

 
Рис. 1.5. Блок управления цветом  

 
В блоке управления цветом расположены два основных индикатора: 
1) Fill (Заливка) - отображает цвет, градиент или узор, заданные в каче-

стве заливки внутренней области выделенного объекта. 
2) Stroke (Обводка) - отображает цвет или узор (pattern), заданный для 

обводки контура выделенного объекта. 
Активным является тот индикатор, который располагается на переднем 

плане, и все изменения цвета будут касаться именно его. Чтобы активизиро-
вать требуемый индикатор, достаточно просто щелкнуть на нем. Для вновь 
создаваемых объектов будут использованы цвета, установленные в индика-
торах Fill (Заливка) и Stroke (Обводка). При выделении уже существующего 
объекта индикаторы отображают цвета, присвоенные элементам данного 
объекта.  

Изменение цвета индикаторов осуществляется с помощью палитр Color 
(Синтез), Swatches (Каталог), Gradient (Градиент), которые будут рассмот-
рены выше. 

Рядом с индикаторами цвета расположены кнопки: 
– Swap Fill and Stroke (Переключатель заливки и обводки) - меняет ме-

стами цвета заливки и обводки контура объекта; 
– Default Fill and Stroke (Цвета заливки и обводки по умолчанию) - воз-

вращает объекту цвета, установленные для заливки и обводки контура по 
умолчанию, цвет заливки при этом будет белым, а цвет обводки контура - 
черным. 

Для упрощения работы с данными инструментами каждому из них 
назначены собственные комбинации клавиш: 

– для переключения с индикатора Fill (Заливка) на индикатор Stroke 
(Обводка) и наоборот - клавиша <X>,  

–  для замены цвета заливки на цвет обводки контура и наоборот - ком-
бинация клавиш <Shift+X>,  

– для восстановления цветов, установленных по умолчанию - клавиша 
<D>. 
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Ниже под индикаторами цвета и обводки контура расположены три 
вспомогательных кнопки: 

1) Color (Цвет) – отображает цвет, который был использован в доку-
менте последним; 

2) Gradient (Градиент) – отображает градиент, который был использо-
ван в документе последним; 

3) None (Без атрибута) – отмена заливки или обводки контура (заливка 
исчезает, а обводка контура становится невидимой). 

 
1.3.3. Способы выделения объектов 

 
Для выполнения операций выделения объектов существуют достаточно 

большой арсенал средств и инструментов, к которым относятся команды 
главного меню программы, инструменты, кнопки выбора которых располо-
жены на палитре основных инструментов. 

 
1. Основные инструменты выделения 
 
1) Selection (Выделение) – выбор объекта целиком или созданием пря-

моугольной рамки. Для выделения одиночных объектов необходимо либо 
щелкнуть на объекте, либо обвести объект/объекты рамкой выделения. 

  

Рис. 1.6. Выделение объектов инструментом Selection (Выделение) 
 

2) Direction Selection (Частичное Выделение) – выбор опорных точек 
объекта целиком или созданием прямоугольной рамки. Для выделения, необ-
ходимо обвести все опорные точки, которые должны быть выделены. 
Щелчок внутри объекта приводит к выделению всего объекта. 

Рис. 1.7. Частичное выделение объектов  
3) Group Selection (Выделение объекта в группе) – выбор объекта в 

группе, группы объектов внутри другой группы или нескольких групп в 
изображении. При нажатой клавише <Shift> можно выделить несколько объ-
ектов в группе. 
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Рис. 1.8. Выделение объектов в группе 
 
 
2. Дополнительные инструменты выделения 
 
1) Lasso (Лассо) – выделение опорных точек объекта построением 

рамки произвольной формы. Необходимо обвести рамкой произвольной 
формы нужные объекты таким образом, чтобы все опорные точки оказались 
внутри созданной рамки. 

2) Magic Wand (Волшебная палочка) – выделение объектов на основе 
подобия атрибутов. При щелчке в необходимой области выделятся все окру-
жающие объекты, например, окрашенные в красный цвет. 

 
3. Команды меню Select (Выделение) 
 
Select All (Выделить все) - выделяет все объекты за исключением тех, 

которые заблокированы (locked) или спрятаны (hidden); 
Deselect (Отменить выделение) - снимает выделение с выделенных ра-

нее объектов;  
Inverse (Инвертировать) - выделяет все невыделенные объекты и одно-

временно снимает выделение со всех выделенных объектов; 
Same > Fill & Stroke (Та же заливка и обводка) -выделяет все объекты, 

окрашенные в одни и те же цвета и имеющие одинаковую толщину линий; 
Same > Fill Color (C одинаковым цветом заливки) - выделяет все объек-

ты с одинаковым цветом заливки; 
Same > Stroke Color (C одинаковым цветом обводки) - выделяет все 

объекты с одинаковым цветом обводки; 
Same > Stroke Weight (C одинаковой толщиной обводки) - выделяет все 

объекты с одинаковой толщиной линий; 
Same > Blending Mode (Тот же режим наложения) - выбор объектов с 

тем же режимом наложения, что и у выделенного; 
Same > Opacity (Та же прозрачность) - выбор объектов с тем же значе-

нием прозрачности, что и у выделенного; 
Same > Style (Тот же стиль) - выделяет все объекты имеющие одина-

ковые атрибуты стиля; 
Object > Masks (Маски) - выделяет в документе все маски; 
Object > Stray Points (Изолированные точки) - выделяет в документе 

все изолированные точки; 
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Object > Brush Strokes (Кисти) - выделяет в документе все декоратив-
ные контуры, т.е. оформленные с помощью кисти. 

 
1.3.4. Выравнивание и распределение объектов 

 
Для выравнивания объектов по другим объектам в горизонтальном и 

вертикальном направлении, а также для размещения их на равном расстоя-
нии друг от друга используется палитра Align (Выравнивание). Как и все 
палитры, она выводится на экран с помощью одноименной команды меню 
Window (Окно). 

 

Рис. 1.9. Палитра Align (Выравнивание) 
 
В палитре Align (Выравнивание) представлены три ряда кнопок: 
1) Align Objects (Выровнять объекты) - позволяет выравнивать выде-

ленные объекты по левому/правому/верхнему /нижнему краю, а также по 
вертикальному/ горизонтальному центу. 

 

 

Рис. 1.10. Выравнивание объектов по горизонтали 
 

2) Distribute Objects (Распределить объекты) - позволяет размещать 
выделенные объекты на равном расстояниям между левыми / правыми / 
верхними / нижними краями, а также между горизонтальными / вертикаль-
ными центрами. 

 

 
Рис. 1.11. Распределение центра объектов на равном расстоянии  
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3) Distribute Spacing (Распределить с равными промежутками) - поз-
воляет обеспечить одинаковые расстояния между объектами по вертикали и 
горизонтали. 

 
Рис. 1.12. Распределение объектов на равном расстоянии по горизонтали 

 
Если в окошке-списке в нижней части палитры установлен режим Auto 

(Автоматически), то положение крайних объектов при распределении фик-
сировано. 

Если же в поле ввести число, то расстояние между объектами будет рав-
но этому значению. Объект, относительно которого будет происходить 
распределение, нужно выделить еще раз после выделения всех объектов с 
помощью инструмента Selection (Выделение).  

При последовательном выделении объектов выравнивание происходит 
относительно последнего, при выделении рамкой ⎯ по крайнему объекту со-
ответствующей стороны. 

 
1.3.5. Группировка объектов 

 
Группирование объектов позволяет объединять несколько выбранных 

объектов в единый сложный объект, что позволяет в дальнейшем осуществ-
лять преобразование группы объектов без изменения их формы и взаимного 
расположения.  

Для того, чтобы сгруппировать / разгруппировать объекты их сначала 
необходимо выделить и выполнить одно из действий: 

– сгруппировать объекты - команда Group (Сгруппировать) меню 
Object (Объект) или контекстного меню выбранных объектов, а также ком-
бинация клавиш <Ctrl+G>; 

– разгруппировать объекты - команда Ungroup (Разгруппировать) ме-
ню Object (Объект) или контекстного меню группы объектов, а также 
комбинация клавиш <Shift+Ctrl+G>. 

Выделить один объект в группе можно с помощью инструмента 
 Group Selection (Выделение объекта в группе) или  Direction Selection 

(Частичное Выделение).  
Группы могут вкладываться друг в друга, т.е. объединяться с другими 

объектами или группами для образования новой группы большего размера. С 
помощью инструмента  Group Selection (Выделение объекта в группе) 
можно выделять объекты, подгруппы и группы объектов, при этом: 

первый щелчок - приводит к выделению объекта в группе; 
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второй щелчок - приводит к выделению всех объектов, находящихся в 
одной с ним подгруппе (если есть подгруппы); 

последующие щелчки - приводят к выделению объектов, принадлежащих 
к подгруппам объектов на последующих уровнях группирования. 

 
1.4. Методические указания к лабораторной работе 

 
1. Присвоение параметров заливки и обводки. Откройте исходный 

файл, предназначенный для выполнения данного задания. На блоке управле-
ния цветом установите параметры заливки и обводки по умолчанию 
(клавиша <D>). Присвойте векторным объектам различные атрибуты пара-
метров заливки и обводки. Создайте три итоговых векторных объекта с 
различными параметрами: первый - с заливкой и обводкой, второй - с залив-
кой, но без обводки; третий - без заливки, но с обводкой. Цвет на данном 
этапе можно выбрать двойным щелчком на индикаторе блока управления 
цветом. 

2. Выравнивание и распределение объектов. Откройте исходный 
файл, предназначенный для выполнения данного задания. Вызовите на экран 
палитру Align (Выравнивание). Выполните выравнивание объектов по гори-
зонтали. Далее распределите объекты таким образом, чтобы расстояние 
между их центрами было равным. Установите режим распределения объек-
тов, который позволяет определить точное расстояние между ними. Введите 
в поле произвольное число и определите объект, относительно которого бу-
дет осуществляться распределение, затем выполните операцию 
расположения объектов по горизонтали (вертикали). Поупражняйтесь в вы-
равнивании и распределении объектов, используя различные опции, 
предлагаемые палитрой выравнивания. 

3. Выделение и группирование объектов. Откройте исходный файл, 
предназначенный для выполнения данного задания. Выберите инструмент 

 Selection (Выделение), выделите несколько объектов и сгруппируйте их. 
Затем, не снимая выделения, активизируйте инструмент  Group Selection 
(Выделение объекта в группе) и переместите один из элементов в группе в 
другое место документа. Снимите выделение щелчком в любом месте доку-
мента с нажатой клавишей <Ctrl>. Выберите инструмент  Direction 
Selection (Частичное Выделение) и выделите несколько опорных точек од-
ним из описанных выше методов. Измените форму объекта (объектов) 
перемещая опорные точки в любом направлении. Продолжите проводить 
эксперименты с различными инструментами выделения. 

4. Дополнительные способы выделения объектов. Откройте исход-
ный файл, предназначенный для выполнения данного задания. Выделите 
элемент векторного объекта, имеющий цвет заливки и обводки. С помощью 
команды Select >  Same > Fill & Stroke (Выбор > Одинаковый > Заливка и Об-
водка) выделите все объекты в документе, имеющие те же цвета заливки и 
обводки, и перекрасьте их. Далее аналогичным образом, выбирая различные 
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команды Same (Одинаковый) меню Select (Выбор) перекрасьте объекты, 
имеющие одинаковый цвет заливки, одинаковый цвет обводки, поменяйте 
толщину обводки и т.п. 

Исходные данные для изучения текущего материала выдаются препода-
вателем в электронном виде.  

В процессе выполнения заданий, для развития навыков по управлению 
документом и выводом изображения на экран, а также для организации более 
эффективной работы в дальнейшем, используйте материал, описанный в 
ПРИЛОЖЕНИИ 1и 2.  

 
1.5. Контрольные вопросы 

 
1. Какие параметры могут быть присвоены контуру (path)? 
2. Что понимается под термином заливка (fill)? 
3. Какими параметрами характеризуется обводка (stroke)? 
4. Каким способом можно установить цвета по умолчанию в блоке 

управления цветом? 
5. Можно ли выделить опорную точку инструментом  Select (Выделе-

ние)? 
7. Как отредактировать форму объекта? 
8. Как распределить объекты на равном расстоянии друг от друга? 
9. Как выделить объект из группы объектов? 
10. Как изменить форму одного объекта в группе? 
 
 

2. ЛАБОРАТОРНАЯ РАБОТА №2 
«Создание линий и геометрических фигур» 

 
2.1. Цель работы 

 
Изучить технологию создания стандартных фигур и линий с помощью 

простейших инструментов рисования. Приобрести навыки практической ра-
боты с разнообразными средствами рисования и научиться создавать и 
редактировать простые векторные объекты.  

 
2.2. Задание к лабораторной работе 

 
Создайте на основе геометрических примитивов свой собственный объ-

ект (рис.2.1). Тема произвольная. На данном этапе для определения цветовых 
характеристик объекта рекомендуется использовать блок управления цветом, 
расположенный на палитре инструментов и градации серого цвета. В даль-
нейшем, после изучения приемов работы с цветом, к объектам можно 
применить более интересное цветовое решение. 
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Полученный результат сохраните в файле «object.ai», сдайте преподава-
телю на проверку и защитите его.  

    

Рис. 2.1. Объекты на основе стандартных геометрических фигур  
 
 

2.3. Создание линий и геометрических фигур 
 
К инструментам рисования геометрических фигур и простейших форм 

относятся инструменты группы  Rectangle (Прямоугольник),  Line Seg-
ment (Линейный сегмент) и  Pencil (Карандаш). 

 
2.3.1. Инструменты группы Rectangle (Прямоугольник) 

 
1)  Rectangle (Прямоугольник) - предназначен для создания фигур 

прямоугольников (квадратов). 
2)  Raunded Rectangle (Скругленный прямоугольник) - предназначен 

для создания фигур прямоугольников (квадратов) со скругленными углами; 
3)  Ellipse (Эллипс) - предназначен для создания эллипсов (кругов); 
4)  Polygon (Многоугольник) - предназначен для создания фигур пра-

вильных выпуклых многоугольников; 
5)  Star (Звезда) - предназначен для создания фигур звезд. 

 
Общее в рисовании геометрических фигур: 
- рисование из центра - при нажатой клавише <Alt>; 
- получение квадрата или круга - при нажатой клавише <Shift>; 
- звезды, спирали, многоугольники всегда рисуются из центральной точ-

ки. 
Советы по рисованию многоугольников, спиралей и звезд: 
- увеличить число сторон многоугольника, лучей звезды, сегментов спи-

рали - нажимать клавишу <↑> или <↓> не отжимая клавиши мыши; 
- повернуть фигуру - перетаскивать указатель мыши по дуге; 
- удержать сторону или луч в верхнем направлении - удерживать нажа-

той клавишу <Shift>; 
- сохранить постоянный внутренний радиус - протянуть указатель мы-

ши, а затем нажать и удерживать клавишу <Ctrl>; 
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- переместить фигуру в процессе рисования - нажать и удерживать кла-
вишу <Пробел>; 

- создать несколько копий фигуры, во время рисования - удерживать 
клавишу <∼> (тильда). 

 
2.3.2. Инструменты группы Line Segment (Линейный сегмент) 

 
1)  Line Segment (Линейный сегмент) – предназначен для создания 

прямолинейных отрезков от заданной точки.  
2)  Arc (Дуга) – предназначен для создания криволинейного сегмента 

от заданной точки. Степень кривизны дуги, в процессе рисования, регулиру-
ется путем последовательных щелчков на клавише <↑> или <↓>. 

3)  Spiral (Спираль) – предназначен для создания фигур спиралей, об-
ладающих двумя свойствами: промежутки спирали расширяются при 
удалении от нее центра и данная фигура представляет собой контур Безье. 

4)  Rectangle Grid (Прямоугольная сетка) – предназначен для созда-
ния фигур прямоугольных сеток, которые состоят их вертикальных и 
горизонтальных отрезков, расстояние между которыми могут быть одинако-
выми или монотонно изменяться. 

5)  Polar Grid (Полярная сетка) - предназначен для создания фигур 
полярных сеток, состоящих из серии концентрических эллипсов и прямоли-
нейных отрезков, исходящих от центра фигуры, расстояния между которыми 
могут быть одинаковыми или монотонно меняться. 

 
2.3.3. Инструменты группы Pencil (Карандаш) 

 
1)  Pencil (Карандаш) - предназначен для рисования от руки разомкну-

тых векторных контуров Безье путем перетаскивания указателя по области 
документа при нажатой кнопки мыши. В результате работы данного инстру-
мента получается векторный контур, в котором опорные точки 
расставляются программой автоматически.  

Число опорных точек зависит от длины и сложности линии, а также от 
диалогового окна Pencil Tool Preferences (Параметры инструмента каран-
даш), которое вызывается двойным щелчком на кнопке инструмента (рис. 
2.2). 

Параметры инструмента Pencil (Карандаш): 
- Fidelity (Точность) - расстояние между пикселями, чем больше его зна-

чение, тем меньше опорных точек, появляющихся на траектории; 
- Smoothness (Гладкость) - определяет количество опорных точек. Его 

увеличение минимизирует число опорных точек; 
- Keep selected (Оставить выделенным) - оставляет контур  выделенным 

после прекращения рисования; 
- Edit select paths (Редактировать выделенные контуры) - обеспечивает 

возможность продолжить уже нарисованную кривую; 
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- Within (Внутри) - определяет, сколько пикселей должно быть между 
концом исходной и началом новой кривой, чтобы они объединились в одну. 

Для автоматического замыкания контура в конце рисования  необходи-
мо нажать клавишу <Alt>. 

2) Smooth (Сглаживание) - сглаживает контуры (удаление части 
опорных точек), уменьшает количество опорных точек выделенной кривой, 
если провести им вдоль траектории. 

3)  Erase (Ластик) - удаляет фрагменты выделенного контура (не ра-
ботает с текстом и градиентной сеткой). 

 

 
Рис.2.2. Диалоговое окно инструмента Pencil (Карандаш) 

 
 

2.3.4. Палитра Stroke (Контур) 
 
Палитра Stroke (Контур), которая вызывается на экран при помощи ко-

манды Stroke (Обводка) меню Window (Окно) и служит для определения 
основных параметров контурам (рис.2.3). 

 
1.Weight - толщина обводки 
2.Группа Cap - тип окончания линии  
3.Miter Limit - замена острых углов на срезанные  
4.Группа Join - тип сочленения линий 
5.Align Stroke - выравнивание обводки относитель-
но центра 
6.Dashed Line - пунктир 
7.Dash - штрих 
8.Gap  - зазор 

Рис. 2.3. Палитра Stroke (Контур) 
 

В поле Weight (Толщина) задается толщина линии в пунктах (один пункт 
равен 0,353 мм). Если в данное поле установить значение толщины, равное 0, 
то при выводе на экран или при печати толщина линии трактуется как линия 
толщиной в 1 пиксель, и ее конкретная толщина зависит от разрешения вы-
водного устройства. Для того чтобы контур имел действительно нулевую 
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толщину контура, следует присвоить ее с помощью кнопки None (Без атри-
бута) в палитре инструментов.  

В группе Сар (Концы) представлены кнопки, определяющие три типа 
окончания линии: 

 - срезанные концы; 
 - скругленные концы; 
 - выступающие концы. 

В группе Join (Стыки) также представлены кнопки, определяющие три 
типа сочленения линий: 

 - угловые стыки; 
 - скругленные стыки; 
 - скошенные стыки. 

   

     

а) концы б) стыки 

Рис. 2.4 - Концы и стыки линий 
 
Параметром Miter Limit (Замена острых углов на срезанные) задается 

значение, превышение которого приводит к срезу стыка.  
Форма линии определяется в полях Dash (Штрих) и Gap (Зазор) при 

установленном флажке Dashed Line (Пунктирная линия). 
 

 
 
 

Рис. 2.5. Пунктирная линия 
 
В группе Align Stroke (Выравнивание обводки) представлены кнопки, 

определяющие выравнивание обводки относительно контура: 
 - обводка по центру линии 
 - обводка внутри линии 
 - обводка снаружи линии 

  
а) по центру б) внутри в) снаружи 

Рис. 2.6. Выравнивание обводки



22 

 

2.4. Методические указания к лабораторной работе  
 
1. Установка цвета заливки и обводки. Установите цвет заливки и об-

водки по умолчанию. Для этого в блоке управления цветом щелкните на 
соответствующем значке Default Fill and Stroke (Цвета заливки и обводки по 
умолчанию). В результате цвет заливки станет белым, а цвет обводки ― чер-
ным. Затем активизируйте индикатор заливки и щелкните на кнопке None 
(Отсутствует), чтобы удалить цвет заливки.  

2. Создание геометрических фигур. Создайте с помощью инструмен-
тов группы Rectangle (Прямоугольник) стандартные геометрические 
фигуры, аналогичные представленным на рисунке 2.7. процессе создания фи-
гур используйте советы, приведенные выше в п.2.3.1. Создайте различными 
способами несколько собственных фигур. 

 
Рис. 2.7. Геометрические фигуры (примитивы) 

3. Создание фигур с прямыми углами. Создайте с помощью инстру-
мента Line Segment (Линия) геометрические фигуры с прямыми углами, 
аналогичные представленным на рисунке 2.8. Помните, что если в процессе 
рисования удерживать нажатой клавишу <Shift>, то линия будет установлена 
под определенным углом, а для перемещения линии или изменения ее разме-
ра необходимо нажать и удерживать клавишу <Ctrl>. 

 
Рис. 2.8. Геометрические фигуры с прямыми углами 

4. Создание фигур произвольной формы. Создайте с помощью ин-
струмента Pencil (Карандаш) фигуры произвольной формы, аналогичные 
представленным на рисунке 2.9. Для автоматического замыкания контура в 
конце рисования нажимайте клавишу <Alt>. Если полученный результат не 
удовлетворительный, то повторите попытку, используя возможности  
настройки параметров инструмента и сглаживания контура. 

 
Рис. 2.9. Геометрические фигуры произвольной формы 

5. Создание несимметричных фигур. Создайте с помощью инструмен-
тов группы Line Segment (Линия) несимметричные фигуры, состоящие из 
отдельных прямых и кривых линий, аналогичные представленным на рисун-
ке 2.10. Сначала выберите инструмент  Line Segment (Линия) и создайте 
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все прямые линии первой фигуры, Далее выберите инструмент Arc (Дуга) 
и нарисуйте дугообразные линии. Соедините полученные линии и сгруппи-
руйте их. Постройте аналогичным образом вторую несимметричную фигуру. 
Создайте несколько собственных несимметричных фигур с различной степе-
нью кривизны. 

 

Рис. 2.10. Несимметричные  фигуры  
 
 

2.5. Контрольные вопросы  
 
1. Какие инструменты используются для создания простых фигур? 
2. Как нарисовать квадрат? 
3. Как нарисовать эллипс из центра? 
4. Как автоматически  замкнуть контур в конце рисования?   
5. Каким образом можно преобразовать прямую линию в пунктирную?  
6. Опишите различные способы изменения толщины обводки? 
7. Какие клавиши позволяют изменить степень кривизны дуги в процес-

се рисования? 
8. Как увеличить количество сторон многоугольника в процессе рисова-

ния? 
 

 
3. ЛАБОРАТОРНАЯ РАБОТА №3  

«Работа с цветом» 
 

3.1. Цель работы 
 
Изучить особенности работы с цветом, типы и способы создания сплош-

ных, градиентных и декоративных заливок. Приобрести навыки 
практической работы по созданию цветных векторных изображений. 

 
3.2. Задание к лабораторной работе 

 
Создайте новые образцы цвета, градиентной и декоративной заливки, 

сохраните их в палитре Swatches (Образцы) и раскрасьте с их помощью гра-
фический объект, созданный в лабораторной работе №2. Сохраните 
использованные для заливки объекта образцы цвета в своей библиотеке об-
разцов, предварительно удалив все лишние.  
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Цветной векторный объект сохраните в файле «color.ai», сдайте препо-
давателю на проверку и защитите его.  

 

 

Рис.3.1. Раскрашенные графические объекты  
 
 

3.3. Работа с цветом 
 
В векторных иллюстрациях цвет может применяться как для обводки, 

так и для заливки. Обводка повторяет контур объекта, а для заливки исполь-
зуется ограниченная контуром область.  

Изменить цвет обводки и заливки можно с помощью:  
- блока управления цветом; 
- палитры Color (Цвет) и Swatches (Образцы); 
- диалогового окна ColorPicker (Цветовая палитра); 
- библиотеки образцов; 
- инструмента EyedropperTool (Пипетка) и Paint Bucket (Заливка). 
Кроме того, в качестве заливки можно использовать градиентные пере-

ходы цвета, для создания которых применяют: 
- инструмент Gradient (Градиент); 
- палитру Gradient (Градиент). 
 

3.3.1. Цветовые режимы и модели 
 
Для отображения, печати и хранения изображений используются раз-

личные цветовые режимы, в основе которых заложены базовые модели 
описания цветов. К наиболее распространенным цветовым моделям относят-
ся: 

Модель RGB - используется при задании и описании цветов на экране 
монитора. В нее входят следующие основные цветовые компоненты: Red - 
красный; Green - зеленый; Blue - синий. Значения цветовых составляющих 
могут изменяться в пределах от 0 до 255. 

Модель CMYK - используется при задании и описании цветов в публика-
циях, предназначенных для печати. Основные цветовые компоненты этой 
модели: Cyan - голубой; Magenta - пурпурный; Yellow - желтый; Black - чер-
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ный. Значения цветовых составляющих могут изменяться в пределах от 0 до 
100 %.  

Модель HSB - наиболее близка к физическому восприятию цвета челове-
ком. В ней для описания цвета используются три компонента:  

- Hue - цветовой тон. Изменяется в пределах от 0 до 360°. 
- Saturation - насыщенность. Изменяется в пределах от 0 до 100 %. 
- Brightness - яркость. Изменяется в пределах от 0 до 100 %. 
Режим Grayscale (градации серого) - это не модель, а режим, предна-

значенный для работы с черно-белыми изображениями. Цвета в этой модели 
представляют собой оттенки серого и могут задаваться в диапазоне от 0 до 
100 %. 

Выбор цветового режима документа зависит от того, будет изображение 
выводиться на экран (режим RGB) или на печать (режим CMYK). Цветовой 
режим можно установить или изменить в любое время. Для этого необходи-
мо выполнить команду Document Color Mode (Цветовой режим документа) 
меню File (Файл). 

 
3.3.2. Типы цвета 

 
Цвета, используемые в программе можно обозначить либо как плашеч-

ные (spot color), либо как триадные (process color). Эти два вида цветов 
соответствуют двум основным видам красок, используемым при печати про-
дукции. 

Плашечный цвет (spot color) - это особая, заранее созданная смесь кра-
сок, которая применяется вместо или в дополнение к триадным цветам и 
требует использования отдельной печатной формы на печатном станке. Пла-
шечные цвета следует использовать в том случае, когда задается немного 
цветов и достоверность цветопередачи имеет очень важное значение. Пла-
шечные цвета всегда глобальны, т.е. при любых изменениях он изменяется во 
всем документе.. 

Триадный цвет (process color) - печатается с помощью сочетания четы-
рех стандартных триадных цветов: cyan (голубого), mangenta (пурпурного), 
yellow (желтого) и black (черного). Триадные цвета следует применять в тех 
случаях, когда при печати необходимо использовать большое количество 
цветов и использование плашечных красок становится дорогим или непрак-
тичным (например, при печати цветных фотографий). Триадные цвета могут 
быть как глобальными, так  и неглобальными: 

- глобальный триадный цвет (global process color) - автоматически об-
новляется во всех объектах всего документа, если их параметры меняются в 
палитре Swatches (Образцы). 

- неглобальный триадный цвет (non-global process color) - сохраняет 
свои параметры при изменении их в палитре Swatches (Образцы).  

По умолчанию все триадные цвета являются неглобальными.  
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3.3.3. Палитра Color (Цвет) 
 
Палитра Color (Цвет) позволяет задавать цвет в одной из доступных 

цветовых моделей и переключаться между выбором цвета обводки и цвета 
заливки выделенного объекта (рис.3.2). Для вызова палитры Color (Цвет) на 
экран необходимо выполнить команду Color (Цвет) меню Window (Окно). 

Самый простой способ определения цвета в этой палитре ― это поме-
стить курсор на широкую полосу, представляющую спектр цветовой модели, 
курсор при этом примет вид инструмента EyedropperTool (Пипетка) и 
щелкнуть на искомом цвете. Левее от спектра расположено поле исключения 
заливки или обводки, а правее – поля белого и черного цветов. 

 
Рис.3.2. Палитра Color (Цвет) 

Более точное определение цвета происходит с помощью перемещения 
движков на полосах цветовых составляющих соответствующей цветовой мо-
дели. Эти параметры можно определить, задав числовые значения в полях, 
расположенных справа от цветовых полос:  

RGB - от 0 до 255 
CMYK - от 0 до 100% 
HSB - Н (Hue) - от 0 до 360 град; S (Saturation) - от 0 до 100%; В 

(Brightness) - от 0 до 100% 
Grayscale - от 0 до 100% 
Web Safe RGB - цвета web-безопасной палитры. 
Команды Invert (Инверсный) и Complement (Дополнительный) меню 

палитры позволяют получить к текущему цвету инверсный (негативный) и 
дополнительный цвета, соответственно.  

 
3.3.4. Диалоговое окно Color Picker (Цветовая палитра) 

 
Диалоговое окно ColorPicker (Цветовая палитра) позволяет визуально 

выбрать цвет в цветовом пространстве или задать его по математическому 
описанию. Для вызова диалоговое окно на экран  необходимо дважды щелк-
нуть по кнопке фона или контура в блоке управления цветом палитры Tools 
(Инструменты) или в палитре Color (Цвет). 
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В окне Color Picker (Цветовая палитра) можно выбирать и просматри-
вать цвета во всех доступных цветовых моделях одновременно (рис.3.3). 
Справа представлена полоса спектра, на которой выбирается цветовой тон 
(красный, синий, зеленый и т.д). В области слева выбирается насыщенность 
(горизонтальное направление) и яркость (вертикальное направление) вы-
бранного цветового тона.  

В прямоугольнике вверху правее полосы спектра, указывается выбран-
ный цвет: текущий цвет отображается в верхней части прямоугольника и 
автоматически обновляется при выборе другого цвета, в нижней части пря-
моугольника указывается первоначальный цвет выделенного объекта.  

 
Рис. 3.3. Диалоговое окно Color Picker (Цветовая палитра) 

 
Правее отображаются предупреждения о выходе за пределы допустимой 

гаммы. Это предупреждение появляется, если выбранный цвет не входит в 
гамму цветов для Web (значок с изображением кубика) или в гамму CMYK 
(значок с изображением треугольника с восклицательным знаком). Если 
щелкнуть на верхнем значке, будет выбран наиболее близкий цвет из гаммы 
CMYK, а на нижнем - наиболее близкий цвет из гаммы цветов для Web. В 
остальных областях диалогового окна можно просматривать и задавать чис-
ловые значения цвета во всех четырех моделях. 

 
3.3.5. Палитра Swatches (Образцы) 

 
Палитра Swatches (Образцы) предназначена для хранения, редактирова-

ния и использования образцов цветов (рис.3.4). Для вызова палитры на экран 
необходимо выполнить команду Swatches (Образцы) меню Window (Окно). 

С помощью этой палитры можно выбирать цвета из набора образцов, 
сохранять собственные образцы, а также создавать свои библиотеки образцов 
цвета и использовать их в других документах или воспользоваться уже гото-
выми библиотеками.  
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Рис.3.4. Палитра Swatches (Образцы) 

 
В палитре Swatches (Образцы) могут храниться не только образцы 

сплошных заливок, но также градиенты и узоры. Все образцы, сохраняемые в 
данной палитре, относятся только к текущему документу. 

Переносить образцы цвета можно из палитр Color (Цвет) и Gradient 
(Градиент), а также из цветовых индикаторов Fill (Заливка) и Stroke (Обвод-
ка), расположенных на панели инструментов. Щелчок на образце в палитре 
Swatches (Образцы), переносит цвет, градиент или узор в палитры Color 
(Цвет) и Gradient (Градиент). 

Палитра Swatches (Образцы) позволяет добавлять, дублировать и уда-
лять произвольное количество образцов. Для этих целей удобно пользоваться 
меню палитры, которое открывается щелчком на кнопке со стрелкой в верх-
нем правом углу. 

 
1. Добавление нового образца цвета 
 
Для добавления нового образца необходимо в палитрах Color (Цвет) 

или Gradient (Градиент) подготовить цвет, градиент или создать узор (эле-
мент декоративной заливки). Затем можно воспользоваться кнопкой New 
Swatch (Новый образец) в нижней части палитры или одноименной командой 
из меню палитры, которая выводит на экран диалоговое окно New Swatch 
(Новый образец). 

 

Рис. 3.5. Диалоговое окно New Swatch (Новый образец) 

 
Параметры диалогового окна New Swatches (Новый образец): 
- Swatch Name (Имя) - произвольное имя; 
- Color Type (Тип цвета) - Process Color или Spot Color (триадный или 

плашечный); 
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- Global (Глобальный) - устанавливается для глобального изменения па-
раметров триадного цвета во всем документе; 

- Color Mode (Цветовой режим) - цветовой режим (CMYK, RGB, HSB 
или Grayscale) для определения параметров цвета.  

Цвет или градиентную растяжку можно «перетащить» из цветового ин-
дикатора палитры инструментов и расположить не только на свободном 
пространстве, но и между любой парой существующих образцов. Если при 
«перетаскивании» цвета удерживать клавишу <Ctrl>, то цвет любой модели 
будет конвертирован в плашечный. Той же цели можно достичь, если при 
щелчке на кнопку New Swatch (Новый образец) удерживать клавишу <Ctrl>.  
 

2. Удаление образца цвета 
 
Для удаления образца цвета, его необходимо выделить, щелкнув на нем 

левой кнопкой мыши. Для выделения нескольких образцов, расположенных 
вразбивку, необходимо удерживать клавишу <Ctrl>, а для расположенных 
подряд - клавишу <Shift>. Затем можно воспользоваться одним из способов 
удаления:  

- выбрать команду Delete Swatch (Удалить образец) меню палитры;  
- щелкнуть на кнопке Delete Swatch (Удалить образец), расположенной 

в нижней части палитры;  
- захватив выделенный образец «перетащить» его на кнопку Delete 

Swatch (Удалить образец).  
 

3.3.6. Инструменты Eyedropper (Пипетка) и Paint Bucket (Заливка) 
 
Тандем инструментов Eyedropper (Пипетка) и Paint Bucket (Быстрая 

заливка) палитры Tools (Инструменты) позволяет легко обмениваться пара-
метрами как в пределах одного документа, так и в нескольких открытых 
документах: 

 Eyedropper (Пипетка) - копирует параметры объектов в палитры.  
 Paint Bucket (Быстрая Заливка) –присваивает параметры другим 

объектам. 
Взаимное переключение этих инструментов осуществляется с помощью 

клавиши <Alt>. Следует иметь в виду, что щелчок инструментом 
Eyedropper (Пипетка) на объекте или даже на рабочем поле изменяет 

установки палитр Color (Синтез), Gradient (Градиент) и Stroke (Обводка) 
вне зависимости от того, выведены ли они на экран. Это означает, что всем 
вновь создаваемым объектам будут присваиваться эти параметры до тех пор, 
пока не будут установлены новые.  
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3.3.7. Работа с библиотеками образцов 
 
Обеспечить доступ ко многим цветовым библиотекам, которые широко 

используются в полиграфии, можно с помощью команды Open Swatch 
Library (Открыть Библиотеку Образцов) меню палитры Swatches (Образ-
цы) или команды Swatch Libraries (Библиотеки образцов) меню Window 
(Окно). 

Использовать цветовые образцы, градиенты и узоры из других докумен-
тов можно с помощью команды Other Library (Другая библиотека) меню 
Window > Swatch Libraries (Окно > Библиотеки образцов).  

При копировании объектов из одного документа в другой вместе с ними 
переносятся и параметры цветов.  

 
3.3.8. Градиентные и декоративные заливки 

 
В качестве заливки для векторных, текстовых и составных объектов 

можно использовать не только сплошной цвет, но и более сложные построе-
ния, такие как градиенты (gradient) и узоры (pattern).  

 
Градиентные заливки 

 
Градиентные заливки используются для создания плавных переходов 

цвета для одного объекта или группы объектов, а также для придания объек-
там объемного вида. Градиентные заливки могут быть двухцветными и 
многоцветными двух видов (рис.3.6.):  

1) Linear (Линейный) - цветовой переход распространяется вдоль пря-
мой линии;  

2) Radial (Радиальный) - цветовой переход распространяется по концен-
трическим окружностям.  

Для создания и настройки градиентной заливки используются палитра и 
инструмент Gradient (Градиент) 

  
а)  б) 

Рис. 3.6. Типы градиента: а) линейный, б) радиальный  
 
1.1. Палитра Gradient (Градиент) 
 
Параметры градиентной заливки определяются в палитре Gradient 

(Градиент), которая вызывается одноименной командой меню Window (Ок-
но).  
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Рис. 3.7. Палитра Gradient (Градиент) 
 
Для определения начального цвета растяжки следует щелкнуть мышью 

на левом прямоугольнике под полосой просмотра и выполнить одно из сле-
дующих действий:  

- при нажатой клавише <Alt> щелкнуть на одном из образцов палитры 
Swatches (Образцы);  

- определить новый цвет в палитре Color (Цвет).  
Для определения конечного цвета растяжки нужно щелкнуть мышью на 

правом квадратике под полосой просмотра и использовать указанные воз-
можности.  

В раскрывающемся списке Туре (Тип) можно выбрать один из двух ти-
пов градиента. 

В линейной растяжке можно изменить угол наклона, для этого в поле 
Angle (Угол) следует ввести соответствующее значение в диапазоне от -180 
до 180 градусов (рис.3.8).  

 

Рис. 3.8. Изменение угла наклона градиента  
 
Начальную и конечную точки растяжки можно перемещать вдоль поло-

сы, сужая или расширяя диапазон растяжки. По умолчанию центральная 
точка располагается строго посередине. Если требуется сместить централь-
ную точку, то необходимо переместить ромбик над полосой просмотра или 
ввести соответствующее значение в поле Location (Положение).  

Для сохранения градиента в документе достаточно из палитры Gradient 
(Градиент) или из цветового индикатора заливки в палитре инструментов 
«перетащить» растяжку в палитру Swatches (Образцы). Этой же цели можно 
достичь, если щелкнуть на кнопке New Swatch (Новый образец) в нижней ча-
сти палитры. 

 
 



32 

 

1.2. Инструмент Gradient 
 

Инструмент  Gradient (Градиент) позволяет в интерактивном режиме 
изменить направление растяжки, переопределить начальную и конечную 
точки, а также присвоить параметры градиента одновременно нескольким 
объектам («растянуть» ее на несколько объектов).  

Для того чтобы переопределить направление растяжки, необходимо вы-
делить объект, включить инструмент  Gradient (Градиент), подвести 
курсор к начальной точке растяжки, нажать кнопку мыши, протянуть ее к ко-
нечной точке и отпустить кнопку. При удерживании клавиши <Shift> 
обеспечивается направление линии, кратное 45 градусам.  

Для того чтобы «протянуть» растяжку через несколько объектов, необ-
ходимо выделить эти объекты и посредством палитр Color (Цвет) или  
Swatches (Образцы) каждому из них присвоить параметры требуемой рас-
тяжки, затем включить инструмент  Gradient (Градиент) и с его помощью 
«протянуть» воображаемую линию через все объекты.  

 
Декоративные заливки 

 
Декоративная заливка представляет собой заполнение внутренней обла-

сти объекта тем или иным узором. Узор обычно принято называть текстурой 
или декоративным элементом (tiles), который может быть двухцветным или 
многоцветным. Текстурные заливки используются для декоративного 
оформления иллюстраций и выполняются посредством многократного по-
вторения определенного узора (рис. 3.9). 

 

 
Рисунок 3.9. Примеры декоративных заливок 

 
Декоративные заливки можно создавать самостоятельно, используя в 

качестве основного элемента векторный объект. В качестве основы нельзя 
использовать: объекты с градиентной и декоративной заливкой; маскиро-
ванные объекты; декоративные кисти; растровые изображения; графики и 
диаграммы. 

 
2.1. Создание узоров 
 
При создании узора следует избегать не только сложных конструкций и 

многоцветия, но также нарисовать прямоугольник - элемент (tile), выполня-
ющий роль ограничительной рамки вокруг рисунка, который предполагается 
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использовать в качестве узора. Ограничительный прямоугольник необходимо 
сделать невидимым (без обводки и заливки) и сделать нижним объектом. 

Рисунок, предназначенный для использования в качестве элемента за-
ливки (рис.3.10), следует выделить вместе с ограничительной рамкой, после 
чего необходимо выполнить одно из двух действий, для того чтобы поме-
стить новую заливку в палитру Swatches (Образцы):  

- выполнить команду Define Pattern (Определить элемент заливки) ме-
ню Edit (Редактирование) и в открывшемся диалоговом окне New Swatch 
(Новый образец) ввести имя заливки;  

- просто «перетащить» выделенный объект в палитру Swatches (Образ-
цы).  

Если объект удовлетворяет требованиям программы, то декоративная 
заливка автоматически появится в палитре Swatches (Образцы). Для провер-
ки качества узора можно нарисовать простой объект и применить к нему 
созданную декоративную заливку. 

 
Рис.3.10. Создание узора 

 
2.2. Редактирование узоров 

 
Элементы декоративной заливки можно редактировать как любое век-

торное изображение и вернуть его в палитру Swatches (Образцы) под новым 
именем или заменить отредактированным изображением старое.  

Для редактирования узора сначала необходимо убедиться в отсутствии 
выделенных объектов, а затем «перетащить» элемент узора из палитры 
Swatches (Образцы) на рабочий стол.  

После редактирования узор можно обратно «перетащить» в палитру, в 
этом случае он получит новое стандартное имя и станет самостоятельным 
элементом. Если же в процессе «перетаскивания» удерживать клавишу <Alt> 
и поместить узор поверх старого образца, то он обновится не только в палит-
ре Swatches (Образцы), но и в текущем документе.  

 
2.3. Трансформирование объектов с декоративной заливкой 
 
Если объект имеет декоративную заливку, то его можно трансформиро-

вать (например, вращать или масштабировать) как вместе с заливкой, так и 
независимо от нее. Более того, можно трансформировать только элементы 
заливки.  

Выбор варианта трансформирования (объекта и заливки, только объекта 
или только заливки) осуществляется в разделе General (Основные) диалого-
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вого окна Preferences (Установки), которое вызывается командой 
Preferences (Установки) меню Edit (Правка), а также в диалоговых окнах, 
связанных с процессом трансформирования (перемещение, масштаби-
рование, поворот и т.п.)  

Для того чтобы обеспечить одновременное трансформирование объек-
тов и декоративной заливки, необходимо в разделе General (Основные) 
диалогового окна Preferences (Установки) установить флажок Transform 
Pattern Tiles (Трансформировать декоративные элементы). Если требуется 
трансформировать только объекты, не затрагивая декоративной заливки, этот 
флажок следует снять.  

С установкой в разделе General (Основные) диалогового окна 
Preferences (Установки) связаны установки диалоговых окон всех команд 
трансформирования (рис.3.11). Единственное отличие заключается в том, что 
последние располагают еще флажком Pattern (Узор), установка которого 
обеспечивает трансформирование только элементов заливки. 

 
Рис.3.11. Диалоговое окно команды Rotate (Поворот)  

 
Для трансформирования только элементов декоративной заливки в ин-

терактивном режиме (при помощи трансформирования в палитре 
инструментов) необходимо удерживать нажатой клавишу <~> (тильда).  

 
2.4. Преобразование объектов с градиентными и декоративными залив-

ками 
 
Преобразовать объекты с градиентными и декоративными заливками в 

серию более простых можно с помощью команды Expand (Преобразовать) 
меню Object (Объект), которая открывает одноименное окно.  

Объекты с градиентной заливкой можно конвертировать в простые объ-
екты, их количество в диапазоне от 1 до 10 000 определяется в поле Specify 
Objects (Определение объектов) и в сложные объекты с градиентной сеткой, 
если установить переключатель Gradient Mesh (Градиентная сетка). Объек-
ты, имеющие декоративные заливки, преобразуются автоматически.  
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3.4. Методические указания к выполнению работы 
 
1. Создание сплошной заливки. Создайте замкнутый криволинейный 

контур и залейте его образцом цвета, находящимся по умолчанию в палитре 
Swatches (Образцы). Поменяйте цвет заливки, используя цветовую линейку 
палитры Color (Цвет) и перемещение движков (R, G, В). Создайте с помо-
щью диалогового окна Color Picker (Цветовая палитра) образец сплошной 
заливки на свой вкус и залейте им криволинейный контур. Создайте несколь-
ко новых вариантов образцов цвета и сохраните их в палитре Swatches 
(Образцы). 

2. Создание градиентной заливки. Создайте замкнутый криволиней-
ный контур и залейте его градиентом, находящимся по умолчанию в палитре 
Swatches (Образцы). Поменяйте параметры градиентной заливки в палитре 
Gradient (Градиент) и направление растяжки с помощью инструмента Gradi-
ent (Градиент). Создайте собственную градиентную заливку и сохраните ее в 
палитре Swatches (Образцы). Выделите криволинейный контур и примените 
к нему созданную градиентную заливку. Создайте несколько вариантов но-
вой градиентной заливки с различными параметрами и сохраните их в 
палитре Swatches (Образцы). 

3. Редактирование узора. Создайте замкнутый криволинейный контур 
и залейте его узором, находящимся по умолчанию в палитре Swatches (Об-
разцы). Отредактируйте элементы узора и сохраните его в палитре Swatches 
(Образцы). Выделите криволинейный контур и примените к нему отредакти-
рованную декоративную заливку. 

4. Создание симметричного узора. Создайте собственный симметрич-
ный узор, габаритные размеры которого вписываются в прямоугольник, и 
сохраните его в палитре Swatches (Образцы). Создайте замкнутый криволи-
нейный контур и примените к нему созданную декоративную заливку. Если 
декоративная заливка получилась с дефектами, исправьте недостатки. Со-
здайте несколько новых вариантов симметричного узора и сохраните их в 
палитре Swatches (Образцы). 

5. Создание несимметричного узора. Создайте несимметричный узор, 
габаритные размеры которого вписываются в прямоугольник. Процесс со-
здания несимметричного узора требует больше внимания и умения. 
Сохраните узор в палитре Swatches (Каталог). Создайте замкнутый криволи-
нейный контур и примените к нему созданную декоративную заливку. Если 
декоративная заливка получилась с дефектами, исправьте недостатки.  

6. Создание библиотеки образцов. Создайте свою собственную биб-
лиотеку образцов, удалив предварительно все неиспользованные в рабочем 
документе образцы цвета, градиенты и узоры. 
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3.5. Контрольные вопросы 
 
1. Какие цветовые модели используются для описания цвета? 
2. От чего зависит выбор цветового режима документа? 
3. Опишите не менее трех способов заливки объектов цветом? 
4. Для чего нужны предупреждения, возникающие при создании ново-

го образца цвета?  
5. Как можно сохранить новый образец цвета? 
6. Как присвоить цвету имя? 
7. Каким образом можно создать декоративную заливку? 
8. Каким образом можно редактировать градиентную заливку? 
9. Опишите способы работы со стандартными библиотеками цветов 
 
 

4. ЛАБОРАТОРНАЯ РАБОТА №4.  
«Создание сложных контуров и фигур» 

 
4.1. Цель работы 

 
Изучить технологию создания векторных изображений с помощью кри-

вых Безье, основные элементы кривых Безье и инструменты, 
предназначенные для их создания и редактирования. Приобрести навыки 
практической работы с соответствующими инструментами и научиться со-
здавать и редактировать контуры произвольной формы. 

 
4.2. Задание к лабораторной работе 

 
Создайте объект на основе кривых Безье. Тема произвольная (животное, 

насекомое, сказочный герой и т.п.). В процессе работы используйте инстру-
менты и средства, предназначенные для создания и редактирования кривых 
Безье и работы с цветом. 

Полученный результат сохраните в файле «curve.ai», сдайте преподава-
телю на проверку и защитите его.  

 

    

Рис. 4.1. Объекты на основе кривых  
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4.3. Создание линий и фигур произвольной формы 
 

4.3.1. Основные элементы кривых Безье 
 
В основе векторного контура (path) лежит математический метод, пред-

ставляющий любую линию или фигуру в виде совокупности элементов трех 
типов: опорных точек, отрезков линий (сегментов) и управляющих точек. Та-
кой контур называется контуром Безье или кривой Безье. Достоинством 
векторного контура Безье является возможность в любой момент изменить 
форму, расположение и заливку объекта. 

Векторный контур (рис.4.2) состоит как минимум из одного прямоли-
нейного или криволинейного отрезка (сегмента), начало и конец которого 
обозначается опорными точками (anchor points).  

 
а) б) 

Рис. 4.2. Векторный контур:   
а) прямолинейный сегмент; б) криволинейный сегмент 

 
Опорные точки бывают двух типов (рис. 4.3):  
- гладкая опорная точка (smooth anchor point) - точка, в которой контур 
остается плавным;  
- угловая опорная точка (corner anchor point) - точка, в которой контур 
резко меняет свое направление.  

 

а) б) 

Рис. 4.3. Типы опорных точек:  
а) гладкая опорная точка;  б) угловая опорная точка 

 
Опорные точки имеют управляющие линии (control line) и управляющие 

точки (control point).  
Изменить форму сегмента (рис. 4.4) можно как перемещением опорных 

точек, так и перемещением управляющей точки (control point), связанной с 
опорной точкой посредством управляющей линии (control line). При пере-
мещении управляющей линии, относящейся к гладкой опорной точке, 
изменяются обе кривые. А при перемещении управляющей линии, относя-
щейся к угловой опорной точке, изменяется только кривая, расположенная с 
той же стороны.  
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Рис. 4.4. Изменение формы и размера контура 
 

Тип опорной точки можно изменить. Из гладкой точки можно получить 
угловую, и наоборот, угловая точка может быть преобразована в гладкую 
(рис.4.5). 

а)  б)  

Рис. 4.5. Изменение типа опорных точек:  
а) гладкой точки в угловую; б) угловой точки в гладкую 

 
 

4.3.2. Инструменты группы Pen (Перо) 
 

Основными инструментами, позволяющими создавать векторные конту-
ры произвольной формы, являются: 

1) Pen (Перо) - построение контуров по опорным точкам. Первичный 
инструмент работы с контурами, обеспечивающий высокую точность. 

2) Add Anchor Point (Добавить опорные точки) - добавление опор-
ной точки на контуре. 

3) Delete Anchor Point (Удалить опорные точки) - удаление опорной 
точки на контуре. 

4) Convert Anchor Point (Изменить тип опорной точки) - изменение 
типа опорной точки (из угловой точки в гладкую и наоборот). 

5) Direct Selection (Частичное выделение) - выделение опорных то-
чек, изменение формы сегмента контура путем перемещения выделенных 
опорных точек и управляющих линий. 

Инструмент Pen (Перо) предназначен для формирования любых век-
торных контуров путем выполнения последовательных щелчков или нажатий 
кнопки мыши в местах будущего расположения опорных точек, с возможной 
регулировкой кривизны текущего его участка перетаскиванием указателя по 
документу (при нажатой кнопке мыши). Контур, формируемый инструмен-
том Pen (Перо) выделяется на экране тонкой линией, раскрашенной 
служебным цветом своего слоя.  

Основное отличие контуров, создаваемых инструментом Pen (Перо), 
от контуров, образуемых инструментом Pencil (Карандаш) и Paintbrush 
(Кисть), состоит в более высокой точности их формирования и более глад-
ких формах. 
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Операции, выполняемые инструментом Add Anchor Point (Добавить 
опорные точки): 

- добавление сегмента (создание опорной точки); 
- замыкание контура (щелчок на начальной точке). 
Операции, выполняемые инструментом Convert Anchor Point (Изме-

нить тип опорной точки): 
- преобразование гладкой опорной точки в угловую (щелчок); 
- преобразование угловой опорной точки в гладкую (щелчок с переме-

щением мыши). 
Операции, выполняемые инструментом Direct Selection (Частичное 

выделение): 
- изменение формы сегмента (щелчок по сегменту с перемещением мы-

ши); 
- выделение опорных точек (с клавишей <Shift> или обводка рамкой);  
- перемещение выделенных точек; 
- изменение формы кривой при изменении типа опорной точки (переме-

щение управляющей точки). 
Временный переход к другому инструменту: выделить объект с помо-

щью  Direct Selection (Частичное выделение) и активизировать 
инструмент  Pen (Перо): 

- положение курсора над сегментом - инструмент Add Anchor (Доба-
вить опорные точки); 

- положение курсора над опорной точкой - инструмент Delete Anchor 
(Удалить опорные точки) 

- удерживая клавишу <Alt> - инструмент Convert Anchor Point (Из-
менить тип опорной точки) 

- удерживая клавишу <Ctrl> - инструмент Direct Selection (Частичное 
выделение)   

 
4.3.3. Рисование кривых инструментом Pen (Перо) 

 
1. Рисование прямолинейных сегментов 

 
Для создания прямой линии необходимо включить инструмент Pen 

(Перо), подвести курсор к начальной точке и щелкнуть левой кнопкой мыши. 
Затем переместить курсор на место расположения следующей точки и снова 
щелкнуть левой кнопкой мыши. В результате две точки соединяются прямой 
линией. Если необходимо нарисовать прямую линию в горизонтальном, вер-
тикальном направлении или с углом наклона, кратным 45 градусам, 
необходимо в процессе рисования держать нажатой клавишу <Shift>.  
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Рис. 4.6. Рисование прямолинейного сегмента 

 
Для того чтобы завершить рисование открытого контура, необходимо 

нажав клавишу <Ctrl>, щелкнуть кнопкой мыши в стороне от контура или в 
меню Select (Выделение) выполнить команду Deselect (Отменить выделе-
ние), после чего можно начинать рисовать новую линию или включить 
другой инструмент.  

Для того чтобы замкнуть контур, необходимо щелкнуть на начальной 
точке в тот момент, когда рядом с курсором появится маленький кружок, 
символизирующий «точное попадание». Последнюю точку можно переме-
щать, если, не отпуская кнопки мыши, нажать клавишу <Пробел>. 

 
2. Рисование криволинейных сегментов 
 
С помощью инструмента Pen (Перо) можно также легко создавать 

кривые (рис.4.7). Для этого необходимо включить инструмент, подвести кур-
сор к начальной точке и, нажав левую кнопку мыши, потянуть в сторону. 
Курсор меняет вид на стрелку, из появившейся точки выдвигаются управля-
ющие линии. Размер и угол наклона управляющих линий определяют 
кривизну сегмента, входящего в эту точку. Так же получают следующие 
опорные точки и определяют кривизну линий. По умолчанию новая опорная 
точка создается гладкой. 

 
Рис. 4.7. Рисование криволинейного сегмента 

 
Рисование выпуклых и S-образных кривых (рис.4.8): 
- перемещение управляющих точек в противоположных направлениях 

дает выпуклую кривую; 
- перемещение управляющих точек в одном направлении дает S-

образную кривую. 

 

Рис. 4.8. Рисование выпуклых и S-образных кривых 
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Создание угловых точек при рисовании плавного контура (рис.4.9): 
- нажать клавишу <Alt> и переместить курсор в направлении изгиба кри-

вой; 
- затем отпустить клавишу и перемещать курсор в направлении, противо-

положном изгибу кривой. 

 
  

1-шаг 2-шаг 3-шаг 

Рис. 4.9. Этапы создания угловой точки в процессе рисования 
 
 

4.3.4. Редактирование векторных контуров 
 
1. Преобразование опорных точек 
 
Для преобразования угловой точки в гладкую и наоборот (рис.4.10) ис-

пользуется инструмент Convert Anchor Point (Изменить тип опорной 
точки): 

- чтобы преобразовать угловую точку в гладкую, ее необходимо выде-
лить и протащить курсор в сторону до появления управляющих линий; 

- чтобы преобразовать гладкую точку в угловую, ее необходимо выде-
лить и переместить одну из управляющих линий для разрыва связи между 
ними. 

 
 

а) б) 

Рис. 4.10. Преобразование опорных точек:  
а) угловой точки в гладкую; б) гладкой точки в угловую 

 
Эффективность контура зависит от количества сегментов и опорных то-

чек, чем их меньше, тем контур получается более чистым и гладким. 

 

Рис. 4.11. Эффективность от наименьшей к наибольшей 
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2. Добавление и удаление опорных точек 
 
Для добавления опорных точек используется инструмент Add Anchor 

Point (Добавить опорные точку), а для удаления - Delete Anchor Point 
(Удалить опорные точку). 

Если необходимо добавить опорную точку в центре между двумя опор-
ными точками, то следует использовать команду Add Anchor Points 
(Добавить опорные точки) меню Object > Path (Объект > Контур). Эта ко-
манда особенно полезна при использовании фильтров Pucker & Bloat 
(Втягивание и раздувание), Twirl (Скручивание) меню Effect > Dis-
tort&Transform (Эффект > Искажение & Трансформация). 

 
3. Соединение краевых опорных точек 
 
Открытый контур имеет две концевых опорных точки - начальную и ко-

нечную, а у закрытого контура таких точек нет. Открытый контур можно 
преобразовать в закрытый соединив краевые опорные точки в процессе рисо-
вания или уже после его создания.  

Способы соединения краевых опорных точек: 
- команда Join (Соединить) контекстного меню выделенного объекта; 
- соединительные щелчки по опорным точкам инструментом Pen (Пе-

ро); 
- попарное выделение опорных точек инструментом Direct Selection 

(Частичное выделение) и затем команда Object > Path > Join (Объ-
ект > Контур > Соединить).  

Если соединяемые опорные точки совпадают друг с другом по местопо-
ложению (одна расположена на другой), то они заменяются на одну общую 
опорную точку. Если же краевые точки расположены на определенном рас-
стоянии друг от друга, то между ними создается дополнительный 
соединительный сегмент. 

 
4. Выравнивание опорных точек 
 
Выровнять опорные точки по горизонтали и вертикали в процессе рисо-

вания контуров можно удерживая нажатой клавишу <Shift>. 
Для того чтобы выровнять определенные опорные точки по горизонтали 

или по вертикали в уже имеющемся контуре, их необходимо выделить ин-
струментом  Direct Selection (Частичное выделение) и выполнить команду 
Average (Усреднить) меню Object > Path (Объект > Контур), которая выво-
дит на экран одноименное диалоговое окно (рис.4.12).  
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Рис. 4.12. Способы выравнивания опорных точек 
 
В диалоговом окне Average (Усреднить) следует установить один из 

трех переключателей в группе Axis (Оси):  
- Horizontal (Горизонтальная) - выравнивание по горизонтали;  
- Vertical (Вертикальная) - выравнивание по вертикали;  
- Both (Обе) - выравнивание по обеим осям одновременно.  
 

4.3.5. Дополнительные операции работы с контурами 
 
1. Удаление с экрана опорных точек и контуров 
 
Чтобы на экране не отображались опорные точки и каркас контуров 

(рис.4.13), можно воспользоваться командой Hide Edges (Спрятать грани-
цы) меню View (Просмотр). В результате у выделенных объектов удаляются 
с экрана упомянутые элементы, а команда меняет свой вид на Show Edges 
(Показать границы). Ее повторное выполнение возвращает способность про-
граммы отображать опорные точки и контуры. 

а) б) 

Рис. 4.13. Удаление с экрана опорных точек и контуров 
 

2. Удаление изолированных опорных точек 
 
Наличие в документе изолированных опорных точек излишне усложняет 

его, увеличивает время на его обработку и даже может замедлить вывод 
изображения на печать. Для борьбы с такими опорными точками необходимо 
включить флажок Stray Points (Изолированные точки) диалогового окна 
Clean Up (Вычистить), которое вызывается командой Clean Up (Вычи-
стить) меню Object > Path (Объект > Контур).  
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Рис.4.14. Удаление изолированных опорных точек  

 
Одновременно в этом диалоговом окне установкой флажка Unpainted 

Objects (Незакрашенные объекты) можно удалить объекты без заливки, а 
установкой флажка Empty Text Paths (Пустые текстовые контуры) - пу-
стые контуры для размещения текста.  

 
3. Разделение объектов 
 
Под разделением объектов понимается разбивка выбранного векторного 

объекта на несколько независимых объектов или удаление из него некоторой 
части. Для разделения объектов предусмотрены следующие инструменты: 

 Eraser (Ластик) - удаляет из области заливки выбранного векторно-
го объекта тот участок, на который воздействует (при нажатой кнопке 
мыши); 

 Scissors (Ножницы) - разрезает контур выбранного объекта щелчком 
инструмента по двум опорным точкам на незамкнутые контуры;  

 Knife (Нож) - разрезает объект с замкнутыми контурами (выделять 
его не обязательно) на несколько объектов по траектории движения инстру-
мента (провести по объекту произвольную линию). 

 

 
а) б) в) 

Рис. 4.15. Пример работы с инструментами разделения объектов:  
а) Eraser (Ластик); б) Scissors (Ножницы); в) Knife (Нож). 

 
4. Расширение объектов 
 
Под расширением объектов понимается преобразование выбранного 

векторного объекта в несколько объектов, которые образуются из заливки 
или обводки исходного объекта, при сохранении его исходного вида. Для 
расширения объекта предусмотрены следующие команды: 

- Expand (Разобрать) меню Object (Объект) - преобразует область за-
ливки (флажок Fill диалогового окна) и/или область обводки (флажок Stroke 
диалогового окна) выбранного векторного объекта с обычной обводкой в от-
дельные объекты по границам цветовых и тоновых переходов; 
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- Expand Appearance (Разобрать внешний вид) меню Object (Объект) - 
преобразует в отдельные объекты обрамляющее изображение векторного 
объекта, созданного при его фигурной обводке каллиграфической, художе-
ственной, шаблонной или диффузной кистью; 

- Outline Stroke (Определение границы обводки) подменю Path (Контур) 
меню Object (Объект) - преобразует выделенный контур, имеющий толщину 
и обычную обводку на замкнутые объекты повторяющие внешний и внут-
ренний периметры обводки (данная команда является упрощенным 
вариантом команды Expand). 

 
4.4. Методические указания к выполнению работы 

 
1. Создание прямых линий. Создайте прямые и зигзагообразные линии 

(рис.4.16). Для этого выберите инструмент  Pen (Перо) и щелкните в нача-
ле и конце линии, удерживая нажатой клавишу <Shift>. Снимите выделение 
щелчком кнопки мыши в любой области документа с нажатой клавишей 
<Ctrl>. Создайте несколько линий самостоятельно, в том числе вертикаль-
ную, диагональную и зигзагообразную.  

 

Рис. 4.16. Прямые и зигзагообразные линии  
 

2. Создание прямолинейного замкнутого контура. Создайте с помо-
щью инструмента Pen (Перо) сначала простой прямолинейный замкнутый 
контур (например: треугольник), а затем многоугольник, звезду и более 
сложную геометрическую фигуру (рис. 4.17). Для этого выберите инструмент 

Pen (Перо) и с помощью щелчков в определенных точках, постройте необ-
ходимые фигуры. Помните, что для того, чтобы замкнуть контур в процессе 
рисования  необходимо щелкнуть на начальной точке в тот момент, когда ря-
дом с курсором появится маленький кружок, символизирующий «точное 
попадание».  

 
Рис. 4.17. Прямолинейные замкнутые контуры 

3. Создание кривых линий. Создайте с помощью инструмента Pen 
(Перо) незамкнутые криволинейные контуры, состоящие из двух и более 
сегментов (рис. 4.18). Для этого выберите инструмент Pen (Перо), подве-
дите  курсор к начальной точке и, нажав левую кнопку мыши, потяните в 
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сторону. Курсор поменяет вид на стрелку, а из точки выдвинутся управляю-
щие линии. Размер и угол наклона управляющих линий определяет кривизну 
сегмента, входящего в эту точку. Таким же образом получите следующие 
опорные точки и определите кривизну линий. По умолчанию новая опорная 
точка создается гладкой.  

 
Рис. 4.18. Криволинейные незамкнутые контуры 

 
4. Создание криволинейного замкнутого контура. Создайте с помо-

щью группы инструментов Pen (Перо) фигуры в форме круга и сердца (рис. 
4.19). Для этого выберите инструмент Pen (Перо) и попробуйте сначала 
нарисовать круг, используя только две гладкие точки: при щелчке на первой 
точке курсор протяните вверх, а на второй – вниз, для замыкания контура – 
подведите  курсор к начальной точке и, нажав левую кнопку мыши, потяните 
вверх. Снимите выделение щелчком кнопки мыши в любой области доку-
мента с нажатой клавишей <Ctrl>. Выберите инструмент Pen (Перо) и 
попробуйте нарисовать фигуру в форме сердца, используя только две угло-
вые точки. В процессе рисования фигуры, для преобразования гладкой точки 
в угловую и замыкания контура нажимайте клавишу <Alt>.  

 
Рис. 4.19. Криволинейные замкнутые контуры  

5. Преобразование и редактирование контуров. Преобразуйте фигуру 
звезды в цветок, а затем цветок в круг (рис.4.20). Создайте с помощью ин-
струмента Star (Звезда) фигуру многолучевой звезды и, не снимая 
выделения, выберите инструмент Convert Anchor Point (Преобразовать 
опорную точку). Подведите курсор к верхней опорной точке луча звезды и, 
нажав левую кнопку мыши, потяните в сторону. Курсор поменяет вид на 
стрелку, из точки выдвинутся управляющие линии и угловая точка преобра-
зуется в гладкую. Аналогичным образом продолжите преобразование 
остальных лучей звезды. Затем выделите инструмент Delete Anchor Point 
(Удалить опорную точку) и по очереди щелкните на каждой внутренней 
опорной точке цветка, в результате чего они будут удалены, а контур примет 
вид круга. 
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Рис. 4.20. Преобразование и редактирование контуров 

6. Создание фигур произвольной формы. Для закрепления и развития 
навыков по созданию кривых произвольной формы нарисуйте фигуру груши, 
состоящую их кривых разных типов (рис. 4.21), не забывая в процессе рисо-
вания преобразовывать гладкую точку в угловую и наоборот с помощью 
клавиши <Alt>. Для создания и редактирования готовой формы используйте 
инструменты группы Pen (Перо) и Direct Selection (Частичное выделе-
ние).  

 
Рис. 4.21. Совмещение кривых разных типов 

 
 

4.5. Контрольные вопросы 
 

1. Какие типы опорных точек вы знаете? 
2. С помощью какого инструмента можно выделить опорную точку? 
3. Как создать прямую горизонтальную или вертикальную линию? 
4. Какой инструмент можно использовать для редактирования кривой? 
5. Как создать угловую точку при рисовании плавного контура? 
6. Как преобразовать гладкую точку в угловую у созданного объекта? 
7. Какую линию дает перемещение управляющих точек в противопо-

ложных направлениях? 
8. Какую создать эффективную S-образную линию? 
9. Для чего используются управляющие элементы? 
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5. ЛАБОРАТОРНАЯ РАБОТА №5 
«Работа с растровыми изображениями» 

 
5.1. Цель работы 

 
Изучить технологию преобразования растровых изображений в вектор-

ные объекты и их быстрой заливки. Приобрести навыки практической 
работы с инструментами, осуществляющими автоматическую трассировку 
растровых изображений и интерактивное закрашивание объекта трассировки.  

 
5.2. Задание к лабораторной работе 

 
Найдите в сети Интернет цветную фотографию, пригодную для автома-

тической трассировки. Преобразуйте оригинал в векторный объект 
приемлемого качества, совмещая при необходимости автоматическую трас-
сировку с ручной, и залейте его цветом с помощью инструмента быстрой 
заливки. Исходное растровое изображение не удаляйте из рабочего докумен-
та.  

Полученный результат сохраните в файле «trace.ai», сдайте преподава-
телю на проверку и защитите его.  

 

Рис.5.1. Пример преобразования растрового изображения в векторное. 
 
 

5.3. Работа с растровыми изображениями 
 
Для работы с растровыми изображениями программой предоставляется 

ряд возможностей, которые позволяют их:  
- импортировать в документ, используя команду Place (Поместить); 
- управлять с помощью палитры Links (Связи); 
- трассировать инструментом Live Trace (Быстрая трассировка); 
- закрашивать объекты трассировки инструментом Live Paint (Быстрая 

заливка). 
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5.3.1. Импорт растровых изображений 
 
Основным способом импорта иллюстраций в программу является ко-

манда Place (Поместить) меню File (Файл), при использовании которой 
можно определить место хранения изображения, импортированного в доку-
мент, в диалоговом окне (рис. 5.2) следующими способами: 

- связанный объект (linked () - флажок Link (Связать) установлен; 
- внедренный объект (embedded) - флажок Link (Связать) не установлен. 

 
Рис. 5.2. Диалоговое окно команды Place (Поместить) 

 
Связанный объект (linked) хранится независимо от документа, а в до-

кументе хранится ссылка на помещенный файл, тем самым сокращая его 
размер. Кроме того, связанный объект можно: 

- независимо редактировать (автоматически обновляется копия); 
- многократно использовать без увеличения размера документа; 
- изменить с помощью средств трансформации и эффектов, но нельзя 

выбрать и изменить его отдельные компоненты 
Встроенный объект (embedded) копируется в документ в полном раз-

решении, что приводит к увеличению его размера. Документ со встроенной 
иллюстрацией остается самодостаточным, т.к. его невозможно независимо 
редактировать. 

Определить, является иллюстрация связанной или встроенной, а также 
изменить это состояние можно в палитре Links (Связи). 

 
5.3.2. Палитра Links (Связи) 

 
Палитра Links (Связи) используется для просмотра и управления (иден-

тификация, выбор, отображение и обновление) всеми связанными или 
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встроенными иллюстрациями. Для того чтобы вызвать палитру на экран, 
необходимо выполнить команду Links (Связи) меню Window (Окно).  

В палитре представлен список изображений, в каждой строке которого 
представлены маленькая миниатюра иллюстрации и имя импортированного 
файла, а также некоторые служебные пиктограммы, указывающие ее теку-
щий статус (рис. 5.3). 

 

 

Рис. 5.3. Палитра Links (Связи) 

Кнопки внизу палитры Links (Связи) 
- Relink (Заменить объект) - за новым изображением сохраняются раз-

меры, расположение, атрибуты, трансформация исходного связанного; 
- Go To Link (Перейти к объекту) - выделяет связанный объект; 
- Update Link (Обновить связь) - модификация файла и замена изобра-

жения; 
- Edit Original (Редактировать оригинал) - запуск родительской про-

граммы выделенной связи. 
 

5.3.3. Трассировка растровых изображений 
 
Трассировка (векторизация) изображений - операция преобразования 

растровых объектов в векторные. В зависимости от происхождения оригина-
ла, можно использовать следующие способы трассировки растровых 
изображений: 

Ручная трассировка - представляет собой обводку очертаний фрагмен-
тов рисунка с помощью инструмента Pen (Перо) или Pencil (Карандаш) и 
служит для достижения наилучших результатов; 

Автоматическая трассировка - предназначена для трассировки про-
стых изображений с помощью команды Live Trace (Быстрая трассировка) 
и, как правило, для достижения приемлемого качества совмещается с ручной 
трассировкой. 

Выбор конкретного варианта для трассировки зависит от сложности ис-
ходного изображения, требуемого качества и используемого способа. В 
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любом случае по окончании трассировки для сформированных векторных 
контуров подбираются заливки и границы, а слой с исходным растровым 
изображением удаляется. 

 
1. Ручная трассировка с помощью шаблонных слоев 
 
Сущность ручной трассировки заключается в рисовании поверх растро-

вого изображения векторных контуров инструментами групп Pen (Перо), 
Pencil (Карандаш) или Paintbrush (Кисть) и др. Трассируемое изобра-

жение необходимо предварительно поместить на специальный шаблонный 
слой (Template). 

Шаблонные слои - это заблокированные, непечатаемые слои, которые 
используются для трассировки изображений вручную и могут создаваться 
как при импорте изображения, так и на основе существующих слоев. Шаб-
лонные слои по умолчанию слегка затенены (dimmed) на 50 %, 
заблокированы (locked). 

Для трассировки импортируемого изображения в качестве шаблонного 
слоя необходимо в диалоговом окне окно команды Place (Поместить) вы-
брать параметр Template (Шаблон) и затем нажать кнопку Place 
(Поместить). Под текущим слоем в палитре появится шаблонный слой.  

Для трассировки существующего изображения необходимо убедиться в 
том, что оно находится на отдельном слое в палитре Layers (Слои), дважды 
щелкнуть по слою и в появившемся диалоговом окне Layer Option (Пара-
метры слоя) выбрать параметр Template (Шаблон), затем нажать кнопку 
<OK>. Также можно использовать команду Template (Шаблон) в меню па-
литры Layers (Слои). Значок глаза  изменится на значок шаблона , а 
слой будет заблокирован. 

Чтобы преобразовать шаблонный слой в обычный, необходимо дважды 
щелкнуть по шаблонному слою в палитре Layers (Слои) и  отменив выбор 
параметра Template (Шаблон)  нажать кнопку <OK>. 

 
2. Автоматическая трассировка 
 
Автоматическая трассировка - это быстрый способ векторизации раст-

рового изображения, который позволяет не только управлять уровнем 
детализации трассируемого изображения, но и преобразовать его в контуры 
или объект с быстрой заливкой. Автоматическая трассировка растрового 
изображения осуществляется с помощью команд меню Object > Live Trace 
(Объект > Быстрая трассировка) как с ручной настройкой параметров, так 
и с автоматической. 

 
 
 
 



52 

 

2.1. Автоматическая трассировка без настройки параметров.  
 
Для получения векторного изображения без настройки параметров трас-

сировки  (по умолчанию) необходимо выделить объект и выбрать одну из 
команд Live Trace (Быстрая трассировка):  

- Make (Выполнить) - без преобразования в векторные контуры. Для 
преобразования полученного объекта в векторные контуры необходимо до-
полнительно выполнить команду Object > Expand (Объект > Разобрать) 

- Make and Expand (Выполнить и Разобрать) - преобразование объекта  
в векторные контуры. 

- Make and Convert To Live Paint (Выполнить и конвертировать в ре-
жим быстрой заливки) - преобразование объекта в режим быстрой заливки. 
Преобразовать объект в режим быстрой заливки можно и другим способом: 
Object > Live Trace > Make (Объект > Быстрая трассировка > Выполнить), 
а затем применить команду Object > Live Trace > Convert To Live Paint 
(Объект > Быстрая трассировка > Конвертировать в режим быстрой за-
ливки). 

 
2.2. Автоматическая трассировка с ручной настройкой параметров. 
 
Для получения векторного изображения с настройкой параметров трас-

сировки необходимо выделить объект и выбрать команду Object > Tracing 
Options (Объект > Параметры трассировки) и установив необходимые па-
раметры в одноименном диалоговом окне (рис.5.3) нажать кнопку Trace 
(Трассировать). После преобразования объекта трассировки коррекция па-
раметров трассировки станет невозможна. 

 
Рис.5.4. Настройка параметров трассировки 
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5.3.4. Преобразование объекта трассировки 
 

Объект трассировки можно преобразовать в контуры или объект с быст-
рой заливкой, что позволяет работать с объектом трассировки точно так же, 
как с любым другим векторным изображением. После преобразования объек-
та трассировки коррекция параметров трассировки станет невозможна. 

Преобразование объекта трассировки в контуры. Для преобразование 
объекта трассировки в контуры необходимо выделить объект и нажать кноп-
ку Expand (Разобрать) в палитре Control (Управление) или выбрать команду 
Object > Live Trace > Expand (Объект > Быстрая трассировка > Разо-
брать). Этот способ используется, если нужно работать с компонентами 
объекта как с отдельными объектами. Получившиеся контуры группируются 
вместе. 

Преобразование объекта трассировки в  объект с быстрой заливкой. 
Для преобразование объекта трассировки в объект с быстрой заливкой необ-
ходимо выделить объект и нажать кнопку Live Trace (Быстрая трассировка) 
в палитре Control (Управление) или выбрать команду Object > Live Trace > 
Live Paint (Объект > Быстрая трассировка > Преобразовать в быструю за-
ливку). Этот способ используется, если нужно применить заливку и обводку к 
трассированному графическому объекту с помощью инструмента Live Paint 
(Быстрая заливка). 

Чтобы за один прием создать объект трассировки и преобразовать его в 
векторный необходимо выбрать  один из способов: 

1) Object > Live Trace > Make and Expand (Объект > Быстрая трас-
сировка > Создать и разобрать); 

2) Object > Live Trace > Make and Convert to Live Paint (Объект > 
Быстрая трассировка > Создать и преобразовать в быструю заливку). 

а)  б)  в)  

Рис. 5.5. Пример автоматической трассировки и интерактивного закрашивания раст-
рового изображения: а) исходное изображение в формате jpeg, б) полученное 

изображение в кривых, в) закрашенное изображение в кривых 
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5.3.5. Интерактивное закрашивание объекта трассировки 
 
С помощью инструмента Live Paint (Быстрая заливка) можно раскра-

шивать фрагменты и края в группах с быстрой заливкой, применяя атрибуты 
текущей заливки и обводки. Курсор инструмента отображает один или три 
цветных квадрата, представляющих выбранный цвет заливки или обводки, а 
также, если используются цвета из библиотеки образцов, два цвета, смежных 
с выбранным цветом в библиотеке. Можно получить доступ к смежным цве-
там, а также к цветам, следующим за ними, и так далее, нажимая клавиши 
<→> » или «←».  

Инструмент Live Paint (Быстрая заливка) позволяет быстро закраши-
вать векторные объекты путем автоматического обнаружения и 
корректировки пробелов, которые могут оказывать влияние на процесс при-
менения заливки и штриха.  

Прежде, чем приступить к закрашиванию объекта необходимо решить 
вопрос с пробелами. Пробелы - это маленькие разрывы в контурах объектов, 
через которые цвет может «перетекать» из одного контура в другой. Поэтому 
прежде, чем начать закрашивание необходимо установить параметры пробе-
лов в диалоговом окне Gap Options (Параметры пробела) (рис. 5.6) команды 
Live Paint (Быстрая заливка) меню Object (Объект).  

 
Рис. 5.6. Диалоговое окно Gap Options (Параметры пробела)   

 
 

5.4. Методические указания к лабораторным работам  
 
1. Ручная трассировка. Преобразуйте растровое изображение логотипа, 

предложенного преподавателем, в векторное вручную (ручная трассировка) с 
помощью шаблонных слоев и инструмента Pen (Перо). Предварительно им-
портируйте исходное изображение в документ, создав шаблонный слой. 
Шаблонный слой после окончания работ не удаляется.  

2. Автоматическая трассировка. Осуществите быструю трассировку 
растрового изображения, предложенного преподавателем с помощью коман-
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ды Live Tract (Быстрая трассировка). Для достижения наилучших результа-
тов  используйте настройки параметров трассировки в диалоговом окне 
Tracing Options (Параметры трассировки), не забыв включить предвари-
тельно флажок Preview (Просмотр) 

3. Преобразование объекта трассировки в контуры. Выделите полу-
ченное после трассировки изображение и преобразуйте его в векторные 
контуры с помощью команды Expand (Разобрать). Полученное векторное 
изображение можно залить цветом традиционным способом. 

4. Преобразование объекта трассировки в объект быстрой заливки. 
Полученное векторное изображение преобразуйте в объект быстрой заливки 
с помощью команды Live Paint (Быстрая заливка). Для достижения наилуч-
ших результатов  используйте настройки параметров пробелов в диалоговом 
окне Gap Options (Параметры пробела). 

5. Быстрая заливка объекта трассировки. С помощью инструмента 
быстрой заливки команды Live Paint (Быстрая заливка) закрасьте получен-
ное векторное изображение. Предварительно создайте и сохраните 
необходимые для заливки образцы цвета 

Внимание: В процессе работы следите за тем, чтобы контуры, там где 
это необходимо, были замкнутыми, иначе их невозможно будет закрасить. 

 
5.5. Контрольные вопросы 

 
1. Какие способы импорта растровых изображений в векторный доку-

мент существуют и их особенности? 
2. Каким образом можно управлять растровыми изображениями, поме-

щенными в векторный документ? 
3. Что подразумевается под термином трассировка? 
4. Какие виды трассировки вы знаете? 
5. В чем заключается сущность ручной трассировки, и в каких случаях 

рекомендуется ее использовать? 
6. Как осуществляется автоматическая трассировка с настройкой пара-

метров? 
7. Каким образом можно преобразовать объект трассировки в контуры? 
8. Каким образом можно преобразовать объект трассировки в объект 

быстрой заливки? 
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ЛАБОРАТОРНАЯ РАБОТА №6 
«Работа с текстом» 

 
6.1. Цель работы 

 
Изучить специфику работы с текстом, средства и способы его создания 

и редактирования. Приобрести навыки практической работы, необходимые 
для ввода, форматирования и управления текстом.  

 
6.2. Задание к лабораторной работе 

 
Создайте календарь на текущий или следующий год. Проект должен 

включать в себя помимо текстовых блоков и векторные объекты. Для работы 
с текстом рекомендуется использовать не более двух шрифтовых гарнитур.  

Полученный результат сохраните в файле «text.ai», сдайте преподавате-
лю на проверку и защитите его.  

 

    
Рис.6.1. Примеры карманного календаря 

 
 

6.3. Работа с текстом 
 
Для работы с текстом программа предоставляет огромные возможности: 

его можно вводить, изменить размер, форму, цвет, расположить горизон-
тально, вертикально, по кривой, внутри заданной области, а также 
трансформировать, создать столбцы и строки с текстом, задать обтекание 
графических объектов текстом, работать как с графическим объектом, со-
здать текстовые маски и т.д. 

 
6.3.1. Инструменты группы Type (Текст) 

 
Инструменты группы Туре (Текст) служат для набора горизонтального 

или вертикального текста в любом месте документа по кривой или внутри 
заданной области. В группу инструментов для работы с текстом входят: 

1) Type (Текст) - набор и редактирование горизонтального текста; 
2)   Area type (Текст в области) - набор и редактирование горизон-

тального текста в ограниченной области; 
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3) Type On a Path (Текст по пути) - набор и редактирование горизон-
тального текста по пути (криволинейному сегменту); 

4)  Vertical Type (Вертикальный текст) - набор и редактирование 
вертикального текста; 

5)  Vertical Area Type (Вертикальный текст в области) - набор и ре-
дактирование вертикального текста в ограниченной области 

6)  Vertical Area Type On a Path (Вертикальный текст по пути)  - 
набор и редактирование вертикального текста по пути (криволинейному сег-
менту) 

 
6.3.2. Способы ввода текста 

 
1. Ввод текста в точке 

 
Такой способ ввода текста подходит для оформления заголовков и не-

больших фраз. Длина строки вводимого текста является независимой ― 
текст удлиняется или сокращается при редактировании, но не переходит на 
следующую строку. Для перехода на новую строку необходимо нажать кла-
вишу <Enter>. Текст, созданный таким способом, может быть как 
горизонтальным, так и вертикальным. 

Для набора заголовочного текста необходимо выбрать инструмент 
 Туре (Текст) или  Vertical Type (Вертикальный текст) и щелкнуть в 

произвольном месте документа и вводить текст (рис. 6.2.)  
 

 
а)  б)  

Рис.6.2. Текст в точке:  
а) горизонтальный текст; б) вертикальный текст 

 
При масштабировании текста, набранного таким способом, происходит 

его искажение. 

 

Рис.6.3. Масштабирование текста в точке 
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2. Ввод текста в области 
 

В данном случае текст может быть помещен внутри области произволь-
ной формы. Длина строки такого текста ограничена шириной области. При 
достижении текстом границы  в процессе набора происходит автоматический 
переход на следующую строку без разрыва абзаца. Принципиальное отличие 
такого текста от заголовочного заключается в том, что нажимать клавишу  
<Enter> следует только в конце абзаца. Такой способ подходит для оформле-
ния основного текста в границах заданной области, в котором существуют 
абзацы, и требуется форматирование. Текст в области может быть как гори-
зонтальным, так и вертикальным. 

Для печати текста в области необходимо нарисовать рамку или создать 
область произвольной формы, выбрать инструмент  Area type (Текст в об-
ласти) или Vertical Area Type (Вертикальный текст в области) и 
вводить текст (границы области станут невидимыми в обычном режиме, и не 
будут выводиться на печать). Если в заданной области набрано текста боль-
ше, чем может отобразиться, то в правом нижнем углу выводится квадратик 
со знаком «плюс».  

 
а)  б) 

Рис.6.4. Текст в области:  
а) горизонтальный текст, б) вертикальный текст 

 
Для изменения размера и формы текстовой области можно использовать 

инструменты выделения Selection (Выделение) или Direct Selection (Ча-
стичное выделение): 

- при выделении текстового блока с помощью инструмента Selection 
(Выделение) становятся доступными «габаритные» маркеры, с помощью ко-
торых можно легко изменить размер и пропорции области печати. Для 
пропорционального масштабирования следует удерживать клавишу <Shift>.  

- при выделении текстового блока с помощью инструмента Direct 
Selection (Частичное выделение) можно свободно изменять форму, переме-
щая опорные точки. Все изменения в форме текстового блока автоматически 
отрабатываются программой. 

Инструмент Direct Selection (Частичное выделение) проще применять 
в контурном режиме (outline), поскольку в обычном режиме контур текстово-
го блока не отображается. Кроме прочего, при выделении нужно постараться 
не попасть на базовые линии текста, иначе будет выделен текст, а не тексто-
вая рамка.  
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3. Ввод текста вдоль контура 
 
Текст может быть помещен не только внутри объекта, но и направлен 

вдоль открытого или закрытого контура любой произвольной формы. Контур 
в этом случае становится невидимым и не выводится на печать. Текст, 
направленный вдоль контура может быть как горизонтальным, так и верти-
кальным. При наборе горизонтального текста символы размещаются 
параллельно базовой линии, а горизонтального — перпендикулярно.  

Для печати горизонтального текста вдоль заранее созданного контура, 
необходимо выбрать один из инструментов  Туре (Текст) или Path Type 
(Текст вдоль контура), а для вертикального — Vertical Path Type (Верти-
кальный текст вдоль контура), затем подвести курсор к контуру и щелкнуть 
кнопкой мыши (рис. 6.5). После появления текстового курсора можно начи-
нать ввод текста. Изменение контура при необходимости можно осуществить 
с помощью инструмента выделения Direct Selection (Частичное выделе-
ние). 

 
а) 

 б) 

Рис.6.5. Текст вдоль контура:  
а) горизонтальный текст, б) вертикальный текст 

 
Для перемещения текста вдоль контура, существует специальный знак, 

имеющий вид текстового курсора. Он появляется при выделении текста с 
помощью инструментов Selection (Выделение) и Direct Selection (Ча-
стичное выделение). Перемещение этого знака влечет за собой и 
перемещение всего текста. Если требуется размещение текста на противопо-
ложной стороне контура, то достаточно знак курсора «перетащить» на 
другую сторону контура или дважды по нему щелкнуть. 

 
6.3.3. Форматирование текста 

 
Управление параметрами шрифта и текста осуществляется с помощью 

двух палитр - Character (Символ) и Paragraph (Абзац), которые выводятся 
на экран из меню Window > Туре (Окно > Текст). Настройки шрифта и тек-
ста можно устанавливать как до ввода текста, так и после, изменяя внешний 
вид уже существующего выделенного текста. 
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1. Палитра Character (Символ) 
 
С помощью палитры Character (Символ) можно управлять параметрами 

шрифта: 
- гарнитура - font (шрифт); 
- начертание - bold (жирное), italic (курсивное) и т.д.; 
- размер - font size (кегль); 
- расстояние между базовыми линиями соседних строк - leading (интер-

линьяж); 
- оптические пробелы между парами букв - kerning (кернинг); 
- межбуквенные пробелы - tracking (трекинг). 

 
Рис.6.6. Палитра Character (Символ) 

 
 
2. Палитра Paragraph (Абзац) 
 
С помощью палитры Paragraph (Абзац) можно управлять параметрами 

форматирования текста: 
- выключка (выравнивание строк текста влево, вправо и т.д.); 
- левый и правый абзацный отступ; 
- красная строка; 
- отбивка до и после абзаца. 

 

Рис.6.7. Палитра Paragraph (Абзац)
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3. Изменение регистра 
 
Для изменения регистра выделенного шрифта используется диалоговое 

окно Change Case (Изменить регистр), которое выводится из меню Type 
(Текст). Переключатели окна: 

- Upper Case (Все прописные); 
- Lower Case (Все строчные); 
- Title Case (Все слова с большой буквы). 
- Sentence Case (Первое слово в предложении с большой буквы). 
 
4. Трансформация текста 
 
Текст можно поворачивать, зеркально отражать, масштабировать и 

наклонять точно так же, как и другие объекты. Однако результаты трансфор-
мирования зависят от способа выделения текста: 

- чтобы трансформировать текст вместе с его ограничительным конту-
ром, необходимо выделить текстовый объект и воспользоваться 
инструментами трансформации, например, для поворота объекта и текста - 
Rotate (Поворот); 

- чтобы трансформировать только ограничительный контур без текста, 
необходимо выделить текстовый объект и повернуть его с помощью инстру-
мента Selection (Выделение). 

- чтобы повернуть символы текстового объекта на определенное значе-
ние в градусах необходимо их выделить и в палитре Character  (Символ) 
задать параметр «поворот символа». 

- чтобы преобразовать горизонтальный текст в вертикальный и наоборот 
необходимо выделить текстовый объект и выбрать команду Type > Type 
Orientation > Horizontal (Текст > Ориентация текста > Горизонтальная) 
или  Vertical (Вертикальная). 

- чтобы повернуть весь текстовый объект (символы и ограничительную 
рамку) необходимо выделить текстовый объект и выполнить  поворот с по-
мощью ограничительной рамки инструмента Free Transform (Свободное 
трансформирование), инструмента или команды Rotate (Поворот) или 
палитры Transform (Трансформирование). 

 

 
а) б) 

Рис.6.8. Трансформация текста:  
а) поворот текста и контура; б) поворот контура  
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6.3.4. Создание текстовых колонок 
 
Текст в области можно распределить по рядам и колонкам (рис.6.6.) с 

помощью диалогового окна команды Area Type Options (Параметры тексто-
вой области) меню Type (Текст). 

 
Рис.6.9. Текстовые колонки  

 
Для этого необходимо в диалоговом окне Area Type Options (Парамет-

ры текстовой области) установить флажок Preview (Просмотр), количество 
колонок и рядов, расстояния между рядами и колонками и т.д. (рис.6.10). 

 

Рис.6.10. Диалоговое окно Area Type Options (Параметры текстовой области)  
 

Параметры текстовой области: 
- Number (Количество) - число строк и колонок; 
- Span (Величина) - высота строк и ширина колонок;  
- Fixed (Фиксированный) - определяет, что происходит с размерами ко-

лонок и рядов при изменении размеров текстовой области: флажок 
установлен - изменение числа колонок или рядов, но не к изменению их раз-
меров; флажок не установлен - изменение размеров рядов и колонок; 

- Gutter (Средник) - расстояние между рядами и колонками; 
- Inset Spacing (Зазоры вставки) - размер поля между текстом и рамкой, 

ограничивающей текст (внутренний отступ); 
- First Baseline (Первая базовая линия) - управляет выравниванием пер-

вой строки текста относительно верхнего края объекта; 
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В группе Option (Варианты) можно установить различные режимы пе-
ретекания текста между строками и колонками  

 
6.3.5. Обтекание объектов текстом 

 
Любой графический объект, кроме объекта, созданного инструментом 

Paintbrush (Кисть) можно обтекать текстом, в том числе и другой блок 
текста (рис. 6.11). Таким образом, формируются текстовая вставка и буквица. 

Для этого необходимо выделить инструментом Select (Выделение) 
текстовый блок и выполнить команду меню Object > Text Wrap > Make 
(Объект > Обтекание текстом > Создать). 

 
а) б) 

Рис.6.11. Обтекание объектов текстом:  
а) обтекание текста; б) обтекание графического объекта 

 
 

6.3.6. Конвертирование шрифта в кривые 
 
В программе предусмотрена возможность выделенный шрифтовой объ-

ект конвертировать в совокупность контуров, которые сохраняют все 
внешние параметры и позволяют обращаться с ними как с обычными вектор-
ными объектами (рис.6.12). Неизбежная потеря при этом заключается в 
невозможности форматировать и редактировать этот блок как текст (из  тек-
ста он превратился в форму). Поэтому нельзя конвертировать одну букву или 
слово, входящие в обширный текст. Для этого необходимо создать отдель-
ный текстовый блок только из этой буквы или только из этого слова.  

 

 
Рис.6.12. Декоративный текст в кривых  

 
Для того чтобы конвертировать шрифтовой объект в кривые, его необ-

ходимо выделить с помощью инструмента Selection (Выделение), a затем 
выполнить команду Create Outlines (Преобразовать в контуры) меню Туре 
(Текст), которая из любой буквы создаст отдельный векторный объект. 
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6.4. Методические указания к лабораторным работам  
 
1. Создание студенческого билета. Возьмите за основу внутренний 

разворот своего студенческого билета и создайте его копию. Для реализации 
используйте инструменты группы Type (Текст) и при необходимости раз-
личные типы ввода текста. С помощью палитры Paragraph (Абзац) 
отформатируйте набранный текст должным образом.  

2. Создание рекламного постера. Возьмите у преподавателя все необ-
ходимые материалы для создания рекламного постера (исходный текст, 
графику и т.п.). Используйте все необходимые приемы для работы с текстом 
и компоновки элементов таким образом, чтобы получился искомый вариант.  

3. Создание календарной сетки. Наберите текст в области, содержащий 
дни недели и числа для одного месяца текущего года. Текст в области рас-
пределите по рядам и колонкам с помощью настройки параметров 
диалогового окна команды Area Type Options (Параметры текстовой обла-
сти) меню Type (Текст). В результате должна получиться календарная сетка 
для одного месяца. Создайте календарные сетки для недостающих месяцев 
таким образом, чтобы получился календарь на текущий год.  

4. Создание декоративного текста. Наберите свое имя заглавными 
буквами плотным шрифтом (например, Impact) и преобразуйте его в кривые. 
Создайте с помощью инструмента Pen (Перо) волну и положите ее поверх 
текста (см. рис. 6.12). Выделите оба объекта и на панели Pathfinder (Обра-
ботка контуров) выберите режим Divide (Разделение). Залейте разными 
оттенками одного и того цвета верхнюю и нижнюю части слова.  

 
6.5. Контрольные вопросы 

 
1. Какие инструменты нужно использовать, чтобы написать заголовоч-

ный текст, текст внутри области и вдоль контура? 
3. Каким образом можно преобразовать текст в кривые, и в каких случа-

ях это необходимо делать? 
4. В чем заключаются преимущества и недостатки преобразования тек-

ста в кривые? 
5. Какие палитры предназначены для управления параметрами шрифта и 

текста? 
6. Что такое интерлиньяж, и каким образом его можно установить или 

изменить? 
7. Что случится с текстом, если у вас на компьютере нет шрифта, кото-

рый используется для его форматирования? 
8. Когда выполняется операция обтекания текстом изображения, текст и 

рисунок должны находиться на одном слое. Как должен располагаться текст 
по отношению к изображению, сверху или снизу?  

9. Каким образом текст в области можно распределить по рядам и ко-
лонкам? 
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7. ЛАБОРАТОРНАЯ РАБОТА №7 
«Преобразование объектов» 

 
7.1 Цель работы 

 
Изучить различные методы и средства преобразования векторных объ-

ектов. Приобрести навыки практической работы с разнообразными 
командами и специальными инструментами, позволяющими изменить форму 
векторных объектов и научиться выполнять операции преобразования опти-
мальным способом. 

 
7.2. Задание к лабораторной работе 

 
Создайте букет из нежных цветов, используя инструменты трансформа-

ции в сочетании с эффектами искажения. Цветы раскрашивайте с 
применением различных радиальных градиентов. Инструкцию по созданию 
цветов возьмите у преподавателя.  

Полученный результат сохраните в файле «flowers.ai», сдайте препода-
вателю на проверку и защитите его.  

 

  

Рис. 7.1. Примеры букета из цветов 
 
 

7.3. Преобразование объектов 
 

7.3.1. Трансформация объектов 
 
Под трансформацией векторного объекта подразумевается изменение 

формы или ориентации в пространстве объекта или его отдельных частей пу-
тем выполнения одной из следующих операций: масштабирование, поворот, 
отражение или наклон.  
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а) б) в) г) 

Рис. 7.2. Пример трансформации векторных объектов:  
а) масштабирование; б) поворот; в) отражение; г) наклон 

 
Векторные объекты можно трансформировать с помощью палитры 

Transform (Трансформация), команды Transform (Трансформация) меню 
Object (Объект), команд меню объекта, специальных инструментов транс-
формации, а также осуществлять множество вариантов преобразования 
путем перетаскивания ограничительной рамки. 

 
Палитра Transform (Трансформация) 

 
В палитре Transform (Трансформация) содержится информация о ме-

стоположении, размере и ориентации одного или нескольких выбранных 
объектов (рис.7.3). Путем ввода новых значений, можно изменить выбранные 
объекты и их декоративную заливку, а также центр трансформации или за-
фиксировать пропорции объекта. Все значения в палитре относятся к 
ограничительным рамкам объектов, за исключением значений X и Y, кото-
рые относятся к центру трансформации.  

Пиктограмма в левой части палитры (девять маленьких квадратиков) 
служит для задания центра трансформация. Выбранный щелчком мыши 
квадратик становится черным. Размер объекта определяется значениями в 
полях W (Ширина) и H (Высота). В полях нижней части палитры задаются 
углы поворота и наклона объекта.  

В меню палитры находятся команды, с помощью которых можно транс-
формировать только объект (Transform Object Only), только декоративную 
заливку (Transform Pattern Only) или оба элемента вместе (Transform Both). 

 

 
Рис. 7.3. Палитра Transform (Трансформация) 
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Команда Transform (Трансформация) 
 
Команда Transform (Трансформирование) находится в меню Object 

(Объект), и в качестве подкоманд в нее входят операции трансформирования 
перемещение, масштабирование, поворот и отражение. Все операции вы-
полняются относительно центра выделенного объекта и предоставляют 
способ трансформации объектов при необходимости задания точных пара-
метров в соответствующем диалоговом окне. 

Трансформация командой Transform Each (Трансформировать каж-
дый) позволяет одновременно выполнить несколько операций 
трансформации векторного объекта относительно одного из его восьми 
трансформационных маркеров или центра: 

- коэффициент масштабирования объекта по горизонтали и вертикали - 
ползунки Horizontal (Горизонталь) и Vertical (Вертикаль) в области Scale 
(Масштабирование); 

- величина смещения объекта по горизонтали и вертикали - ползунки 
Horizontal (Горизонталь) и Vertical (Вертикаль) в области Move (Перемеще-
ние); 

- угол поворота объекта - поле с круговым ползунком Angle (Угол); 
- режим отражения объекта по горизонтали и вертикали - флажки Reflect 

X (Отражение по оси X), Reflect Y (Отражение по оси Y); 
- режим случайного выбора параметров обработки объекта в пределах от 

исходных до заданных значений - флажок Random (Случайный). 

 
а) б) в) 

Рис. 7.4. Трансформации командой Transform Each (Трансформировать каждый):  
а) исходный объект; б) трансформация с параметрами Scale = 90%, Rotate = 15 
град.; в) копирование одновременным нажатием клавиш <Ctrl> и <D> 

 
Инструменты трансформации 

 
Группа инструментов трансформации включает в себя пять специализи-

рованных инструментов: 
1) Rotate (Поворот) - поворот вокруг заданного центра; 
2) Reflect (Отражение) - отражение относительно заданной точки; 
3) Scale (Размер) - масштабирование относительно заданной точки; 
4) Shear (Наклон) - наклон относительно заданной точки; 
5) Free Transform (Свободная трансформация) - свободная транс-

формация с использованием габаритной рамки. 
С помощью инструментов трансформации можно осуществлять преоб-

разования в интерактивном режиме, определяя точность изменения объекта 
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визуально или задавать точные параметры в соответствующих диалоговых 
окнах, которые вызываются двойным щелчком на инструменте. 

Все инструменты, предназначенные для трансформации объектов, осу-
ществляют свое воздействие на объекты относительно центра 
преобразования (point of origin). Точка, относительно которой производятся 
преобразования, по умолчанию располагается в геометрическом центре объ-
екта. При работе с инструментами трансформации ее можно переместить 
мышью в любое место рабочего поля (рис.7.5). 

 

а) б) 

Рис. 7.5. Изменение  центра трансформации:  
а) трансформация объекта с геометрическим  центром трансформации;  
б) трансформация объекта с перемещением центра трансформации 

 
Для трансформации объекта в интерактивном режиме его необходимо 

выделить, включить инструмент трансформации и далее: 
- чтобы выполнить преобразование относительно геометрического цен-

тра трансформации достаточно нажать кнопку мыши и перемещать объект в 
нужном направлении;  

- чтобы выполнить преобразование объекта относительно иного центра 
трансформации необходимо щелчком мыши переместить центр в предпола-
гаемое место и затем перемещать объект в нужном направлении. 

Для трансформации объекта с помощью установочных параметров 
необходимо выбрать объект и далее: 

- чтобы выполнить преобразование относительно геометрического цен-
тра трансформации необходимо дважды щелкнуть мышью на инструменте и 
затем в диалоговое окно инструмента ввести необходимые параметры; 

- чтобы выполнить преобразование относительно иного центра транс-
формации необходимо с помощью нажатой клавиши <Alt> перенести центр в 
предполагаемое место и щелкнуть на инструменте, а затем в диалоговое окно 
инструмента ввести необходимые параметры. 

Для того, чтобы исходный объект остался на месте, а в новом положе-
нии оказалась копия (трансформация с копированием) необходимо: 

- при преобразовании относительно геометрического центра трансфор-
мации - удерживать клавишу <Alt> при перемещении объекта; 

- при преобразовании с изменением центра трансформации - нажать 
кнопку Copy (Копировать) в диалоговом окне инструмента. 
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Если во время трансформации удерживать нажатой клавишу <Shift>, то 
преобразование будут происходить по ортогональным осям или под углом 45 
градусов. 

Повторить любое преобразование можно одновременным нажатием кла-
виш <Ctrl> и <D> . 

Контекстное меню объекта 

Все операции по трансформации объекта можно выполнять с помощью 
контекстного меню векторного объекта. Для вызова диалогового окна для 
определения параметров трансформации через контекстное меню необходи-
мо выделить объект, щелкнуть правой кнопкой мыши на поле листа и 
выбрать Transform (Трансформация). В появившемся меню появится пере-
чень команд трансформации, аналогичный тем, которые появляются при 
выборе команды Transform (Трансформация) меню Object (Объект). Далее 
необходимо выбрать команду трансформации и в диалоговом окне опреде-
лить необходимые параметры. 

Трансформация с использованием «габаритной» рамки 

При выборе одного или нескольких объектов с помощью инструмента 
Selection (Выделение) вокруг них появляется «габаритная» (ограничитель-

ная) рамка, которая используется для быстрого перемещения, вращения, 
копирования и масштабирования объекта путем перетаскивания объекта или 
маркера (рис.7.6). 

Чтобы скрыть «габаритную» рамку необходимо выбрать команду View > 
Hide Bounding Box (Просмотр > Спрятать габаритную рамку). 

Чтобы показать ограничительную рамку необходимо выбрать команду 
View > Show Bounding Box (Просмотр > Показать габаритную рамку). 

Чтобы переориентировать «габаритную» рамку после поворота необхо-
димо выбрать команду Object > Transform > Reset Bounding Box (Объект > 
Трансформация > Восcтановить настройки габаритной рамки по умолча-
нию). 

 

а) б) 

Рис. 7.6. Трансформация с использованием «габаритного» контейнера: 
а) масштабирование; б) поворот 
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Свободная трансформация 
 
1.  Free Transform (Свободное трансформирование) 
 
С помощью инструмента Free Transform (Свободное трансформиро-

вание) можно получить свободную деформацию объекта, в том числе 
имитировать перспективу и наклон (рис.7.7). Для этого необходимо выделить 
объект, включить инструмент Free Transform (Свободное трансформиро-
вание), захватить один из угловых маркеров и только потом нажать клавишу 
<Ctrl>. Маркер начинает независимо от других перемещаться, образуя непра-
вильный четырехугольник, в который вписан исходный объект.  

Если нажать комбинацию клавиш <Shift> + <Alt> + <Ctrl>, то деформи-
рование габаритного прямоугольника будет происходить симметрично, 
создавая эффект перспективы.  

С помощью инструмента Free Transform (Свободное трансформиро-
вание) можно выполнить наклон. Для этого необходимо инструментом 

Selection (Выделение) выделить объект или объекты, предназначенные для 
отражения, включить инструмент Free Transform (Свободное трансфор-
мирование), захватить боковой маркер «габаритного» контейнера и, нажав 
комбинацию клавиш <Ctrl> + <Alt>, протянуть его в направлении, отличном 
от обычного.  

 

а) б) в) 

Рис. 7.7. Примеры свободной трансформации: 
а) деформация; б) перспектива, в) наклон 

 
 
2. Фильтр Free Distort 
 
В меню Effect > Distort & Transform (Фильтр > Деформация & Транс-

формация) представлена команда Free Distort (Свободная деформация), 
которая позволяет изменять форму выделенного объекта или объектов. В од-
ноименном диалоговом окне выделенный объект или совокупность объектов 
размещаются в прямоугольнике, в углах которого располагаются маркеры. 
Произвольное перемещение маркеров деформирует объекты (рис.7.8).  
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Рис. 7.8. Свободная деформация с помощью фильтра Free Distort  
 
 

7.3.2. Эффекты искажения 
 
Под эффектом искажения понимается деформация формы выбранного в 

документе векторного объекта под воздействием семи инструментов группы 
Warp (Искажение) и шести команд, составляющих первое подменю Distort 
(Искажение) меню Effect > Distort & Transform (Фильтр > Деформация & 
Трансформация). 

 
1. Инструменты искажения 
 
1) Warp (Деформация) - произвольное искажение формы объектов.  
2) Twirl (Воронка) - искажение вращательного характера границ объ-

екта.  
3) Pucker (Втягивание) - втягивание границ объекта 
4) Bloat (Раздувание) - раздувание границ объекта 
5) Scallop (Зубцы) - добавление плавных криволинейных деталей гра-

нице объекта 
6) Cristallize (Кристаллизация) - добавление остроугольных деталей 

границе объекта 
7) Wrinkle (Морщины) - добавление щероховатостей границе объекта 

   

1) 2) 3) 4) 5) 6) 7) 

Рис. 7.9. Примеры эффектов искажения инструментами:  
1) Warp(Искривление); 2) Twirl (Закручивание); 3) Pucker (Втягивание); 4) Bloat 

(Вздутие); 5) Scallop (Моллюск); 6) Cristallize (Кристаллизация); 7) Wrinkle (Морщина) 
 
2. Команды искажения 
 
1) Free Distort (Свободная трансформация) - эффект искажения путем 

регулировки в диалоговом окне команды контура прямоугольника, описан-
ного вокруг данного объекта. 
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2) Pucker & Bloat (Втягивание и вздутие) - деформирует контуры во 
внутреннюю или внешнюю стороны. 

3) Roughen (Шерохотоватость) - создает  «шероховатый» контур, т. е. 
контур с зазубринами различной величины. 

4) Tweak (Щипок) - служит для произвольной деформации объектов в 
заданных пределах. 

5) Twist (Скручивание) - деформация объектов вращением, причем в 
центре вращение сильнее, чем по краям. 

6) Zig Zag (Зигзаг) - деформирует линии контура в виде зигзагообразных 
или волнистых линий. 

   

1) 2) 3) 4) 5) 6) 

Рис. 7.10. Примеры эффектов искажения командами:  
1)Free Distort (Свободная трансформация); 2)Pucker & Bloat (Втягивание и взду-

тие); 3)Roughen (Шерохотоватость); 4)Tweak (Щипок); 5)Twist(Скручивание); 6)Zig Zag 
(Зигзаг) 

 
 

7.3.3. Комбинирование объектов 
 
1. Составные контуры и фигуры 
 
Для создания сложных объектов недостаточно использовать только про-

стые геометрические фигуры и полученные с помощью инструмента Pen 
(Перо) контуры. Необходимо также иметь возможность объединения конту-
ров и фигур в новые, более сложные объекты.  

Для начала необходимо четко понимать разницу между простыми и со-
ставными контурами и фигурами. 

  
а)  б)  в)  

Рис. 7.11. Примеры простых и составных контуров и фигур: 
а) простые контуры; б) составной контур; в) составная  фигура 

 
Составной контур. Составные контуры состоят из двух или более про-

стых контуров. Для того, чтобы создать составной контур из нескольких 
простых необходимо сначала выделить их и выполнить команду Object > 
Compound Path > Make (Объект > Составной контур > Создать). Для то-
го, чтобы разделить составной контур на несколько простых необходимо 
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сначала его выделить и выполнить команду Object > Compound Path  > Re-
lease (Объект > Составной контур > Отменить).  

Составная фигура. Составная фигура состоит из двух или более конту-
ров, составных контуров, переходов, блоков текста или других составных 
фигур, которые соединяются вместе с целью создания новой, редактируемой 
фигуры. Для того, чтобы создать составную фигуру необходимо вывести на 
экран палитру Pathfinder (Обработка контуров), выделить объекты и вы-
полнить команду меню палитры Make Compound Shape (Создать 
составную фигуру). 

Главное различие между составными контурами и составными фигура-
ми состоит в том, что для составных фигур доступно больше средств 
редактирования. 

 
2. Палитра Pathfinder (Обработка контуров) 
 
Палитра Pathfinder (Обработка контуров) представляет собой мощное 

средство обработки контуров благодаря командам, которые позволяют раз-
личными способами объединять контуры и фигуры. Доступ к командам 
палитры осуществляется с помощью палитры Pathfinder (Обработка конту-
ров) и одноименной команды меню Effect (Эффект)  

 

Рис. 7.12. Палитра Pathfinder (Обработка контуров) 
 
Команды палитры разбиты на две группы: Shape Modes, предназначен-

ная для работы с пересекающимися фигурами и Pathfinders - для работы с 
составными контурами. 

Команды группы «Shape Modes» (рис.7.13): 
 Add (Добавление) - объединяет все объекты в одну составную фигуру, 

которой присваиваются атрибуты заливки и обводки верхнего объекта. 
 Subtract (Вычитание) - вычитает верхние объекты из самого нижнего, 

причем новому объекту будут присваиваются атрибуты заливки и обводки 
самого нижнего объекта. 

 Intersect (Пересечение) - образует новый объект из общих областей 
перекрывающихся фигур, которому присваиваются атрибуты заливки и об-
водки самого верхнего объекта. 

 Exclude (Исключение) - пересекающиеся области удаляются, а все 
остальные объединяются в одну, новому объекту присваиваются атрибуты 
заливки и обводки самого верхнего объекта. 
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1) 2) 3) 4) 

Рис. 7.13. Примеры команды группы «Shape Modes»:   
1) Add (Добавление); 2) Subtract (Вычитание); 3) Roughen Intersect (Пересечение); 4) 

Exclude (Исключение) 
 
Команды группы «Pathfinders» (рис.7.14):  

 Divide (Разделение) - разбивает объекты в местах пересечения на не-
зависимые фрагменты. Стили заливки и обводки сохраняются, кроме того, 
команда объединяет заливку всех контуров. По умолчанию все элементы бу-
дут сгруппированы. Поэтому, чтобы переместить, полученные объекты, 
сначала их следует разгруппировать. 

 Trim (Подрезка) -удаляет невидимые фрагменты перекрывающихся 
объектов. При этом все объекты остаются независимыми. Атрибуты заливки 
сохраняются, но обводка удаляется. Чтобы увидеть, как работает эта команда 
можно выделить объект и переместить его в сторону. 

 Merge (Слияние) -удаляет невидимые фрагменты перекрывающихся 
объектов и объединяет объекты, окрашенные в один цвет, обводка удаляется. 
Чтобы увидеть, как работает эта команда необходимо переместить объеди-
ненные объекты. *Корректно работает, если оба объекта имеют одинаковую 
заливку и обводку. 

 Grop (Обрезка) - разделяет объект на отдельные компоненты и удаля-
ет все области, оказавшиеся за пределами самого верхнего контура. 
Атрибуты заливки сохраняются, но обводка удаляется. 

 Outline (Обводка) - удаляет заливку объектов, разбивает их на конту-
ры, разделенные в точках пересечения. Цвет обводки станет таким же, как 
был цвет заливки, а атрибуты заливки будут удалены. 

 Minus Back (Минус нижний) - вычитает нижние объекты из верхнего, а 
полученный объект будет иметь цвет самого верхнего контура. 

 

   

1) 2) 3) 4) 5) 6) 

Рис. 7.14. Примеры команды группы «Pathfinders»:  
1) Divide (Разделение); 2) Trim (Подрезка); 3) Merge (Слияние); 4) Grop (Обрезка); 5) Out-

line (Обводка); 6) Minus Back (Минус нижний) 
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7.3.4. Обтравочные маски 
 
Обтравочная маска (Clipping Mask) - это объект, форма которого маски-

рует другой объект таким образом, что видимыми остаются только области, 
которые лежат в пределах маски, то есть рисунок обрезается по форме маски. 
Обтравочной маской может быть векторный объект или группа объектов.  

Обтравочная маска и замаскированные объекты называются обтравоч-
ным набором. Обтравочный набор можно составить выделив два и более 
объектов или на основе всех объектов группы или слоя. Обтравочные наборы 
на уровне объектов объединяются в группу в палитре Layers (Слои) При со-
здании обтравочных наборов на уровне слоев, объект, находящийся в слое 
поверх остальных, обрезает лежащие под ним объекты. Все операции над об-
травочным набором на уровне объектов, например, выравнивание, 
выполняются на основе границы обтравочной маски, а не границы немаски-
рованной области. 

Создав обтравочную маску на уровне объекта, можно выделить содер-
жимое, которое было обрезано, используя палитру Layers (Слои) или 
инструмент Selection (Прямое выделение) или изолировав обтравочный 
набор. 

Работая с масками нужно помнить следующее: 
- в качестве маскирующих объектов могут использоваться только 

векторные объекты, в том числе открытый, закрытый, составной контуры, 
текст; 

- применить маску можно к любому векторному или растровому объ-
екту; 

- маскирующий объект должен располагаться поверх маскируемого, 
причем оба объекта должны быть размещены на одном слое; 

- цвет маски, её прозрачность, а так же толщина обводки не влияет на 
процесс маскирования; 

- если для создания маски используется несколько объектов, их необхо-
димо предварительно преобразовать в один составной контур. 

 
1. Создание обтравочной маски для сокрытия частей объектов 
 
Для создания обтравочной маски необходимо создать объект, который 

будет использоваться в качестве маски (обтравочный контур), переместить 
ее поверх объектов, которые следует маскировать, выделить все и выполнить 
команду Object > Clipping Mask > Make (Объект > Маска > Создать). 
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а) б) 

Рис. 7.15. Примеры обтравочной маски для растровых объектов:  
а) обтравочный котур – векторный объект; б) обтравочный котур - текст 

 
 

2. Создание обтравочной маски для группы или слоя 
 
Для создания обтравочной маски на уровне слоя необходимо создать 

объект, который будет использоваться в качестве маски, перенести маску и 
объекты, которые следует маскировать, в слой или группу, в палитре Layers 
(Слои) следует убедиться, что маскирующий объект является верхним объек-
том группы или слоя и щелкнуть на имени группы или слоя. В нижней части 
палитры Layers (Слои) необходимо нажать кнопку Make/Release Clipping 
Mask (Создать/Отменить Маску) или выполнить команду Make Clipping 
Mask (Создать Маску) меню палитры. 

 
3. Редактирование обтравочной маски 
 
Для редактирования обтравочной маски в палитре Layers (Слои) необ-

ходимо выбрать обтравочный контур или выделить обтравочный набор и 
выполнить команду меню Object > Clipping Mask > Edit Contents (Объект 
> Маска > Редактировать Cодержимое). Затем можно выполнить одно из 
следующих действий: 

- переместить обтравочный контур, перетаскивая центральную кон-
трольную точку объекта с помощью инструмента Direct Selection 
(Частичное выделение); 

- изменить форму обтравочного контура с помощью инструмента Di-
rect Selection (Частичное выделение); 

- применить к обтравочному контуру заливку и обводку. 
Чтобы добавить объект в обтравочную маску или удалить из нее необ-

ходимо в палитре Layers (Слои) перетащить объекты в группу или слой, 
содержащий обтравочный контур, или из группы/слоя. 

 
4. Удаление обтравочной маски 

 
Для освобожения объектов от обтравочной маски необходимо выпол-

нить одно из следующих действий: 
- выбрать группу, которая содержит обтравочную маску и выполнить 

команду Object > Clipping Mask > Release (Объект > Маска > Отменить). 
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- в палитре Layers (Слои) щелкнуть на имени группы или слоя с обтра-
вочной маской. Нажать кнопку Make/Release Clipping Mask 
(Создать/Отменить Маску) в нижней части палитры или выполнить коман-
ду  Release Clipping Mask  (Создать Маску)  меню палитры. 

Поскольку обтравочной маске назначается значение заливки и обводки 
None (Нет), она будет невидимой, пока ее не выделить и не назначить новое 
значение атрибута заливки/обводки. 

 
7.4. Методические указания к выполнению работы 

 
1. Трансформация объектов. Создайте на рабочем столе несколько 

простых фигур, представленных выше на рисунке 7.2. С помощью инстру-
ментов трансформации Rotate (Поворот), Reflect (Отражение), Scale 
(Размер), Shear (Наклон) попробуйте трансформировать объекты и добиться 
аналогичных результатов. Изучите диалоговые меню каждого инструмента и 
установку центра трансформации объекта. 

2. Искажение объектов. Нарисуйте пятиконечную звезду. Сделайте 
тринадцать копий оригинала. С помощью семи инструментов группы Warp 
(Деформация) и шести команд Distort (Искажение) меню Effect (Эффект) 
деформируйте форму объекта и попробуйте получить результаты, аналогич-
ные, представленным на рисунках 7.9 и 7.10. Изучите диалоговые меню 
каждой команды искажения. 

3. Обработка контуров. Нарисуйте две простые фигуры (например, 
квадрат и круг) наложите их друг на друга. Сделайте десять копий группы 
созданных объектов. С помощью различных команд палитры Pathfinder (Об-
работка контуров) создайте более сложные фигуры, аналогичные 
представленным выше на рисунках 7.13 и 7.14.  

4. Создание маски. Поместите в рабочий документ любое растровое 
изображение и сделайте его копию. Нарисуйте круг и расположите его по-
верх первого растрового объекта. Создайте с помощью команды Clipping 
Mask (Обтравочная маска) меню Object (Объект) или контекстного меню 
объекта обтравочную маску. Напишите произвольный текст и поместите его 
поверх второго растрового объекта. Аналогичным образом создайте обтра-
вочную маску из текста. Не забудьте, что текст состоит из нескольких 
неперекрывающихся объектов (буквы), поэтому прежде чем делать маскиро-
вание необходимо преобразовать его в составной контур.  

 
7.5. Контрольные вопросы 

 
1. Какие инструменты используются для трансформации объектов? 
2. Каким образом можно создать зеркальную копию объекта?  
3. Как можно задать точку, относительно которой изменяется угол вра-

щения объекта?  
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4. Как выполнить пропорциональное изменение размеров группы объек-
тов? 

5. Какой простой способ существует для создания перспективы? 
6. Какая команда используется для создания составного контура? 
7. Какая палитра позволяет создавать более сложные объекты? 
8. Может ли растровое изображение служить маскирующим объектом? 
9. Влияет ли цвет маски на процесс маскирования? 

 
 

ЛАБОРАТОРНАЯ РАБОТА №8 
«Работа с кистями» 

 
8.1. Цель работы 

 
Изучить технологию, средства и способы создания и редактирования де-

коративных элементов оформления графических векторных объектов. 
Приобрести навыки практической работы, необходимые для выполнения 
операций, совершаемых при работе с различными типами кистей  и настрой-
кой их параметров.  

 
8.2. Задание к лабораторной работе 

 
Создайте открытку на произвольную тему (например, новогодняя, «ва-

лентинка» и т.п.). В процессе выполнения проекта создайте свои 
собственные кисти в соответствии с выбранной тематикой (трава, снежинки, 
сердце, лента и т.п.) и используйте их в своей работе.  

Полученный результат сохраните в файле «card.ai», сдайте преподава-
телю на проверку и защитите его.  

Рис. 8.1. Примеры поздравительных открыток 
 

8.3. Работа с кистями 
 
Инструменты, рассмотренные ранее, позволяют создавать контуры раз-

личных форм и цвета, но иногда необходимо добавить к ним графические 
элементы оформления. Программа предоставляет возможность использовать 
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стандартные или создавать новые кисти различных типов, позволяющие из-
менить внешний вид контуров, украшая их декоративными элементами. 

Кисти применяются к контурам при рисовании инструментом  
Paintbrush (Кисть) или другими инструментами рисования. Их мож-

но выбирать из имеющихся стандартных наборов, модифицировать или 
создавать собственные в процессе работы. Все кисти — как стандартные, так 
и вновь созданные отображаются в палитре Brushes (Кисти).  

 
8.3.1. Типы кистей 

 
Палитра Brushes (Кисти) содержит четыре основных типа кистей, кото-

рые служат для создания различных художественных эффектов (рис.8.2): 
1) Calligraphic (Каллиграфические) - жесткие кисти, имитирующие ри-

сование каллиграфическим пером с определённым углом наклона. 
2) Scatter (Диффузные) - фигурные кисти, «распыляющие» копии объек-

тов вдоль траектории контура.  
3) Art (Художественные) - кисти, имитирующие рисование карандашом 

или краской (например, мелом или акварелью) и растягивающие определен-
ное изображение вдоль контура. 

4) Pattern (Узорчатая) - кисти, располагающие вдоль траектории от-
дельные декоративные элементы (tile). Кисть данного типа может содержать 
пять элементов: основной рисунок, внешний и внутренний углы, начало и 
конец бордюра. 

  
а) б) в) г) 

Рис. 8.2. Типы кистей:  
а) каллиграфическая , б) диффузная, в) художественная, г) узорчатая 

 
Необходимо иметь в виду, что стрелки, созданные с помощью диффуз-

ной кисти, остаются прямыми по отношении к контуру, а художественной 
или узорчатой кисти  ⎯ изгибаются по форме контура.  

 

а) б) в) 

Рис. 8.3. Стрелки, созданные разными кистями:  
а) диффузная, б) художественная, в) Узорчатая 
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8.3.2. Палитра Brushes (Кисти) 
 
Палитра Brushes (Кисти) предназначена для работы с кистями (рис.8.4). 

С ее помощью можно Палитра Brushes (Кисти) создавать и хранить любые 
новые кисти всех четырех типов, а также получать копии кистей, изменять их 
параметры и удалять ненужные кисти. Доступ к этим возможностям осу-
ществляется при помощи контекстного меню палитры.  

По умолчанию Палитра Brushes (Кисти) отображает пиктограммы ки-
стей, при желании можно выводить только список имен кистей. Для этого 
необходимо выполнить команду List View (Отобразить список) из кон-
текстного меню палитры. 

Обилие неиспользованных в документе кистей при передаче готового 
документа увеличивает объем файла. Программа дает возможность выделить 
ненужные кисти с помощью команды Select AD Unused (Выделить неис-
пользованные) и удалить их в корзину. Кроме того, удалить выделенные 
кисти можно с помощью команды Delete Brush (Удалить кисть). 

Для создания кисти с другими параметрами достаточно получить копию 
имеющейся – команда Duplicate Brush (Копировать кисть) и изменить ее 
параметры. В контекстном меню палитры также расположена команда Brush 
Option (Параметры кисти), предназначенная для изменения всех парамет-
ров конкретной кисти. Диалоговые окна совершенно идентичны тем, которые 
открываются при создании кисти 

 
Рис. 8.4. Палитра Brushes (Кисти) 
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Общие принципы работы с палитрой Brushes (Кисти) 
 
1) Применение кисти к обьекту - выделить объект инструментом Selec-

tion (Выделение) и в палитре Brushes (Кисти) щелкнуть на соответствующей 
пиктограмме кисти или перетащить ее на контур. Для того чтобы сохранить 
параметры кисти (например, размер, поворот и т.п.), которые были у объекта 
от ранее присвоенной кисти, следует удерживать клавишу <Alt>. 

2) Удаление кисти с обьекта - выделить линию, раскрашенную кистью и 
в палитре Brushes (Кисти) в контекстном меню палитры выбрать команду 
Remove Brush Stroke (Удалить мазок кисти) или нажать кнопку  

 Remove Brush Stroke (Удалить мазок кисти) внизу палитры.  
3) Одновременное рисование линий и применение кисти - выбрать кисть 

в библиотеке кистей или в палитре Brushes (Кисти) и инструментом  
Paintbrush (Кисть) нарисовать линию.  

4) Удаление кисти из палитры - выделить кисть и нажать кнопу 
 Delete (Удалить) или выполнить команду меню палитры Delete Brush 

(Удалить кисть). Для того, чтобы удалить неиспользованные в документе 
кисти их можно предварительно выделить с помощью команды меню палит-
ры Select All Unused (Выбрать Неиспользованные).  

5) Создание дубликата кисти - выполнить команду меню палитры Dupli-
cate Brush (Дублировать кисть) или перетащить кисть на кнопку  

 New Brush (Новая кисть) внизу палитры. 
6) Подгрузить кисти из библиотеки - выполнить команду меню палитры 

Open Brush Libraries (Открыть Библиотеку кистей) Кроме того, можно под-
гружать в палитру кисти, созданные собственноручно или скачанные из сети 
Интернет. 

7) Сохранить библиотеку кистей - выполнить команду меню палитры Save 
Brush Libraries (Сохранить Библиотеку кистей) 

 
8.3.3. Инструмент Paintbrush (Кисть) 

 
Инструмент Paintbrush (Кисть) предназначен для выполнения опе-

рации рисования кистью, а конкретный вид контуров определяется в палитре 
Brushes (Кисти).  

При выборе данного инструмента курсор приобретает форму кисти. При 
рисовании контура инструментом Paintbrush (Кисть) путь курсора отме-
чается точечной линией. В процессе рисования незамкнутой линии кнопку 
мыши можно отпустить, когда линия примет желаемую форму, а для замкну-
той - удерживать нажатой клавишу <Alt>. 

После прекращения рисования объекта программа преобразует его в 
векторный объект, который можно редактировать инструментами группы 

Pen (Перо). Более того, любому созданному ранее контуру могут быть 
присвоены параметры кисти. 
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Чтобы применить кисть при рисовании инструментом Paintbrush 
(Кисть) достаточно просто выбрать нужную кисть в палитре Brushes (Ки-
сти), и приступить к рисованию.  

Чтобы применить кисть к контуру, созданному любым инструментом 
рисования, необходимо выделить контур и затем выбрать кисть в палитре 
Brushes (Кисти). 

Кроме того, у инструмента существуют общие параметры, устанавлива-
емые в диалоговом окне Paintbrush Tool Preferences (Установки 
инструмента Кисть). 

 
Общие параметры инструмента Paintbrush (Кисть) 
 
Двойной щелчок на инструменте  Paintbrush (Кисть) выводит на 

экран диалоговое окно Paintbrush Tool Preferences (Параметры инстру-
мента Кисть), в котором определяются общие параметры инструмента 
(рис.8.5). 

 
Рис. 8.5. Параметры инструмента Brush (кисть) 

В разделе Tolerance (Допуск) представлены два параметра, влияющих на 
характер создаваемого контура. 

- Fidelity (Точность) - определяет расстояние в пикселах, на которое 
может отклоняться курсор при рисовании.  

- Smoothness (Гладкость) - определяет сглаженность контура. 
В разделе Options (Опции) представлены три параметра: 
- Fill new brush strokes (Залить штрихи новой кисти) - обеспечивает ав-

томатическую заливку, созданному контуру.  
 

8.3.4. Работа с библиотеками кистей 
 
Библиотеки кистей - это коллекции образцов кистей, поставляемых вме-

сте с программой, а также пользовательские варианты коллекций кистей.  
Загрузить один или несколько наборов кистей можно с помощью коман-

ды Brush Libraries (Библиотеки кистей) меню Window (Окно), которое 
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открывает список стандартных библиотек кистей. Эту же операцию можно 
выполнить с помощью команды Open Brush Libraries (Открыть Библиоте-
ку кистей) меню палитры Brushes (Кисти). Вариант Other Library (Другая 
библиотека) позволяет загрузить документ с образцами кистей из пользова-
тельских библиотек.  

После выбора одной из библиотек набор кистей отражается в специаль-
ной палитре (имя библиотеки указывается на вкладке), работа в которой 
ограничивается присвоением кисти выделенному контуру и возможностью 
перенести кисть в палитру Brushes (Кисти) методом «перетаскивание» или с 
помощью команды Add to Brushes (Добавить в палитру) меню палитры. В 
самой палитре библиотек кистей добавлять, удалять или изменять параметры 
кистей нельзя. 

Можно создавать и собственные библиотеки кистей. Для этого необхо-
димо удалить все лишние кисти и выполнить команду Save Brush Libraries 
(Сохранить Библиотеку кистей) меню палитры Brushes (Кисти) и его имя 
появится в списке команды Brush Libraries (Библиотеки кистей) разумеет-
ся, после перезагрузки программы.  

 
8.3.5. Создание и редактирование кистей 

 
Палитра Brushes (Кисти) позволяет создавать и хранить любые новые 

кисти всех четырех типов. При этом можно использовать произвольные ри-
сунки, удовлетворяющие следующим ограничениям: 

- они должны иметь простой закрытый контур; 
- они не должны иметь декоративной или градиентной заливки; 
- они не должны входить в группу промежуточных объектов (blend) и 

градиентной сетки (gradient mesh); 
- они не должны иметь параметров другой кисти; 
- они не должны содержать растровых объектов, диаграмм и масок; 
- кисти типов Art (Художественная) и Pattern (Узорчатая) не должны 

включать шрифтовые блоки (для этого шрифт должен быть преобразован в 
кривые). 

Для создания кисти нужно щелкнуть по кнопке  New Brush (Новая 
кисть) в нижней части палитры Brushes (Кисти) или выбрать одноименную 
команду в меню палитры. В открывшемся диалоговом окне New Brush (Но-
вая кисть) необходимо выбрать тип создаваемой кисти. 

 
Рис. 8.6. Выбор типа создаваемой кисти 
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После выбора типа создаваемой кисти и нажатия на кнопку <Ok> откро-

ется соответствующее диалоговое окно, в котором можно задать уникальное 
имя кисти, а также определить необходимые параметры. Когда параметры 
кисти будут настроены соответствующим образом и сохранены  кисть отоб-
разится в палитре Brushes (Кисти). Созданные в процессе работы кисти 
сохраняются только в том файле, в котором они были созданы. 

 
Создание кисти типа Calligraphic (Каллиграфические) 

 
С помощью данного типа кисти получаются контуры, напоминающие 

каллиграфическое письмо или создающие эффект плакатного пера (рис.8.7).  

 

Рис. 8.7. Фрагмент с каллиграфической кистью 
 
Если при создании новой кисти был выбран тип New Calligraphic Brush 

(Новая каллиграфическая кисть), то откроется диалоговое окно Calligraphic 
Brush Options (Параметры Каллиграфической Кисти), в котором необходи-
мо определить параметры каллиграфической кисти (рис.8.8.). 

 

Рис. 8.8. Настройка параметров каллиграфической кисти 
 
В поле Name (Имя) можно ввести произвольное имя до 30 символов или 

принять имя, предлагаемое программой, остальные поля определяют внеш-
ний вид кисти:  

- Angle (Угол) - определяет угол наклона  кисти; 
- Roundness (Закругление) - определяет округлость кисти, чем больше 

значение, тем больше округлость; 
- Diameter (Диаметр) - определяет диаметр кисти. 
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В раскрывающемся списке справа от каждого параметра можно следу-
ющие варианты определения формы кисти: 

- Fixed (Фиксированное значение) - используется для установки точного 
значения; 

- Random (Разброс параметров) - используется для получения случай-
ного значения в определенном диапазоне 

- Pressure (Нажим) доступен только при наличии графического планше-
та, у которого степень нажима пера (stylus) коррелируется с величиной 
соответствующего параметра. 

После определения параметров кисти и нажатия кнопки  <OK> новая 
кисть будет отображена в палитре Brushes (Кисти). 

Если новая кисть является модификацией имеющейся кисти, присвоен-
ной существующим объектам, то на экран выводится еще одно диалоговое 
окно Brush Change Alert (Предупреждение об изменении кисти), в котором 
представлены кнопки: 

- Apply to Strokes (Применить к имеющимся штрихам) - изменяет пара-
метры новой кисти, и присваивает их объектам с предшествующим 
вариантом кисти; 

- Leave Strokes (Сохранить штрихи без изменения) - изменяет парамет-
ры новой кисти, но не влияет на объекты с предшествующим вариантом 
кисти. 

 
Создание кисти типа Scatter (Диффузная) 

 
При использовании данного типа кистей объекты (листья, жучки, пу-

зырьки и т.д.) располагаются вдоль пути следования кисти (рис.8.9).  

 
Рис. 8.9. Фрагмент с диффузной кистью 

 
Если при создании новой кисти был выбран тип New Scatter Brush (Но-

вая диффузная кисть), то откроется диалоговое окно Scatter Brush Options 
(Параметры Диффузной Кисти), в котором необходимо определить все воз-
можные параметры кисти этого типа (рис.8.10). 

В поле Name (Имя) можно ввести произвольное имя до 30 символов или 
принять имя, предлагаемое программой, остальные поля определяют внеш-
ний вид кисти:  

- Size (Размер) - определяет размер объектов; 
- Spacing (Интервал) - определяет расстояние между объектами;  
- Scatter (Разброс) - определяет степень близости объектов к контуру; 
- Rotation (Поворот) - определяет угол поворота объектов;  
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- Rotation Relative to (Поворот относительно) -  задает угол поворота 
для объектов относительно страницы (page) или контура (path). 

В разделе Colorization (Тонирование) определяется метод колоризации, с 
помощью которого осуществляется настройка цвета кисти: 

- Tints (Оттенки) - отображает цвета в оттенках цвета, установленного в 
палитре инструментов для обводки; 

- Tints and Shades (Оттенки и Тени) - отображает цвета в диапазоне от-
тенков цвета установленного в палитре инструментов для обводки; 

- Hue Shift (Сдвиг оттенка) - все, что окрашено основным цветом (key 
color), приобретает цвет установленного в палитре инструментов для обвод-
ки, другие же цвета становятся дополнительными к нему.  

Раздел Colorization (Тонирование)  используется также в настройках ки-
стей Art (Художественная) и Pattern (Узорчатая). 

 

Рис. 8.10. Настройка параметров диффузной кисти 
 
 

Создание кисти типа Art (Художественная) 
 
При использовании этой кисти объект распределяется вдоль траектории, 

заданной инструментом. В кистях Art (Художественная) используется ими-
тация различных графических средств (мокрая  или сухая кисть, карандаш, 
уголь и др.) (рис.8.11). 

 

Рис. 8.11. Фрагмент с художественной кистью 

Если при создании новой кисти был выбран тип New Art Brush (Новая 
Художественная Кисть), то откроется диалоговое окно Art Brush Options 
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(Параметры Художественной Кисти), которое позволяет определить все 
возможные параметры кисти этого типа (рис. 8.12). 

 

 

Рис. 8.12. Настройка параметров художественной кисти 
 
В поле Name (Имя) следует ввести произвольное имя до 30 символов 

или принять имя, предлагаемое программой. Остальные поля определяют 
внешний вид кисти.  

В группе Direction (Направление) представлены четыре кнопки, опреде-
ляющие направление рисунка кисти относительно траектории контура: 

- Srtoke From Right To Left (Контур справа налево); 
- Srtoke From Left To Right (Контур х слева направо); 
- Srtoke From Bottom To Top (Контур снизу вверх); 
- Srtoke From Top To Bottom (Контур сверху вниз); 
Если необходимы дополнительные варианты направлений, то следует 

использовать группу Flip (Отражение), в которой представлены два флажка: 
- Flip Along (Отражение по горизонтали) - поворачивает рисунок кисти 

вдоль стрелки поля Direction (Направление); 
- Flip Across (Отражение по вертикали) -  поворачивает рисунок кисти 

поперек стрелки поля Direction (Направление). 
В группе Size (Размер) в поле Width (Ширина) можно ввести значение в 

процентах, которое обеспечит масштабирование рисунка кисти. Флажок Pro-
portional (Пропорционально) позволяет при масштабировании  сохранить 
пропорции рисунка кисти. 

 
Создание кисти типа Pattern (Узорчатая) 

 
С помощью данного типа кисти создается узор, состоящий из разных 

фрагментов (рамки, бордюры и т.п.) (рис.8.13) 
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Рис. 8.13. Фрагменты с узорчатой кистью 

 
Процесс создания и использования кисти типа Pattern (Узорчатая) бо-

лее сложный по сравнению с другими типами кистей, т.к. позволяет 
расположить серию декоративных элементов вдоль контура (рис.8.14): боко-
вой элемент, внешний угловой элемент, внутренний угловой элемент, 
начальный элемент, конечный элемент. Существует несколько способов со-
здания узорчатой кисти:  

- чтобы создать простой узор, например, применяемый к прямой линии, 
можно, выделить объект, используемый в качестве узора, и щелкнуть по 
кнопке New Brush (Новая кисть) в нижней части палитры Brushes (Кисти).  

- чтобы создать более сложный узор для применения к объектам, состо-
ящим из кривых и углов, необходимо сначала создать из иллюстраций 
образцы узоров в палитре Swatches (Образцы), используемые для элементов 
узорчатой кисти, а затем задать новую кисть. Например, чтобы создать узор-
чатую кисть для применения к прямой линии с углами, потребуется три 
образца узоров: для прямой линии, внутреннего угла и внешнего углов.  

 

Рис. 8.14. Элементы узорчатой кисти 

Для создания новой декоративной кисти необходимо выбрать тип New 
Pattern Brush (Новая узорчатая кисть). Появится диалоговое окно Pattern 
Brush Options (Параметры узорчатой кисти), которое позволяет опреде-
лить все возможные параметры кисти этого типа (рис.8.15).  
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Рис. 8.15. Настройка параметров узорчатой кисти 

В поле Name (Имя) следует ввести произвольное имя до 30 символов 
или принять имя, предлагаемое программой. Остальные поля определяют 
внешний вид кисти.  

Ниже расположен блок присвоения различным частям контура декора-
тивных элементов, хранящихся в палитре Swatches (Образцы). Назначение 
кнопок условно обозначено на схемах под ними: 

- Side (Боковой фрагмент) - предназначен  для определения рисунка, ко-
торый используется на прямолинейных участках контура;  

- Outer Corner (Внешний угол) и Inner Coner (Внутренний Угол) - предна-
значены для определения рисунков, которые используется для углов, 
направленных во внешнюю или внутреннюю сторону;  

- Start (Начало) и End (Конец) - предназначены для определения рисун-
ков, которые используется для начального или конечного сегментов контура. 

При выборе конкретного элемента (из списка под кнопками) его рисунок 
в уменьшенном виде отображается в окне-кнопке, а если элемент не выбран, 
то отображается косая красная черта и в списке элементов активным является 
вариант None (Не задан).  

В группе Size (Размер) можно определить Scale (Масштаб) - размер 
элемента относительно исходного и Spacing (Пробелы) - расстояние между 
элементами.  

В группе Flip (Отражение) можно изменить ориентацию узора устано-
вив флажки Flip Along (Отражение по горизонтали) и/или Hip Across 
(Отражение по вертикали). 

В группе Fit (Настройка) можно определить способ подгонки узора к 
контуру при помощи переключателей: 
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- Stretch to Fit (Растянуть) - удлинение или укорачивание элемента с 
тем, чтобы полностью выполнить контур рамки; 

- Add space to Fit (Вставить пробелы) - добавление пробелов, равномер-
но распределенных по всей длине контура; 

- Approximate path (Сместить) - перемещение элементов таким образом, 
что линия контура не обязательно проходит по центру элемента, но вмещает-
ся целое число элементов. 

Для декоративных элементов кисти могут использоваться и текущие ри-
сунки, однако при этом необходимо придерживаться следующего порядка: 

1) создать декоративные элементы для частей контура; 
2) убедиться, что у палитры Brushes (Кисти) кисти отображаются пик-

тограммами; 
3) перетащить элемент для стороны на кнопку New Brush (Новая 

кисть), выбрать вариант New Pattern Brush (Новая узорчатая кисть) и 
нажать кнопку <OK>; 

4) в диалоговом окне Pattern Brush Options (Параметры узорчатой ки-
сти) определить, если требуется, части кисти из списка декоративных 
элементов и все другие параметры и нажать кнопку <OK>; при нажатой кла-
виши <Alt> перетащить иные элементы, в том числе и новый элемент для 
сторон, на соответствующий сектор в строке кисти, а именно:  

первый сектор - для внешнего угла;  
второй и третий сектора - для сторон;  
четвертый сектор - для внутреннего угла;  
пятый сектор - для конца;  
шестой сектор - для начала. 
 

Редактирование кисти 
 
Для редактирования кисти необходимо дважды щелкнуть на кисти в па-

литре Brushes (Кисти) и в соответствующем диалоговом окне определить  
параметры кисти.  

Если текущий документ содержит контуры, раскрашенные кистью, для 
которых используется измененная кисть, то на экран выводится диалоговое 
окно Brush Change Alert (Предупреждение об изменении кисти), в котором 
представлены три кнопки: Apply to Strokes (Применить к контуру), Leave 
Strokes (Оставить контуры без изменения), Cancel (Отменить)  

Чтобы изменить рисунок кисти, необходимо кисти перенести из палит-
ры Brushes (Кисти) на свободное место рабочего документа. После внесения 
соответствующих изменений, рисунок необходимо перетащить на исходную 
кисть в палитре Brushes (Кисти) с нажатой клавишей <Alt>. 

Чтобы изменить линию, раскрашенную кистью, не обновляя соответ-
ствующую кисть, необходимо выделить линию и нажать кнопку  Options 
of Selected Object (Параметры выделенного объекта) внизу палитры Brush-
es (Кисти). 
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8.3.6. Преобразование декоративных контуров в обычные 
векторные объекты 

 
Декоративный контур можно преобразовать в обычный векторный объ-

ект, который доступен для обработки инструментами группы Pen (Перо). 
Для этого следует выделить такой контур и выполнить команду Expand 
(Преобразовать) главного меню Object (Объект). Если данная команда не-
доступна, то следует выполнить команду Expand Apperance (Преобразовать 
внешний вид), расположенную там же. В раскрывшемся одноименном диало-
говом окне следует установить флажок Stroke (Обводка) и нажать кнопку 
<Ok>.  

Для удаления кистей с декоративного контура и дальнейшего преобра-
зования его в векторный объект можно воспользоваться командой Remove 
Brush Stroke (Удалить обводки кисти) меню палитры Brushes (Кисти) или 
кнопкой с таким же названием в нижней части панели. Этой цели можно 
также достичь, если выбрать вариант None (Без атрибута) на вкладке Stroke 
(Обводка) в палитре Color (Синтез) или палитры инструментов.  

Если необходимо сохранить декоративный контур перед преобразовани-
ем его в обычный векторный объект при удалении кисти из палитры Brushes 
(Кисти), то в появившемся диалоговом окне Delete Brush Alert (Удалить 
кисть) необходимо нажать кнопку Expand Strokes (Преобразовать контур). 

 
8.4. Методические указания к выполнению работы 

 
1. Общие принципы работы. На панели инструментов выберите ин-

струмент Pen (Перо) и нарисуйте произвольный контур. Затем, не снимая 
выделения, перетащите на него соответствующую кисть из палитры Brushes 
(Кисти). Выберите кисть в палитре Brushes (Кисти) и инструментом 
Paintbrush (Кисть) нарисуйте произвольную линию. Измените параметры со-
ответствующей кисти в палитре Brushes (Кисти).  

2. Создание каллиграфической кисти. На панели инструментов выбе-
рите инструмент Pencil (Карандаш) и напишите первую букву своего имени. 
Затем щелкните по кнопке New Brush (Новая кисть) в нижней части палитры 
Brushes (Кисти) и укажите тип создаваемой кисти — New Calligraphic Brush 
(Новая каллиграфическая кисть). Настройте параметры новой кисти по сво-
ему усмотрению и сохраните ее. Перетащите кисть на созданный контур и 
отредактируйте ее для достижения желаемого результата. Сохраните создан-
ную кисть в палитре Brushes (Кисти). 

3. Создание диффузной кисти. На панели инструментов выберите ин-
струмент Pencil (Карандаш) и нарисуйте разными оттенками зеленого цвета 
несколько травинок. Затем выделите все линии и выберите из меню палитры 
Brushes (Кисти) команду New brush (Новая кисть) и укажите тип создавае-
мой кисти — New Scatter Brush (Новая диффузная кисть). Настройте 
параметры новой кисти по своему усмотрению и сохраните ее. Попробуйте 
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воспользоваться созданной кистью и нарисовать фрагмент травы. Если ре-
зультат не устраивает, то отредактируйте кисть. Сохраните созданную кисть 
в палитре Brushes (Кисти). 

4. Создание художественной кисти. Создайте художественную кисть 
на примере волос (схематично). Для этого нарисуйте отдельно несколько ли-
ний разного оттенка и распределите их так, чтобы они оказались лежащими 
друг на друге. При нажатой клавише <Shift> выделите все линии, щелкните 
по кнопке New Brush (Новая кисть) в нижней части палитры Brushes (Кисти) 
и укажите тип создаваемой кисти — New Pattern Brush (Новая узорчатая 
кисть). Определите параметры кисти, а затем воспользуйтесь кистью на 
практике. Если результат не устраивает, то отредактируйте кисть. Сохраните 
созданную кисть в палитре Brushes (Кисти). 

5. Создание узорчатой кисти. C помощью группы инструментов Rec-
tangle (Прямоугольник) нарисуйте квадрат и круг. Выделите круг и щелкните 
по кнопке New Brush (Новая кисть) в нижней части палитры Brushes (Кисти) 
и укажите тип создаваемой кисти — New Pattern Brush (Новая узорчатая 
кисть). В палитре появится новая кисть, в которой будут заполнены второй и 
третий сектора (рисунок на прямолинейных участках). Затем выделите квад-
рат и с нажатой клавишей <Alt> перетащите его сначала на первый сектор 
созданной кисти, а затем на четвертый сектор (рисунки для внутреннего и 
внешнего угла). Нарисуйте прямоугольник и примените к нему созданную 
кисть. Сохраните созданную кисть в палитре Brushes (Кисти). 

6. Работа с библиотеками кистей. Создайте собственную библиотеку 
кистей. Для этого удалите все лишние кисти таким образом, чтобы в палитре 
остались только вновь созданные кисти или использованные в процессе ра-
боты и выполните команду Save Brush Libraries (Сохранить Библиотеку 
кистей) меню палитры Brushes (Кисти). 

 
8.5. Контрольные вопросы 

 
1. Какие типы кистей можно создать с помощью палитры Brushes (Ки-

сти) и чем они отличаются? 
2. Можно ли создать кисть из объекта с градиентной заливкой? 
3. В чем состоит разница между применением кисти к рисунку  

с помощью инструмента PaintBrush (Кисть) и применением кисти к рисунку с 
помощью одного из инструментов рисования? 

4. Как влияет на работу инструмента PaintBrush (Кисть) установка 
флажка Keep Selected (Оставить выделенным)? 

5. Каким образом можно изменить рисунок кисти? 
6. Как можно удалить кисть с графического объекта? 
7. Для создания какого типа кистей необходимо выделить объект? 
8. Сколько секторов содержится в строке узорчатой кисти в палитре 

Brushes (Кисти) и для чего они предназначены?  
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ЛАБОРАТОРНАЯ РАБОТА №9 
«Работа со слоями» 

 
9.1. Цель работы 

 
Изучить способы управления информацией с помощью слоевой струк-

туры документа. Приобрести навыки практической работы со слоями и 
научиться распределять информацию на информационные блоки, чтобы ра-
ботать с ними индивидуально и как с единым целым.  

 
9.2. Задание к лабораторной работе 

 
Создать схему компьютерной или телекоммуникационной сети. Если 

оригинал схемы был выбран из учебных материалов или других источников, 
то необходимо внедрить исходное изображение в рабочий файл формата AI, 
который сдается на проверку. Результат должен  по качеству исполнения 
превосходить оригинал.  

Полученный результат сохраните в файле «scheme.ai», сдайте препода-
вателю на проверку и защитите его.  

 

Рис.9.1. Пример схемы компьютерной сети 
 
 

9.3. Работа со слоями 
 

9.3.1. Понятие слоя 
 
Слои - это гибкое средство программы, позволяющее разделить работу 

по отдельным уровням, которые можно редактировать и просматривать как 
отдельные элементы. Создание в документе нескольких слоев позволяет лег-
ко управлять печатью, изображением и редактированием. 
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Главное преимущество слоев заключается в их независимости друг от 
друга, поэтому редактировать содержимое отдельного слоя можно независи-
мо от всех остальных слоев изображения, не оказывая на них никакого 
влияния. При этом методы редактирования содержимого каждого слоя могут 
быть самыми разнообразными, а сами слои можно перемещать, меняя их 
между собой местами в «стопке», изменять степень их прозрачности, свой-
ства, делать слои невидимыми, создавать новые слои, удалять имеющиеся и 
т.д. – при этом каждый раз будет меняться вид всего изображения. 

Основные особенности слоев: 
- в пределах одного слоя объекты располагаются обычным способом - 

«стопкой», каждый объект имеет свой уровень; 
- сгруппированные объекты располагаются на одном и том же слое. при 

группировке объектов, находящихся на разных слоях, они перемещаются на 
самый верхний слой группы; 

- при маскировании объектов, находящихся на разных слоях, объекты 
промежуточных слоев также становятся частью маски. 

Количество слоев в одном документе неограниченно. Кроме обычных 
слоев можно использовать специальные шаблонные слои, которые представ-
ляют собой слои с характерным стилем, сохраняемые отдельно от слоев 
изображения, что позволяет многократно использовать их в различных доку-
ментах. 

Слои удобно использовать при создании планов, чертежей, схем и раз-
личной технической документации. Слои также применяют для создания 
фирменных бланков, визиток, рекламных проспектов и т.д., где обязательно 
использование определенного набора одинаковых элементов.  

 
9.3.2. Палитра Layers (Слои) 

 
Для создания слоев и работы с ними предназначена палитра Layers 

(Слои), которая вызывается одноименной командой меню Window (Окно). 
По умолчанию каждый новый документ содержит один слой, и каждый со-
здаваемый объект помещается в этот слой. Однако можно создавать новые 
слои и распределять элементы по своему усмотрению. 

В основном окне палитры Layers (Слои) отображаются сведения об 
имеющихся в текущем документе слоях и вложенных в слой подслоях 
(рис.9.2). Каждая строка палитры соответствует одному слою, подслою и 
объекту изображения. В каждой строке палитры в поле, расположенном пра-
вее миниатюры, выводится имя слоя, подслоя и объектов, которое можно 
изменить с помощью диалогового окна, которое будет рассмотрено ниже, а 
также элементы управления в виде различных значков, позволяющих управ-
лять отдельными свойствами данного слоя. 
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Основные параметры слоя: 
1) Видимость (скрыть/показать) - показывает, видны  или скрыты  (пу-

стое пространство) элементы в слоях, а также являются слои шаблонными  
или контурными . 

2) Фиксация (доступно/недоступно) - показывает, заблокированы или 
разблокированы элементы слоя (пустое пространство).  

3) Оформление (эффекты и стили) - показывает, предназначены ли слой, 
группа или объект для редактирования в палитре Appearance (Оформление). 
Если кнопка цели отображается как значок двойного кольца (  / ), то эле-
менты выбраны для изменения, а если как значок одиночного кольца ( / ), 
то не выбраны для изменения. 

4) Выделение - показывает, выделены ли элементы в слое или не выде-
лены (цветной прямоугольник). 

 

 

Рис.9.2. Палитра Layers (Слои) 
 
 

9.3.3. Создание нового слоя 
 
Каждый новый документ по умолчанию содержит один слой с именем 

Layer 1. Пользователь может создавать произвольное число слоев.  
Создать новый слой можно несколькими способами: 
- щелчок на кнопке  Create New Layer (Создать новый слой) в нижней 

части палитры - создает новый слой, который располагается над активным 
слоем или группой; 

- щелчок на кнопке  Create New Layer (Создать новый слой) в нижней 
части палитры с нажатой клавишей <Ctrl>  - создает новый слой, который  
располагается выше всех имеющихся слоев; 

- щелчок на кнопке  Create New Layer (Создать новый слой) в нижней 
части палитры с нажатой комбинацией клавиш  <Ctrl>  и  <Alt> - создает но-
вый слой, который  располагается ниже активного слоя; 

- щелчок на кнопке Create New Sublayer (Создать новый вложенный 
слой) в нижней части палитры создает новый слой в пределах активного 
слоя; 
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Новый слой можно получить копированием существующего слоя одним 
из способов: 

- команда Duplicate Layers (Создать копию слоя) меню палитры создает 
новый слой над активным слоем-оригиналом; 

- перетаскивания строки слоя на кнопки  Create New Layer (Создать 
новый слой) или Create New Sublayer (Создать новый вложенный слой) в 
нижней части палитры. 

 
Диалоговое окно Layer Options (Параметры слоя) 
 
Изменить параметры нового слоя, предлагаемые по умолчанию можно с 

помощью диалогового окна Layer Options (Параметры слоя) одним из сле-
дующих способов:  

- щелчок на кнопках  Create New Layer (Создать новый слой) и 
Create New Sublayer (Создать новый вложенный слой) с нажатой клавишей 
<Alt>; 

- команда New Layer (Новый слой) меню палитры Layer (Слой); 
- двойной щелчок на строке слоя. 

 
Рис.9.3. Диалоговое окно Layer Options (Параметры слоя) 

 
Параметры диалогового окна Layer Options (Параметры слоя): 
- Name (Имя) - произвольное имя слоя; 
- Color (Цвет) - выбор цвета; 
- Template (Шаблон) - шаблонный слой; 
- Show (Показать) - видимость слоя (видимый/невидимый); 
- Preview (Просмотр) - режим отображения (полноцветный/ контурный); 
- Lock (Закрепить) - блокирование слоя (доступный/не доступный)  
- Print (Печатать) - вывод на печать (да/нет); 
- Dim Images to (Фоновый режим) - интенсивность отображения связан-

ных и растровых изображений, содержащихся в слое, до определенного 
процентного значения. 

 
9.3.4. Шаблонный слой 

 
Шаблонный слой предназначен для хранения изображений, которые 

имеют вспомогательные функции и не предназначены для печати. При со-
здании такой слой по умолчанию фиксируется (locked) и отображается на 
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экране (previewed) в «притушенном» состоянии (dimmed) даже в контурном 
режиме (outline).  

В палитре Layers (Слои) шаблонный слой символизируется пиктограм-
мой  и знаком фиксирования .  

Шаблонный слой может быть создан специально или  конвертирован из 
любого имеющегося слоя.  

Для конвертации слоя в шаблонный необходимо выполнить одно из сле-
дующих действий:  

- выполнить команду Template (Шаблон) меню палитры;  
- выполнить команду New Layer (Новый слой) меню палитры и в диало-

говом окне Layer Options (Параметры слоя) установить флажок Template 
(Шаблон);  

- выполнить двойной щелчок на имени слоя и в диалоговом окне Layer 
Options (Параметры слоя) установить флажок Template (Шаблон);  

- выполнить щелчок на кнопке  New Layer (Новый слой) при нажатой 
клавише <Alt> и в диалоговом окне Layer Options (Параметры слоя) уста-
новить флажок Template (Шаблон).  

При установке флажка Template (Шаблон) автоматически становятся 
недоступными флажки Show (Показать), Preview (Иллюстрация), Lock (За-
крепить) и Print (Печатать). Это означает, что шаблонный слой всегда 
отображается и фиксируется, но никогда не выводится на печать.  

Новый шаблонный слой также образуется при импортировании изобра-
жений с помощью команды Place (Поместить) меню File (Файл), если в 
одноименном диалоговом окне установить флажок Template (Шаблон).  

Важно помнить, что шаблонный слой не выводится на печать и не 
сохраняется при экспортировании.  
 

9.3.5. Особенности работы со слоями 
 

1. Удаление слоя 
 

Выделенный в палитре слой/подслой, а вместе с ним и все находящиеся 
в нем объекты можно удалить одним из способов: 

- щелчок на кнопке Trash (Корзина) в нижней части палитры; 
- перемещение строки с именем слоя на кнопку Trash (Корзина); 
- выполнение команды Delete (Удалить) <имя> меню палитры.  
 
2. Временное удаление слоев с экрана 
 
В процессе работы может возникнуть необходимость отменить отобра-

жение каких-либо слоев на экране. Скрытый слой не дает возможности 
редактирования. Временно удалять с экрана можно не только слои, но также 
подслои и объекты. 
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Для временного удаления отдельного слоя или объекта с экрана необхо-
димо воспользоваться одним из способов: 

- щелкнуть на кнопке отображения видимости  в строке слоя или объ-
екта (повторный щелчок возвращает скрытую информацию на экран); 

- установить флажок Show (Показать) в диалоговом окне Layer Options 
(Параметры слоя) и таким же образом снять его; 

- выполнить команду Hide (Скрыть) меню Object (Объект).  
Если нужно скрыть все слои, кроме одного, то достаточно щелкнуть на 

соответствующей кнопке в строке слоя при нажатой клавише <Alt>. Повтор-
ный щелчок возвращает скрытую информацию на экран. 

Если скрыто несколько слоев, то для их одновременного отображения на 
экране необходимо можно выполнить команду Show All Layers (Показать 
все слои) меню палитры.  

 
3. Отображение слоев в контурном режиме 
 
Команда Outline (Контурный режим) меню View (Просмотр) позволяет 

отображать на экране весь документ в контурном виде. Однако следует иметь 
в виду, что контурный режим просмотра можно применять и к отдельным 
слоям. Символом этого режима является  «глаз без зрачка» (hollow eye 
icon).  

Для отображения в контурном режиме отдельного слоя необходимо 
необходимо с нажатой клавишей <Ctrl> щелкнуть на кнопке с символом 
«глаз»  или в диалоговом окне Layer Options (Параметры слоя) снять 
флажок Preview (Иллюстрация).  

Если нужно отобразить в контурном режиме все слои, кроме одного, до-
статочно щелкнуть на одной из кнопок при нажатой комбинации клавиш 
<Alt> + <Ctrl>. Повторный щелчок отменяет контурный режим просмотра. 

Для отмены контурного режима в нескольких слоях можно выполнить 
команду Preview All Layers (Просмотреть все слои) меню палитры. 

 
4. Фиксирование слоев и объектов 

 
Фиксированный слой представляет собой «единое целое»: объекты на 

таком слое не выделяются, не изменяются, не перемещаются и не удаляются. 
Фиксировать можно слои, подслои и объекты.  

Для фиксации отдельного слоя или объекта необходимо воспользоваться 
одним из способов:  

- щелкнуть на кнопке фиксирования слоя, левее имени. Символом фик-
сированного слоя является появление символа «замок» , а курсор 
принимает вид «перечеркнутого карандаша». Повторный щелчок на символе 
«замок» снимает фиксацию.  

- установить флажок Lock (Закрепить) в диалоговом окне Layer 
Options (Параметры слоя) и таким же образом снять его. 
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- выполнить команду Lock (Закрепить) меню Object (Объект). Снять 
фиксацию можно с помощью команды Unlock All (Освободить все) меню 
палитры Object (Объект). 

Для фиксации всех слоев, кроме одного достаточно щелкнуть на кнопке 
фиксирования слоя с нажатой клавишей <Alt>. Повторный щелчок на этой 
кнопке снимает фиксацию. 

Если нужно снять фиксацию с нескольких слоев одновременно можно 
воспользоваться командой Unlock All Layers (Раскрепить все слои) меню 
палитры Layer (Слои). 

 
5. Слияние слоев 

 
Уменьшить количество слоев можно за счет слияния их в единое целое. 

Для слияния двух или более выделенных слоев требуется выполнить команду 
Merge Selected (Объединить выделенные слои) меню палитры.  

С помощью команды Collect in New Layer (Разместить на новом слое) 
меню палитры можно собрать все выделенные слои, группы и объекты на 
новом слое.  

При слиянии слоев, расположенных вразбивку, необходимо обра-
щать особое внимание на полученный результат, поскольку 
объединение таких слоев чревато изменением общего рисунка. 

 
6. Изменение порядка слоев 

 
Для изменения порядка слоев необходимо в палитре захватить строку 

выделенного слоя и "перетащить" ее выше или ниже в "стопке" слоев. Ори-
ентироваться нужно по положению следующих элементов:  

- две линии со стрелками на краях — перемещаемый слой занимает по-
ложение между слоями;  

- треугольная стрелка - перемещаемый слой размещается на этом слое.  
 

7. Печать отдельных слоев 
 

С помощью установки и удаления флажков Show (Показать) и Print 
(Печатать) диалогового окна Layer Options (Параметры слоя) можно по-
лучить четыре режима отображения и печати объектов каждого слоя в 
отдельности:  

1) печатать и отображать на экране: установлены флажки Show (По-
казать) и Print (Печатать);  

2) печатать, но не отображать на экране: снят флажок Show (Пока-
зать) и установлен флажок Print (Печатать);  

3) не печатать и не отображать на экране: сняты флажки Show (Пока-
зать) и Print (Печатать);  



100 

 

4) не печатать, но отображать на экране: установлен флажок Show 
(Показать) и снят флажок Print (Печатать).  

При снятом флажке Print (Печатать) имя слоя отображается курсивным 
шрифтом.  

 
9.3.6. Особенности работы с объектами на слоях 

 
1. Местоположение объекта на слоях 
 
Для поиска объекта в палитре его следует выделить, а затем выбрать ко-

манду Locate Object (Определить местоположение объекта) меню палитры 
Layers (Слои). 

Если выделены несколько объектов, то определяется только местополо-
жение самого верхнего объекта. 

Если в палитре установлен режим Show Layers Only (Отображать 
только слои) команда меняется на Locate Layer (Определить местоположе-
ние слоя).  

 
2. Перемещение объектов с одного слоя на другой 
 
Для перемещения объектов с одного слоя на другой  можно использо-

вать команды буфера обмена информацией Cut (Вырезать), Сору 
(Скопировать) и Paste (Вклеить) меню Edit (Правка): 

- Paste (Вклеить) - объект, находящийся в буфере обмена, всегда поме-
щается на активный слой. Объект размещается по центру и в самом верхнем 
положении в «стопке» объектов на слое или в группе.  

- Paste in Front (Вклеить вперед) - позволяет разместить объект с сохра-
нением местоположения объекта на исходном слое, над самым верхним из 
выделенных объектов.  

- Paste in Back (Вклеить назад) - позволяет разместить объект в исход-
ном положении под самым нижним из выделенных объектов. Если 
выделенные объекты входят в группу, то объект, вклеиваемый с помощью 
этих двух команд, также помещается в группу.  

- Paste Remembers Layers (Вклеивать на прежние слои) - позволяет 
возвращать объекты на тот же самый слой, откуда они были скопированы 
или перемещены в буфер обмена.  

Перемещать объекты можно и с помощью палитры Layers (Слои). При 
выделении на слое каких-либо объектов, в строке слоя, в палитре с именем 
этого слоя или группы, появляется квадратик, совпадающий по цвету с 
условным «цветом» слоя. Перемещение этого квадратика на новую строку 
повлечет за собой и перемещение объектов. Если при перемещении квадра-
тика удерживать нажатой клавишу <Alt>, то объекты будут скопированы. 
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9.4. Методические указания к лабораторной работе 
 

1. Создание слоев. Создайте новый документ и откройте палитру Layers 
(Слои). С помощью инструментов группы Rectangle (Прямоугольник) по-
стройте многоугольник. Создайте новый слой и постройте на нем другую 
фигуру, например, звезду. Повторите последний шаг несколько раз, исполь-
зуя разные методы создания слоя и построения различных фигур.  

2. Перемещение слоев. Полученным на предыдущем шаге фигурам 
присвойте параметры заливки и обводки. Для заливки используйте различ-
ные цвета. Расположите объекты таким образом, чтобы они перекрывали 
друг друга, т.е. наложите их друг на друга. Сохраните полученный результат 
в файле. Затем в палитре Layers (Слои) измените порядок слоев. Обратите 
внимание на то, что происходит в рабочей области документа. 

3. Удаление слоев. Выделите слой с многоугольником и удалите его с 
помощью щелчка на кнопке Trash (Корзина) в нижней части палитры. Удали-
те еще два слоя на свое усмотрение, используя другие способы.  

4. Блокировка и скрытие слоев. Откройте сохраненный ранее файл. 
Заблокируйте два произвольных слоя различными способами. Выделите за-
блокированный слой и попробуйте на нем что-либо создать. Скройте 
отображение содержимого одного или двух слоев, не удаляя слои из палит-
ры. Снимите блокировку и верните видимость слоям. 

5. Слияние слоев. Выделите с нажатой клавишей <Ctrl> несколько сло-
ев и объедините их в один слой. Попробуйте выделить объект на каком-либо 
слое и переместить его на другой слой, а также поменять цвет слоя. Объеди-
ните все слои в один с помощью команды меню палитры. 

6. Создание шаблонного слоя. Создайте новый документ и откройте 
палитру Layers (Слои). Найдите в сети Интернет логотип, пригодный для 
дальнейшей трассировки и поместите его в документ на шаблонный слой. 
Далее осуществите преобразование растрового объекта в векторный с помо-
щью средств автоматической и ручной трассировки. Когда работа будет 
завершена, отключите видимость шаблонного слоя  и проверьте качество вы-
полненной работы. Исходное изображение из файла не удаляйте. 

 
9.5. Контрольные вопросы 

 
1. Какие способы создания нового слоя существуют? 
2. Как создать шаблонный слой из имеющегося слоя? 
4. Как можно скрывать слои? 
5. Как можно заблокировать слои? 
6. Каким образом можно отобразить слой в контурном режиме? 
7. Опишите способы изменения порядка слоев в файле. 
8. Опишите способы удаления слоев. 
9. В чем заключается цель изменения цвета выделения в слое? 
10. Как можно перемещать объекты с одного слоя на другой? 
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10. ЛАБОРАТОРНАЯ РАБОТА №10 
«Эффекты объема» 

 
 

10.1. Цель работы 
 

Изучить различные способы создания иллюзии глубины и объема век-
торных объектов. Приобрести навыки практической работы с инструментами 
и средствами, предназначенными для создания переходов, изменения формы 
фигур и трехмерными эффектами. Научиться создавать фотореалистичные 
векторные изображения.  

 
10.2. Задание к лабораторной работе 

 
Создайте композицию из двух или трех трехмерных объектов, (напри-

мер, шахматные фигуры). Для выполнения задания используйте различные 
способы, описанные ниже.  

Полученный результат сохраните в файле «3d.ai», сдайте преподавате-
лю на проверку и защитите его.  

 

   
 

Рис.10.1. Шахматные фигуры 
 
 

10.3. Эффекты объема 
 

10.3.1. Градиентная сетка 
 
Градиентная сетка позволяет создавать сетчатые объекты и более точ-

но управлять цветом, его тоном и наложением цветов при работе с 
градиентными переходами.  

Сетчатый объект - это многоцветный объект, на котором цвета могут 
распределяться в разных направлениях и плавно переходить от одного к дру-
гому в разных точках. Процесс преобразования обычного объекта в сетчатый 
заключается в создании линий сетки, пересекающих этот объект в разных 
направлениях и обеспечивающих возможность настройки цветовых перехо-
дов. Перемещая и редактируя узлы на линиях сетки, можно изменить 
интенсивность цветового сдвига или распространение цветной области на 
объекте. 
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А) Линии сетки (mesh lines) 
Б) Области сетки (patch) 
В) Узлы сетки (mesh points) 
Г) Узловая точка 

 

Рис.10.2. Диаграмма сетчатого объекта  
 
Линии сетки (Mesh Lines) - линии (или кривые), которые можно исполь-

зовать для изменения формы объекта или направления градиентной заливки. 
Линии сетки можно добавлять, перемещать и редактировать точно так же, 
как любые другие линии.. 

Области сетки (Mesh Patch) - фрагменты сетки, ограниченные четырь-
мя узлами. Отдельной области сетки можно назначить цвет, который будет 
плавно перетекать в цвет соседней области.  

Узлы сетки (Mesh Points) - пересечение двух линий сетки представляет 
собой узловую точку особого типа – узел сетки. Узлы сетки отображаются в 
виде ромбов и обладают всеми свойствами узловой точки, а также дополни-
тельным свойством - цветовой характеристикой. Можно добавлять и удалять 
узлы сетки, редактировать их или изменять цвет, связанный с каждым из уз-
лов сетки. 

Узловые точки - узловые точки отображаются в виде квадратного знач-
ка. Они могут быть добавлены, удалены, изменены и перемещены, как и 
любые другие узловые точки. Узловые точки можно расположить на любой 
линии сетки.  

Направляющие (Control Lines) - линии, которые контролируют кривизну 
линий сетки, а также интенсивность цвета, заданного как для области, так и 
для отдельного узла. Эти линии можно перемещать и редактировать точно 
так же, как любые другие линии. 

Объекты с градиентной сеткой можно получать практически из любых 
контуров и даже из растровых изображений. Нельзя использовать для этой 
цели составные контуры (compound paths), текстовые объекты и импортиро-
ванные изображения EPS-файлов.  

 
Создание сетчатых объектов 

 
Существует два способа создания сетчатых объектов: 
1) Команда Greate Gradient Mesh (Создать градиентную сетку) меню 

Object (Объект) - позволяет создавать сетчатый объект с регулярной схемой 
узлов сетки; 

2) Инструмент Gradient Mesh (Градиентная сетка) - позволяет созда-
вать сетчатый объект с нерегулярной схемой узлов сетки. 

При выборе средства создания объекта с градиентной сеткой следует 
исходить из следующих соображений:  
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- сложные объекты проще конвертировать командой Create Gradient 
Mesh (Создать градиентную сетку); 

- простые объекты можно конвертировать как командой Create Gradient 
Mesh (Создать градиентную сетку), так и с помощью инструмента 
Gradient Mesh (Градиентная сетка). Преимущество при выборе инструмен-
та может состоять в том, что пользователь волен сам принимать решение в 
расстановке опорных точек сетки.  

 
1. Создание сетчатого объекта с регулярной схемой узлов сетки 
 
Для создания сетчатого объекта с регулярной схемой узлов сетки необ-

ходимо выделить объект и выполнить команду Object > Create Gradient 
Mesh (Объект > Создать градиентную сетку), которая выводит на экран 
одноименное окно (рис. 10.2). 

 

Рис.10.3. Диалоговое окно Create Gradient Mesh (Создать Градиентную Сетку) 

 
В полях Rows (Ряды) и Columns (Колонки) следует ввести значения, 

определяющие размерность градиентной сетки в диапазоне от 1 до 40.  
В раскрывающемся списке Appearance (Тип) представлены три варианта 

направление подсветки: 
- Flat (Равномерно) - применяет исходный цвет объекта равномерно по 

всей поверхности, в результате чего подсветка не создается; 
- То Center (К центру) - создает подсветку в центре объекта; 
- То Edge (К краю) - создает подсветку по краям объекта. 
В поле Highlight (Подсветка) можно задать уровень осветления цвета 

объекта в диапазоне от 0% (исходный цвет объекта) до 100% (белый цвет). 
Значение 100 % обеспечивает применение максимальной белой подсветки к 
объекту, при значении 0 % белая подсветка отсутствует. 

  

а)  б)  в)  

Рис.10.4. Пример применения разных вариантов типа подсветки: 
а) Flat (Равномерно); б) То Center (К центру); в) То Edge (К краю) 
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2. Создание сетчатого объекта с нерегулярной схемой узлов сетки.  
 
Для создания сетчатого объекта с нерегулярной схемой узлов сетки 

необходимо выделить объект, выбрать инструмент Gradient Mesh (Гради-
ентная сетка) и задать цвет заливки для узлов сетки. Затем щелкнуть в 
точке, в которой необходимо расположить первый узел сетки. В результате, 
объект преобразуется в сетчатый с минимальным числом линий сетки. Про-
должать добавлять дополнительные узлы сетки щелчком в нужных точках. 
Для добавления узла сетки без применения к нему текущего цвета заливки, 
при щелчке необходимо удерживать нажатой клавишу <Shift>. 

 
Редактирование сетчатых объектов 

 
Сетчатый объект можно редактировать несколькими способами: 
- добавления, удаления и перемещения узлов сетки; 
- изменения цвета узлов и контуров сетки; 
- преобразования сетчатого объекта в обычный объект. 
1) Добавление узла сетки - выбрать инструмент Gradient Mesh (Гради-

ентная сетка) и задать цвет заливки для новых узлов сетки. Затем щелкнуть 
в любом месте сетчатого объекта. 

2) Удаление узла сетки - выбрать инструмент Gradient Mesh (Гради-
ентная сетка) и удерживая нажатой клавишу <Alt>  щелкнуть на узле сетки. 

3) Перемещение узла сетки - перетащить его с помощью инструмента  
Gradient Mesh (Градиентная сетка) или Direct Selection (Частичное выде-
ление). Для того, чтобы узел сетки оставался на линии сетки его необходимо 
перетаскивать с помощью инструмента  Gradient Mesh (Градиентная сет-
ка), удерживая нажатой клавишу <Shift>. Это удобный способ перемещения 
узла сетки вдоль изогнутой линии сетки без искажения линии сетки. 

4) Изменение цвета узла или контура сетки - выделить сетчатый объект и 
перетащить цвет с палитры Color (Цвет) или Swatches (Образцы) на узел 
или контур сетки. Затем отменить выделение всех объектов, выбрать цвет за-
ливки, выделить сетчатый объект и использовать инструмент Eyedropper 
(Пипетка), чтобы применить цвет заливки к узлам или контурам сетки. 

5) Преобразование сетчатого объекта обратно в контурный объект - вы-
делить сетчатый объект, выбрать команду Object > Path > Offset Path 
(Объект > Контур > Создать параллельный контур) и ввести ноль в каче-
стве значения сдвига. 

 
Преобразование объекта с градиентной заливкой  

в сетчатый объект 
 

Для преобразования объекта с градиентной заливкой в сетчатый объект 
необходимо выделить его, выбрать команду Object > Expand (Объект > 
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Разобрать), которая выводит на экран одноименное диалоговое окно (рис. 
10.5) 

 

Рис.10.5. Диалоговое окно Expand (Разобрать) 
 
Переключатель Expand Gradient To (Преобразовать градиент в) сле-

дует установить в положение Gradient Mesh (Градиентная сетка). В 
результате выделенный объект преобразуется в сетчатый объект, принимаю-
щий форму радиального или линейного градиента. 

 
10.3.2. Эффект перехода 

 
Из двух исходных векторных объектов, расположенных на некотором 

расстоянии друг от друга, можно сформировать комбинированный объект, 
который состоит из двух базовых элементов и группы промежуточных. Базо-
вые элементы образуются из исходных объектов, а промежуточные 
формируются программой автоматически. В результате данного преобразо-
вания можно создавать объекты либо с плавными переходами цвета между 
исходными объектами, либо трансформировать одну фигуру в другую. Бла-
годаря этой технологии объекты выглядят более естественно и натурально. 
На панели Layers (Слои) «объект перехода» имеет  название <Blend> (Пере-
ход). 

 

а) б) 

Рис.10.6. Пример объекта с переходом: 
а) равномерное распределение цвета; б) равномерное распределение фигур  

 
Объекты, которые получаются в результате данного преобразования, яв-

ляются единым комбинированным объектом, которые в дальнейшем можно 
подвергнуть различным изменениям: перемещению, удалению, масштабиро-
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ванию, вращению, редактированию контуров, присвоению новых цветов и 
декоративных заливок, удалять из них или добавлять в них объекты.  

 
 

Создание объекта с переходом 
 

Создать объект с переходом можно двумя способами: 
1) с помощью инструмента Blend (Переход), путем выполнения по-

следовательных щелчков на двух базовых векторных объектах (выделять их 
необязательно); 

2) с использованием команды Object > Blend > Make (Объект > Пере-
ход > Создать), применив ее к выбранным базовым объектам. 

 
1. Инструмент Blend (Переход) 
 
Инструмент Blend (Переход) позволяет создавать объекты с указани-

ем на опорные точки. Для создания серии промежуточных элементов из 
базовых форм, необходимо выбрать инструмент Blend (Переход) и выпол-
нить одно из следующих действий: 

- для создания последовательного перехода без поворотов - щелкнуть на 
каждом объекте в любом месте, кроме узловых точек; 

- для создания перехода в определенной узловой точке - щелкнуть на уз-
ловую точку инструментом Blend (Переход). Когда курсор будет находиться 
над узловой точкой, его форма изменится с белого квадрата на прозрачный с 
черной точкой в середине. 

- для создания перехода для открытых контуров - выбрать концевую 
точку каждого контура. После завершения добавления объектов к переходу 
еще раз щелкнуть инструментом Blend (Переход). 

 
Рис.10.7. Создание «объекта перехода» по опорным точкам 

 
2. Команда Make Blend (Создать Переход) 
 
Данная команда создает объект с переходом без указания на опорные 

точки. Для создания серии промежуточных объектов между базовыми объек-
тами таким способом достаточно выделить объекты, для которых нужно 
создать переход и выполнить команду Object > Blend > Make (Объект > Пе-
реход > Создать). 
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Параметры объекта с переходом 
 

Количество промежуточных элементов в объекте с переходом и харак-
тер их расположения вдоль траектории определяются в диалоговом окне 
Blend Options (Параметры Перехода) которое вызывается двумя способами: 

1) двойным щелчком на кнопке инструмента Blend (Переход); 
2) выполнением команды меню Object > Blend > Blend Options (Объ-

ект > Переход > Параметры перехода). 
 

 
 

Рис.10.8. Диалоговое окно Blend Оptions (Параметры Перехода) 
 

В раскрывающемся списке Spacing (Интервалы) представлены способы 
определения количества промежуточных элементов:  

- Smooth Color (Сглаженный переход цветов) - обеспечивает автомати-
ческое вычисление количества объектов. Если исходные объекты имеют 
заливки или обводки различного цвета, то обеспечивается соответствующее 
количество промежуточных объектов, необходимых для того, чтобы цвето-
вая растяжка выглядела гладкой.  

- Specified Steps (Количество промежуточных объектов) - дает возмож-
ность пользователю определить количество промежуточных элементов 
объекта в диапазоне от 1 до 1000.  

- Specified Distance (Расстояние) - дает возможность пользователю 
определить расстояние между промежуточными элементами объекта. 

В группе Orientation (Ориентация) диалогового окна можно определить 
расположение промежуточных элементов объекта, а именно:  

-  Align to Page (Привязка к странице) - обеспечивает расположение 
исходных и промежуточных элементов объекта перпендикулярно оси X 
страницы;  

-  Align to Path (Привязка к контуру) - обеспечивает расположение 
промежуточных элементов объекта перпендикулярно траектории контура.  

 

а) б) 
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Рис.10.9. Пример расположения промежуточных элементов в объекте перехода:  
а) выравнивание объектов по странице; б) выравнивание объектов по контуру 

 
 

Изменение объекта с переходом 
 
В созданном объекте с переходом промежуточные элементы располага-

ются вдоль траектории, представляющей собой прямолинейный отрезок, 
которая соединяет центры базовых элементов. После создания объекта с пе-
реходом траекторию, вдоль которой располагаются промежуточные 
элементы можно изменить: 

- настройка формы траектории - перетащить узловые точки и сегменты 
контура на траектории с помощью инструмента Direct Selection (Частичное 
выделение); 

- заменить траекторию на другую - нарисовать другую траекторию, 
выбрать ее вместе с объектом перехода и затем выполнить команду Object > 
Blend > Replace Spine (Объект > Переход > Заменить траекторию) 

- изменить направление траектории - выделить объект с переходом и 
выполнить команду Object > Blend > Reverse Spine (Объект > Переход > 
Изменить направление траектории). 

Изменить расположение элементов «в стопке» на обратное можно с по-
мощью команды Object > Blend > Reverse Front to Back (Объект >  Переход 
> Изменить расположение в «стопке»)  

 
а) б) в) г) 

Рис.10.10. Изменение объекта с переходом:  
а) исходный объект; б) замена  траектории; в) изменение направления траектории;  

г) изменение расположения элементов в «стопке» 
 
Если требуется преобразовать объект с переходом в группу обычных 

объектов, необходимо выделить его и выполнить команду Object > Blend >  
Expand (Объект >  Переход > Разобрать) 

Для того чтобы вернуть исходные объекты в первоначальное положение 
и удалить эффект перехода, необходимо их выделить и выполнить команду 
Object > Blend > Release (Объект >  Переход > Исключить)  

 
10.3.3. Трехмерные эффекты 

 
Трехмерные эффекты - это преобразование плоских фигур в редактиру-

емые трехмерные объекты путем экструзии  или вращения  контура. 
Управлять внешним видом объектов можно с помощью освещения, теней, 
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вращения, проецирование плоских изображений на «поверхность» трехмер-
ных объектов» и других свойств. Можно также помещать рисунки на каждой 
грани объемного объекта. 

Для создания трехмерного объекта можно воспользоваться тремя эф-
фектами 3D (Трехмерные) подменю Effects (Эффект): 

1) Extrude & Bevel (Вытягивание и скос) - выдавливает плоский объект 
по оси Z, придавая ему глубину (например, плоский эллипс превращается в 
цилиндр); 

2) Revolve (Вращение) - вращает плоский объект вокруг оси Y (напри-
мер,  фигура в виде арки превращается в шар); 

3) Rotate (Поворот) - поворачивает плоский объект в трехмерном про-
странстве вокруг оси Z, изменяя перспективу изображения. 

 

 
а)  б)  в)  

Рис.10.11. Трехмерные эффекты: 
а) Extrude & Bevel (Вытягивание и скос); Revolve (Вращение); в) Rotate (Поворот) 
 
При выборе команды появляется соответствующее диалоговое окно, в 

верхнем левом углу которого расположена модель куба, с помощью которого 
можно указать параметры положения объемного вращения (угол поворота и 
наклона объекта). Чтобы открыть полный список параметров, относящихся к 
выбранному эффекту, необходимо нажать кнопку More Options (Больше) 
или Fewer Options (Меньше), чтобы скрыть лишние параметры. Если уста-
новить параметр Preview (Просмотр), то можно увидеть, как внесенные 
изменения повлияют на объект. 

 
Рис.10.12. Диалоговое окно трехмерных эффектов 

 
Для редактирования трехмерного объекта необходимо его выбрать и 

дважды щелкнуть в палитре Appearance (Оформление) на 3D эффекте в ре-
зультате появится окно редактирования объекта.  
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Рис.10.13. Редактирование 3D-эффекта. 

 
 

Объемное вращение объекта 
 
В диалоговом окне можно выбрать предустановленное положение объ-

екта в меню Position (Положение) или для свободного вращения 
перетаскивать грань кубика. Передней части объекта соответствует синяя 
грань кубика, верхняя и нижняя части объекта светло-серые, боковые сторо-
ны – серые, а задняя – темно-серая. 

Чтобы сохранить вращение вокруг глобальной оси, необходимо нажать 
клавишу <Shift> и, удерживая ее, потянуть мышью горизонтально (глобаль-
ная ось Y) или вертикально (глобальная ось X). Для вращения объекта вокруг 
глобальной оси Z необходимо перетащить синюю ленту, которая окружает 
кубик. 

Для сохранения вращения вокруг оси объекта надо перетащить ребро 
кубика. Он будет иметь вид двойной стрелки , и ребро кубика изменит 
цвет в соответствии с осью, вокруг которой будет вращаться объект. Красное 
ребро соответствует оси X объекта, зеленое – оси Y, а синее – оси Z. Также 
можно ввести в текстовые поля значения от -180 до 180 для горизонтальной 

оси (X)  , вертикальной оси (Y) и оси глубины (Z) . 
Для регулировки перспективы в текстовое окно Perspective (Перспекти-

ва) можно ввести значение от 0 до 160.  Маленький угол аналогичен 
телеобъективу фотоаппарата, а большой  – широкоугольному объективу. 

 
Создание объектов с помощью вытягивания 

 
При вытягивании плоские объекты вытягиваются вдоль оси Z объекта, 

что добавляет объектам глубину.  
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а)  б)  

Рис.10.14. Вид объекта с эффектом вытягивания (сплошной, пустотелый):  
а) выдавливание; б) вдавливание. 

Для создания  трехмерных объектов с помощью вытягивания необходи-
мо  выбрать объект и выполнить команду Effect > 3D > Extrude & Bevel 
(Эффект > 3D > Вытягивание и скос). Затем в открывшемся диалоговом 
окне эффекта раскрыть полный список его параметров и определить их зна-
чения. 

 
Рис.10.15. Параметры вытягивания и скоса 

 
Параметры вытягивания и скоса: 
- Extrude Depth  (Длина вытягивания) - глубина объекта от 0 до 2000; 
- Cap (Концы) ⎯  вид объекта (  сплошной  или  пустотелый); 
- Bevel (Скос) ⎯ тип скоса вдоль оси глубины (ось Z); 
- Height (Высота) ⎯ высота скоса от 1 до 100. Слишком большая высота 

скоса для объекта может вызвать самопересечение объекта и привести к не-
предсказуемым результатам; 

- Bevel Extent Out (Скос наружу) ⎯ добавляет скос к объекту; 
- Bevel Extent In  (Скос внутрь) ⎯ вырезает скос из объекта. 

 

а)  б)  в)  

Рис. 10.16. Объект без скоса и со скосом грани:  
а) без скоса; б) скос наружу; в) скос внутрь 

 
Создание объектов с помощью вращения 

 
Вращение поворачивает контур или профиль вокруг глобальной оси y 

(оси вращения) для создания объемного объекта. Поскольку ось вращения 
фиксирована вертикально, то обычно для изображения половины профиля 
необходимого объемного объекта в вертикальном и фронтальном положении 
используют открытый или замкнутый контур.  

Для создания  трехмерных объектов с помощью вращения необходимо  
выбрать объект и выполнить команду Effect > 3D > Revolve (Эффект > 3D > 
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Вращение) Затем в открывшемся диалоговом окне эффекта (рис. 10.17) рас-
крыть полный список его параметров и определить их значения. 

 

Рис. 10.17. Параметры эффекта Revolve (Вращение) 
 

Параметры вращения: 
- Angle (Угол) - число градусов для вращения контура от 0 до 360.  
- Cap (Концы) - вид объекта (  сплошной  или  пустотелый); 
- Offset (Сдвиг) - расстояние между осью вращения и контуром от 0 до 

1000, например, для создания кольцеобразных объектов; 
- From (От) - ось, вокруг которой вращается объект (левый или правый 

край). 

 

Рис. 10.18. Объект, полученный с помощью эффекта вращения  
 
 

Управление внешним видом трехмерного объекта 
 
Управление внешним видом объекта может осуществлять с помощью 

параметров опции Surface (Поверхность) диалогового окна. 
Параметры заливки поверхности (Surface shading options): 
- Wireframe (Каркас) - выводятся контуры геометрии объекта, все по-

верхности прозрачны. 
- No Shading (Без тени) - объекту не добавляется новых свойств поверх-

ности. Объемный объект имеет тот же цвет, что и исходный плоский объект. 
- Diffuse Shading (Размытая тень) - делает отраженный от объекта свет 

мягким и размытым. 
- Plastic Shading (Четкая тень) - свет отражается от объекта так, словно 

он сделан из материала с высоким блеском. 
 

 

а) б) в) г) 

Рис. 10.19. Примеры различной заливки поверхности: 
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а) каркас; б) без тени; в) размытая тень; г) четкая тень 
 
В зависимости выбранного варианта заливки поверхности доступны 

разные параметры освещения. Если объект использует только эффект объем-
ного поворота, доступны только варианты поверхностей Diffuse Shading 
(Размытая тень) и No Shading (Без тени). 

- Light Intensity (Интенсивность освещения) - интенсивность света от 0 
до 100 %. 

- Ambient Light (Окружающее освещение) - общее освещение от 0 до 100 
%, которое одинаково изменяет освещенность поверхности всех объектов. 

- Highlight Intensity (Яркость подсветки) -  отражение света от объектов 
в диапазоне от 0 до 100 %. Низкие значения создают матовую поверхность, 
более высокие образуют зеркальную поверхность. 

- Highlight Size (Размер выделенной области) -  размер подсветки от 
большого (100 %) до малого (0 %). 

- Blend Steps (Шаги перехода) - плавность перехода тени на поверхности 
объектов в диапазоне от 1 до 256. Более высокое значение приводит к появ-
лению более плавных переходов. 

- Draw Hidden Faces (Прорисовать скрытые грани) - вывод на экран 
скрытых граней объекта. Задняя сторона объекта видна, если он прозрачен 
или если объект был разобран и отодвинут в сторону. 

- Preserve Spot Color (Сохранить плашечный цвет ) - позволяет сохра-
нить плашечный цвет объекта.  

 
Параметры освещения объекта(Lighting options) 

 
- Light (Свет) - определяет местоположение источника света, который 

можно перетащить по сфере в нужное место. 
- Move Light Back button (Переместить источник назад) -  переме-

щает выбранный источник света за объект. 
- Move Light Front button (Переместить источник вперед) - переме-

щает выбранный источник света  перед объектом. 
- New button (Новый) - добавляет источник света. По умолчанию новый 

источник света помещается перед сферой посредине. 
- Delete Light button (Удалить источник) - удаляет выбранный источник 

света. 
- Light Intensity (Интенсивность освещения) - изменяет интенсивность 

выбранного источника света от 0 до 100 %. 
- Shading Color (Цвет тени) -  управляет цветом тени объекта в зависи-

мости от выбранной команды. 
- None (Не задано) - не добавляет цвета тени. 
- Custom (Заказной) - позволяет выбрать цвет.  
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- Black Overprint (Наложение черного) - предотвращает использование 
триадных цветов, если используется процесс с плашечными цветами. Тени 
объекта создаются путем наложения черного поверх цвета заливки объекта.  

 
Отображение символов на поверхности трехмерного объекта 

 
Любой трехмерный объект состоит из множества поверхностей. На каж-

дую грань объекта можно наложить любой рисунок, хранящийся в палитре 
Symbol (Символ). Однако проецировать рисунки на объекты можно только с 
помощью эффектов Extrude & Bevel (Вытягивание и скос) и Revolve (Вра-
щение). 

Для нанесения рисунка на поверхность объекта необходимо нажать 
кнопку Map Art (Проецирование) и в одноименном диалоговом окне опреде-
лить параметры отображения рисунка на поверхности: 

• Symbol (Символ) - рисунок для проецирования на выбранную поверх-
ность 

• Surface (Поверхность) - в 3D эффекте все поверхности объекта запо-
минаются по номерам.  

• Scale To Fit (Масштабировать по размеру) - изменить размер рисунка 
в соответствии с размером выбранной поверхности. 

• Clear (Очистить - удалить рисунок с одной поверхности. 
• Clear All (Очистить все) - удалить рисунки с поверхностей объекта. 
• Shade Artwork (Реалистичные тени) - наложить тени. 
• Invisible Geometry (Невидимая структура) - вывести на экран только 

спроецированные рисунки, без геометрии объемного объекта. 
 

 
Рис. 10.20. Нанесение рисунка на поверхность объекта 

 
При отображении символов на объемных объектах необходимо учиты-

вать следующее: 
- при редактировании экземпляра символа он будет автоматически об-

новляться на всех поверхностях, на которые был спроецирован; 
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- работать с символом в диалоговом окне Map Art (Проецирование) 
можно с обычными ограничительными рамками для перемещения, масшта-
бирования или поворота объекта; 

- в объемном эффекте все поверхности объекта с проекциями запомина-
ются по номерам. При редактировании объекта или применении тех же 
эффектов к новому объекту может оказаться, что сторон больше или меньше, 
чем у исходного объекта. Если поверхностей меньше, чем определено для 
исходного объекта, лишние рисунки игнорируются; 

- поверхность для проецирования символа выбирается с помощью нажа-
тия кнопок:  - первая;  - предыдущая;  - следующая;  -последняя или 
ввода номера поверхности в текстовое поле. Светло-серым цветом окрашены 
видимые в настоящий момент поверхности. Темно-серым цветом помечены 
поверхности, невидимые при текущем положении объекта. После выбора в 
диалоговом окне поверхности она в окне документа окрашивается по конту-
ру красным цветом; 

- для перемещения символа необходимо установить курсор внутри огра-
ничительной рамки и перетащить его. Для масштабирования перетащить 
боковой или угловой маркер. Для поворота перетащить наружу и ближе мар-
кер ограничительной рамки; 

- поскольку положение символа зависит от центра поверхности объекта, 
то при изменении геометрии поверхности объекта символ будет проециро-
ваться относительно нового центра. 

 
10.4. Методические указания к лабораторной работе 

 
1. Создание сетчатого объекта с регулярной схемой узлов. Создайте 

сетчатый объект в форме капли (рис. Рис.10.4 б). Для этого нарисуйте форму 
капли и преобразуйте ее в сетчатый объект с помощью команды Create Gradi-
ent Mesh (Создать градиентную сетку.) В одноименном диалоговом окне 
включите Preview (Просмотр) и установите нужные параметры. Получите 
желаемый результат, закройте диалоговое окно с сохранением параметров. 

2. Создание сетчатого объекта с нерегулярной схемой узлов.  Создай-
те сетчатый объект в форме трех воздушных шариков красного, зеленого и 
синего цвета. Для этого сначала постройте с помощью инструмента Ellipse  
(Эллипс)  форму воздушного шарика и сделайте две копии. Выберите один из 
объектов. Выполните команду Create Gradient Mesh (Создать градиентную 
сетку) и определите базовые параметры. Затем с помощью инструмента 

Gradient Mesh (Градиентная сетка) осуществите редактирование базовой 
формы таким образом, чтобы получился фотореалистичный объект. Анало-
гичным образом создайте еще два шарика. 

3. Создание перехода с трансформацией исходных объектов.  Создай-
те комбинированный объект, состоящий из двух исходных объектов и серии 
промежуточных. Для этого сначала с помощью инструментов группы  Rec-
tangle (Прямоугольник) постройте две геометрические фигуры, например, 
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квадрат и звезду (рис. 10.7). Присвойте им только атрибут Fill (Заливка) и за-
красьте различными цветами. Выберите инструмент Blend (Переход) и 
создайте последовательный переход без поворотов, для этого щелкните по-
следовательно на каждом объекте в любом месте. Отмените действие и 
создайте комбинированный объект с поворотом. Для этого щелкните после-
довательно инструментом Blend (Переход) по опорным точкам исходных 
фигур. Если результат поучился неудовлетворительный, то настройте долж-
ным образом параметры инструмента. 

4. Создание перехода с равномерным распределением цвета. Создай-
те комбинированный объект с плавным переходом цвета (рис. 10.6а). Для 
этого сначала с помощью инструментов группы Pen (Перо) нарисуйте две 
произвольные линии,  присвойте им атрибут Stroke (Обводка) и закрасьте 
контуры различными цветами. В диалоговом окне Blend Options (Параметры 
перехода) определите интервалы как Smooth Color (Сглаженный переход 
цветов). Далее выделите исходные объекты и выполните команду Object > 
Blend > Make (Объект > Переход > Создать). Поэкспериментируйте с дру-
гими командами данной группы. 

5. Создание трехмерного объекта с помощью эффекта вытягивания. 
Создайте трехмерную букву (рис.10.16). Наберите с помощью инструмента 

Type (Текст) первую букву своего имени и переведите в кривые. Выделите 
букву и примените к ней трехмерный эффект Extrude & Bevel (Вытягивание 
и скос). В диалоговом окне эффекта В диалоговом окне эффекта включите 
Preview (Просмотр), раскройте полный список его параметров и определите 
их значения. Поэкспериментируйте с  параметрами скоса объекта (без скоса, 
скос наружу, скос внутри). Для редактирования или удаления эффекта ис-
пользуйте палитру Appearеnce (Внешний вид). 

6. Создание трехмерного объекта с помощью эффекта вращения. Со-
здайте трехмерный объект в виде вазы (рис. 10.18). Создайте с помощью 
инструмента Pen (Перо)  контур необходимой формы для будущей вазы и за-
тем преобразуйте его в трехмерный объект с помощью 3d-эффекта Revolve 
(Вращение). В диалоговом окне эффекта включите Preview (Просмотр) и 
установите нужные параметры. Закройте диалоговое окно с сохранением па-
раметров. Если после применения эффекта результат оказался 
неудовлетворительным, то для редактирования контура используйте инстру-
мент Direct Selection (Частичное выделение), а цвета заливки атрибут stroke 
(обводка). 

 
10.5. Контрольные вопросы 

 
1. Опишите два способа создания сетчатого объекта и их отличия. 
2. В чем разница между градиентной заливкой и переходом? 
3. В чем разница между переходом со сглаженными цветами и перехо-

дом с заданным числом шагов? 
4. Как настроить фигуры и цвета в переходе?  
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5. Назовите три типа трехмерных эффектов и их отличия 
6. Перечислите этапы отображения рисунка на объект. 
7. Влияет ли освещение одного трехмерного объекта на освещение 

остальных объектов? 
8. Каким образом можно изменить параметры эффекта? 
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Приложение 1 
 
 

Общие элементы интерфейса 
 

Интерфейс программы представляет все необходимое для работы поль-
зователя: инструменты, палитры, диалоговые окна и т.д. При запуске 
программы на экране открывается рабочее окно, с помощью которого можно 
выполнить любую из следующих операций: 

• создать новый стандартный или нестандартный документ с помощью 
элементов управления  в области Create New (Создать новый); 

• открыть любой документ с помощью элементов управления  в области 
Open a Resent Item (Открыть последний документ); 

• просмотреть в окне справочной системы любой из трех вводных раз-
делов о данной программе, расположенных в левом нижнем углу. 

Для того, чтобы в дальнейшем окно не выводилось на экран, необходи-
мо установить флажок Don`t show again, расположенный внизу. 

Интерфейс программы состоит из следующих основных компонентов: 
• Строка меню (menu bar) - находится под полосой заголовка програм-

мы и представляет собой панель с названиями раскрывающихся списков 
команд основного меню, сгруппированных по функциональному принципу. 

• Панель управления (control panel) - размещается под строкой меню 
и предназначена для отображения параметров активного инструмента. Эле-
менты панели обычно дублируют действие специализированных средств 
программы или команд основного меню. 

• Панель инструментов (toolbox) - расположена слева и представляет 
собой стационарную вертикальную панель с набором инструментов, с помо-
щью которых можно создавать, выделять, редактировать, перемещать 
графические объекты и т.д. Связанные инструменты сгруппированы вместе. 
В каждой ячейке панели могут находиться один или несколько инструментов 

• Функциональные панели (палитры) - могут располагаться в разных 
местах рабочего пространства, в которых сгруппированы палитры, служащие 
для удобства выполнения тех или иных функций (выбор цвета, параметры 
обводки и заливки, трансформации и т.д.). Каждая палитра имеет свое кон-
текстное меню, которое представляет собой список команд с 
дополнительными функциями. Они могут находиться в развернутом или 
свернутом состоянии, а также имеют две формы представления на экране: 
стационарную и плавающую 
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• Контекстные меню - дополнение к пунктам главного меню и палитр, 
вызываются нажатием правой кнопки мыши. Содержание контекстных меню 
находится в зависимости от активного в данный момент инструмента, типа 
выделенного объекта или открытой палитры 

• Рабочее окно документа - предназначено для работы с документом, 
состоящим из одного рабочего листа, и включает следующий набор элемен-
тов: 

- вверху – заголовок окна, содержащий системное меню, название доку-
мента и системные кнопки управления; 

- в центральной части - область обработки, где отображается содержи-
мое документа и производится его обработка; 

- внизу – строка состояния документа, справа от которой находится го-
ризонтальная полоса прокрутки; 

- справа – вертикальная полоса прокрутки 
• Строка состояния (Status bar) - располагается в левой нижней части 

панели окна документа, предназначена для отображения служебной инфор-
мации и содержит следующие элементы: 

- раскрывающийся список стандартных значений масштаба отображения 
документа на экране с редактируемым полем для ввода произвольной вели-
чины масштаба; 

- информационное поле, в котором выводится текущая информация, со-
ответствующая выбранному пункту контекстного меню строки состояния. 

• Монтажный стол - представляет собой прямоугольную область бело-
го цвета, частично отображаемую в рабочем окне документа. 

• Рабочий лист (artboard) - представляет собой прямоугольную об-
ласть документа, очерченную на экране черной сплошной рамкой, 
содержимое которой может быть выведено на печать (при условии располо-
жения его внутри печатаемой области документа, очерченной двойной 
пунктирной рамкой). 

• Компоновочная зона (scratch area) - окружает снаружи рабочий лист 
документа и предназначена для размещения объектов, которые не будут вы-
водиться на печать (или на экран при электронной публикации документа), 
но которые в любой момент могут быть перенесены на его рабочий лист. 

В состав интерфейса программы также входят панели библиотек, диало-
говые окна, справочная информация и т.д. 

 
Обзор панели «Инструменты» 

 
В левой части окна программы расположена палитра Toolbox (Инстру-

менты), в которой объединены инструменты, с помощью которых 
создаются, редактируются и преобразуются векторные объекты.  

Инструменты выделения: 
 Выделение (V) Волшебная палочка (Y) 

 Прямое выделение (A) Лассо (Q) 
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 Групповое выделение Монтажная область (Shift +O) 

 

 

 

Инструменты рисования: 
 Перо (P) Отрезок линии (\) 
 Добавить опорную точку (+) Дуга 
 Удалить опорную точку (-) Спираль 
 Преобразовать опорную точку 

(Shift+C) 
Прямоугольная сетка 

 Прямоугольник (M) Полярная сетка 
 Прямоуг.со скругленными углами Карандаш (N) 
 Эллипс (L) Сглаживание 
 Многоугольник Стирание контура 
 Звезда Сетка перспективы (Shift+P) 
 Блик Выбор перспективы 

Инструменты работы с текстом: 
 Текст (T) Вертикальный текст 
 Текст в области Вертикальный текст в области 
 Текст по контуру Вертикальный текст по контуру 

Инструменты рисования: 
 Кисть (B) Пипетка (I) 
 Кисть-клякса (Shift+B) Линейка 
 Сетка (U) Быстрая заливка (K) 
 Градиент  (G)  Выделение быстрой заливки 

(Shift+L) 

Инструменты изменения формы: 
 Поворот (R) Деформация (Shift-R) 
 Зеркальное отражение (O) Воронка 
 Масштаб (S) Втягивание 
 Наклон Раздувание 
 Перерисовка Зубцы 
 Свободное трансформирование (E) Кристаллизация 
 Создание фигур (Shift+M) Морщины 
 Переход (W) Ширина (Shift+W) 

Инструменты работы с символами: 
 Распыление символов (Shift+S) Вращение символов 
 Смещение символов Обесцвечивание символов 
 Уплотнение символов Прозрачность символов 
 Размер символов Стили символов 

Инструменты работы с диаграммами: 
 Вертикальные полосы  (J) Аддитивный график 
 Вертикальный стек Точечная диаграмма 
 Горизонтальные полосы Круговая диаграмма 
 Горизонтальный стек Радар 
 Линейная диаграмма   

Инструменты фрагментирования и вырезания: 
 Ластик (Shift+E) Фрагмент (Shift+K) 
 Ножницы (C) Выделить фрагмент 
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 Нож   

Инструменты перемещения и масштаба: 
 Рука (H) Масштаб (Z) 
 Разбиение   

 

Приложение 2 
 
 

Основные операции с документом 
 

1. Режимы просмотра документа 
 
Программа допускает два основных режима просмотра документа, кото-

рые различаются скоростью формирования и качеством получаемого в 
результате изображения:  

1) Preview (Иллюстрация) - отображает на экране полноценное изоб-
ражение с параметрами обводок и заливок, принят по умолчанию; 

2) Outline (Контур) - переводит изображение в контуры, позволяя 
отобразить объекты, расположенные как сверху, так и снизу созданного 
изображения. 

Переключение в любой из режимов просмотра документа выполняется с 
помощью одноименных команд меню View (Просмотр), а переключение с 
одного режима на другой осуществляется с помощью комбинации клавиш 
<Ctrl>+<Y>. 

 

 
а) б) 

Рис. П.2.1 — Режимы отображения:  
а) Preview (Иллюстрация); б) Outline (Контур) 

 
Режим просмотра Pixel Preview (Просмотр пикселей) - позволяет пред-

ставить изображение в растровом виде (комбинация клавиш 
<Alt>+<Shift>+<Y>). 

Режим просмотра Overprint Preview (Просмотр наложения) - позволя-
ет увидеть области наложения цветов (overprint) и полезен при подготовке 
документа для полиграфического исполнения (комбинация клавиш <Alt>+< 
Ctrl >+<Y>). 
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2. Масштабирование изображения 
 
Для решения задач масштабирования изображения (рис.П.2.2) суще-

ствуют различные методы. 
1) Команды меню View (Просмотр): 
- Zoom In - увеличение изображения; 
- Zoom Out - уменьшение изображения; 
- Fit in Window - экранный масштаб просмотра изображения; 
- Actual Size - 100% масштаб просмотра изображения. 
2) Инструмент Zoom (Лупа): 
- увеличение изображения - щелчок инструментом; 
- уменьшение изображения - щелчок инструментом с нажатой клавишей 

<Alt>; 
- 100% масштаб просмотр изображения - двойной щелчок по инструмен-

ту; 
- просмотр конкретной области - рамка выделения (область документа, 

попавшая в рамку, будет увеличена). 
3) Горячие клавиши: 
- <Ctrl>+<+> - увеличение изображения; 
- <Ctrl>+<-> - уменьшение изображения;  
- <Ctrl>+<0> - экранный масштаб просмотра изображения; 
- <Ctrl>+<1> - 100% масштаб просмотра изображения; 
- <Ctrl>+<Пробел> - увеличение изображения; 
- <Ctrl>+<Alt>+<Пробел> - уменьшение изображения  
- <Ctrl>+<Пробел>+<рамка> - увеличение конкретной области; 
- Поле масштаба в левой нижней части панели окна документа - можно 

ввести произвольное значение или выбрать процентное соотношение мас-
штаба из списка стандартных значений.  
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20% 100% 400% 

Рис. П.2.2 — Различный масштаб просмотра изображения 

 

 

 

3. Перемещение изображения 
 
Для навигации по документу предусмотрен инструмент Hand (Рука), 

который позволяет переместить документ в любое место экрана, а при двой-
ном щелчке мышью на инструменте изображение заполнит полностью окно 
документа. 

В процессе работы без дезактивации текущего инструмента в любой 
момент времени можно выбрать инструмент Hand (Рука) с помощью клави-
ши <Пробел>. 

 
4. Измерительные линейки 
 
Измерительные линейки (Rules) предназначены для определения коор-

динат объектов, изменения их размеров, а также точного позиционирования 
элементов рисунка и размещения направляющих. Линейки могут отобра-
жаться или не отображаться на экране. По умолчанию измерительные 
линейки на экран не выводятся, но в любой момент пользователь может по-
лучить доступ к ним: 

- показать линейки - команда View > Show Rules (Просмотр > Показать 
линейки) или комбинация клавиш <Ctrl>+<R>; 

- спрятать линейки - команда View > Hide Rulers (Просмотр > Спрятать 
линейки) или комбинация клавиш <Ctrl>+<R>. 

Внешний вид шкалы линеек зависит от установленных в программе 
единиц измерения. 

 
Перемещение начала координат 
 
В левом верхнем углу окна документа (точка пересечения линеек) нахо-

дится кнопка установки нулевой точки отсчета, с помощью которой начало 
координат можно перенести в любое место документа: 

- перемещение точки отсчета - щелчок на точке пересечения линеек и, не 
отпуская кнопку мыши перетащить нулевую координату в новое место рабо-
чего окна документа; 

- возврат точки отсчета - двойной щелчок на точке пересечения линеек. 
 
Единицы измерения 
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Для установки единиц измерения, относящихся к документу, необходи-
мо выполнить команду File > Document Setup (Файл > Параметры 
документа) и в одноименном диалоговом окне в поле Units (Единицы изме-
рения) из списка выбрать требуемый параметр.  

Для установки единиц измерения, относящихся к программе, необходи-
мо выполнить команду меню Edit > Preferences > Unit&Display Perfomance 
(Редактировать > Установки  > Единицы измерения и отображения на 
экране) и в поле General (Основные) появившегося диалогового окна из 
списка выбрать требуемый параметр. 

Программа поддерживает следующие единицы измерения:  
- Points (Пункты), 1 пункт = 1/72 дюйма (0,3428 мм) (по умолчанию);  
- Picas (Пики), 1 пика = 12 пунктам;  
- Inches (Дюймы), 1 дюйм = 24,4 мм;  
- Millimeters (Миллиметры);  
- Centimeters (Сантиметры);  
- Pixels (Пикселы). 
 
Параметры страницы 
 
Для установки параметров страницы необходимо вызвать на экран диа-

логовое окно Document Setup (Параметры документа) в меню File (Файл) 
и установить требуемые параметры:  

- Size (Формат) - размер печатной страницы  (выбор из списка); 
- Width (Ширина) - ширина листа; 
- Height (Высота) - высота листа;  
- Units (Единицы измерения) - миллиметры, сантиметры и т.д.; 
- Orientation (Ориентация) - книжная или альбомная; 
- Show Images in Outline (Показывать узоры в контурном виде) - если 

целесообразно показывать шаблоны декоративных узоров (pattern) в режиме 
Outline (Контур).  

 
5. Сетка и направляющие 
 
Сетка  

 
Сетки (Grid) представляют собой равномерную решетку из линий (lines) 

или точек (dots), не выводятся на печать и предназначены для точного пози-
ционирования объектов в документе. Сетки могут отображаться или не 
отображаться на экране. По умолчанию сетка на экран не выводится, но в 
любой момент пользователь может получить доступ к ней: 

- показать сетку  - команда View > Show Grid (Просмотр > Показать 
сетку) или комбинация клавиш <Ctrl>+<”>; 

- спрятать сетку - команда View > Hide Grid (Просмотр > Спрятать 
сетку) или комбинация клавиш <Ctrl>+<”>. 
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Изменить параметры сетки (цвет и стиль) можно в диалоговом окне ко-
манды Edit > Preferences > Guides&Grid (Редактировать > Установки  > 
Направляющие и сетка)/ 

 
 
 
 
Направляющие 
 
Направляющие (Guide) представляют собой вспомогательные цветные 

линии, которые не выводятся на печать и могут присутствовать в окне доку-
мента в неограниченном количестве. Направляющие могут отображаться или 
не отображаться на экране. По умолчанию направляющие на экран не выво-
дятся, но в любой момент пользователь может получить доступ к ним: 

- показать направляющие - команда View > Guide > Show Guide (Про-
смотр > Направляющие > Показать направляющие) или комбинация клавиш 
<Ctrl>+<;>; 

- спрятать направляющие - команда View > Guide > Hide Rulers (Про-
смотр > Направляющие > Спрятать линейки) или комбинация клавиш 
<Ctrl>+<;>. 

Для того, чтобы создать направляющие необходимо вывести на экран 
измерительные линейки, установить указатель мыши на одной из линеек, за-
тем нажав левую кнопку мыши и, не отпуская ее, переместить указатель в 
требуемую область документа и отпустить кнопку тогда, когда направляю-
щая достигнет нужного места.  

Кроме того с направляющими можно выполнять различные операции: 
- блокировать/разблокировать направляющие - команда View > Guide > 

Lock Guides (Просмотр > Направляющие > Закрепить направляющие) или 
воспользоваться комбинацией клавиш <Ctrl>+<Alt>+<;>; 

- удалить выделенные направляющие  - клавиша <Delete>; 
- удалить все направляющие - команда View > Guide > Clear Guides 

(Просмотр > Направляющие > Удалить направляющие); 
- преобразовать направляющие в объект - команда View > Guide > Make 

Guides (Просмотр > Направляющие > Создать направляющие) или комби-
нация клавиш <Ctrl>+<S>;  

- преобразовать объект в направляющие - команда View > Guide > Re-
lese Guides (Просмотр > Направляющие > Отменить направляющие) или 
комбинация клавиш <Ctrl+Alt+S>; 
- изменить цвет направляющих - установить параметры цвета в диалоговом 
окне команды Edit >Preferences> Guides&Grid (Редактировать > Уста-
новки  > Направляющие и сетка). 
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